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Warning and Disclaimer

ThreatQuotient, Inc. provides this document “as is”, without representation or warranty of any
kind, express or implied, including without limitation any warranty conceming the accuracy,
adequacy, or completeness of such information contained herein. ThreatQuotient, Inc. does

not assume responsibility for the use or inability to use the software product as a result of

providing this information.
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Introduction

The following provides an introduction to the ThreatQ platform.

« ThreatQ Introduction

o Concept Overview

ThreatQ Introduction

ThreatQ is a cyber threat intelligence platform that focuses on centralizing, structuring, and

strengthening a security organization's intelligence-driven defensive posture against attacks.

Concept Overview

The following describes how ThreatQ helps organizations manage threat intelligence, allow-

ing them to defend against sophisticated cyber-attacks.

o Threat Library

o Adaptive Workbench

« Open Exchange

Threat Library

A central repository combining global and local threat data to provide relevant and con-
textual intelligence that is customized for your unique environment. Over time, the library
becomes more and more tuned to your environment and fills in the intelligence gaps created

by different sources, all providing only some pieces of the puzzle.
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Adaptive Workbench

An open and extensible work area for security experts across the organization to work within
your processes and tools. A customizable workflow and customer-specific enrichment

streamlines investigations and analysis, and automates the intelligence life cycle.
Open Exchange

ThreatQ is the only threat intelligence platform specifically designed for customization to
meet the requirements of your unique environment. Get more from your existing security
investments by integrating your tools, teams and workflows through standard interfaces and

an SDK/API for customization.
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System Access

The following describes how to login and log out of the platform.

o System Access Overview

« System Login

« Managing your User Account

« 2 Step Verification

System Access Overview

To access the ThreatQ web Ul, you must authenticate yourself with a username and pass-

word. You can use the main menu to access ThreatQ functionality.

System Login

When you installed ThreatQ, you set up the default user account, Maintenance Account,

which you can use to log into the web UL.

Using this account, you can create additional user accounts.

Passwords must be 15 characters or longer. There is no limit on the character type.
Logging into ThreatQ

When you installed ThreatQ, you defined an IP address for the web Ul, and set up the Main-

tenance Accountand password.

1. In your web browser, navigateto https://your-ThreatQ-web-ip-

address.
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THREATQ )

LOGIN

Copyright © 2019 ThreatQuotient, inc.

2. Enter your username (email address) and password.

3. Optionally, if you have 2-step verification enabled, complete the following steps:
« Enter your verification code from Google Authenticator.
« Optionally, choose to Remember this computer for 30 days.

4. Click Login or Submit.

Session Timeout

User sessions time out after 30 minutes of inactivity.

Managing your User Account

When you choose the User Settings icon > My Account, the system directs you to the Edit
User page for your current login. From here, you can edit your user account, set up 2-step

verification, view your API credentials, or view your login history.
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Procedure

1. Choose the User Settings icon > My Account.

Users that have upgraded to ThreatQ 4.1 will see an avataricon in
place of the My Account link. Click on the icon and select My
Account.

2. On the User Profile tab, you can edit the following settings of your user account:
« Name
o Title
o Email
« Password

3. You can view your API credentials, a unique Client ID, which will allow you to con-
nect with ThreatQ's API.

4. You can update your user avatar; see Update User Avatar.

ﬂ\ The User Avatar feature is only available with ThreatQ 4.1 and later.

5. Optionally, you can set up 2-step verification; see 2 Step Verification.

6. Optionally, on the Login Activity tab, you can view:
« The last date and time you logged in.
« The IP Address where you logged in.
« Whether the login was successful or not.

7. Click Save.

User Avatar Icons

ﬂ\ The User Avatar feature is only available with ThreatQ 4.1 and later.
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System Access

User avatar icons provide a personalized look to your ThreatQ dashboard. Clicking on the

avatar icon will reveal the My Account and Log out options.
Users can update their avatars by clicking on the avatar and selecting My Account.

o Update User Avatar Graphic

Update User Avatar Graphic

ﬂ\ The User Avatar feature is only available with ThreatQ 4.1 and later.

1. Click on avatar icon located to the top-right on the screen and select My Account.

The Edit Userform will load.

2. Select one of two options:
« Click browse and select the icon graphic to upload.
« Click and drag the new icon graphic onto the page.

3. Click Save at the bottom of the page.

2 Step Verification

When you enable 2-Step Verification (also known as two-factor authentication), you add an
extra layer of security to your account. After 2-Step Verification is active, you sign in with your

password and a code sent to your mobile device.

o Enabling 2 Step Verification

Enabling 2 Step Verification
Procedure:

1. Choose the User Settings icon> My Account.

2. Under Enable 2-Step Verification, click Enabled.
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3. In the Enable 2 Step Verification dialog box, complete the following:
« Scan the gr code using your Google Authenticator mobile app.

« Enter the validation code delivered to your mobile device via Google

Authenticator.
o Click Submit.
4. Click Save.

What to do next

The next time you log in, you must use the newest verification code.
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Licensing

The following provides an overview of licensing for the ThreatQ platform.

o Licensing Overview

o Viewing the License Status

« Updating a License

Licensing Overview

Your ThreatQ deployment requires a license to initialize the platform. ThreatQ Support
provides the initial license and any subsequent licenses provided to maintain the platform.

You apply the initial ThreatQ license during first boot, as described in the ThreatQ Getting

Started Guide. Any subsequent license updates can be applied in the ThreatQ user inter-

face.

Viewing the License Status

ThreatQ licenses are not perpetual. To view the license expiration date, complete the fol-

lowing steps:
Procedure

Choose the Settings icon >About .

Updating a License

If you receive a new license from Support, apply the new license by accessing the About

page.

Procedure
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1. Choose the Settings icon > About.
Choose Update License.

Enter the new license key.

W N

Click Submit.
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User Management

The following describes how to manage user accounts.

o User Management Overview

« User Account Creation

« User Account Modification

User Management Overview

ThreatQ uses role-based access control to manage user accounts. The system provides sev-
eral user roles, each containing a set of permissions for accessing system functionality. You
create user accounts, and assign them to a user role. The user role determines each

account's set of permissions.

After you create a user account, you can modify the user role group, full name, and email

address.
« User Roles
User Roles

The following details the user roles and their associated permissions.

User Role Permissions

Members have access to the
Maintenance Account entire ThreatQ user interface and

can edit all data.
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User Role Permissions

Note: This account can

not be deleted

Members have access to the
Administrative Access entire ThreatQ user interface

and can edit all data.

Members have access to most of
the ThreatQ user interface, except

for:

User Management

Incoming Feeds

o Exports

Operations Management

Primary Contributor Access QAR [ G

System Configurations

Members can edit:

Their own user info

« Whitelist Management

Operations Management

Object meta data

Saved Searches
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User Role Permissions

Members have access to most of
the ThreatQ user interface, except

for:

User Management

« Incoming Feeds

« Indicator Management

« Whitelist Management
Read Only Access . Exports
« Operations Management

o OAuth Management

« System Configurations
Members cannot edit any data.

Members can export search res-
ults.

User Account Creation

When you firstinstall ThreatQ, the system creates a default user account, the Maintenance
Account. You cannot delete this account, and you can use it to initially create other user

accounts. Each user account must have a unique username.

Only the Maintenance Account and Administrative Access user role have permissions to
access user management functionality. You can only create new user accounts if logged in

as one of these roles.
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o User Account Properties

« Adding a User

User Account Properties

. full name of the user asso-  any alphabetic character and
ame
ciated with this account spaces

. . . any alphabetic character and
Title optional user title
spaces

roles which this user
Group at least one role selected
account belongs to

Email email address associated  valid email address, such as user-
mai
with this account @domain.com

initial password asso-
Password _ . all characters
ciated with the username

Adding a User

1. From the main menu, choose the Settings icon > User Manangement.
Click Add User.
Enter the user's Name.

Optionally, enter the user's Title.

o &~ B

Select the level of access for the user from the Group drop-down menu.

Choose from the following options:
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« Maintenance Account
o Administrative Access
« Primary Contributor Access
o Read Only Access
Enter the user's Email address.
Enter a password for the user.

Retype the password.

© o N o

Click Add User.

User Account Modification

After you create a user account, you can modify the account's role group, full name, title,

email address, and password.

o Editing a User

o Resetting User Passwords from the Command Line

« Deleting a User

Editing a User

1. From the main menu, choose the Settings icon > User Manangement.

2. Click the name of the user whose profile you wish to edit.
The Edit User page appears.

3. Editthe user fields as desired; see User Account Properties.

4. To change the password, click Change Password.

5. Click Save.

ThreatQ User Guide, Version 4.20 37



THREA Tf,] H User Management

Resetting User Passwords from the Command Line

If you have root access to your ThreatQ installation, you can reset any user's password from

the command line.

. SSH to your ThreatQ installation as root.

. Navigate to the api directory:

cd /var/www/api
Run the following command:

php artisan threatqg:password-reset
At the prompt, enter the email address for the user whose password you are reset-
ting.

At the prompt, enter the new password.

At the prompt, re-enter the new password to confirm.

Deleting a User

Deleting a user cannot be undone.

1.
2.

From the main menu, choose the Settings icon > User Manangement.
Select the user(s) you wish to delete.

Click the Delete. icon.
A confirmation dialog box appears, asking if you are sure.

Click Delete Users.
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System Configurations

The following describes how to manage various system configurations in ThreatQ.

« Indicator Statuses

o Indicator Types

« Event Types

o Proxy
LDAP Authentication

Date and Time Format

Indicator Statuses

Indicator Statuses page allows you to view, duplicate, add, edit, and delete available sys-
tem-wide indicator statuses. You cannot edit and delete indicator statuses provided by

ThreatQ, but you can add new statuses and edit or delete your custom statuses.

o Viewing Indicator Statuses

Indirect Indicator Status

Adding an Indicator Status

Editing an Indicator Status

Deleting an Indicator Status

Viewing Indicator Statuses
To view existing indicator statuses, complete the following procedure.

Procedure:
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1. From the main menu, select Settings [<1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Active Poses a threat and is being exported to detection toals,
Expirad Mo longer poses a serious threat.

Indirect Associated to an actiee indicator or event fi.e. pONS)L
Review Requires further analysis.

Whitelisted Poses NO risk and should never be deplayed.

66000868

O Dema This Is 2 dema

Statuses found within ThreatQ are listed by status, number, and description within the
Indicator Statuses table.

2. Optionally, to sort the table by a column, click the column header. To reverse the

column sorting order, click the header a second time.

Indicator Statuses Table Functions:

Function Description

Change the number of entries displayed in the table. 1. Click the dropdown
menu at the top right of
the table and select

the desired option.

Sort the table by a column. 1. Click the column

header.

2. Toreverse the column
sorting order, click the

header a second time
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Indirect Indicator Status

For feeds that set multiple statuses, A status of Indirectis assigned to indicators that meet the

following criteria:
« Indicators created from the relations array are imported with a status of Indirect.

« Ifanindicator already exists, its original status value will remain the same. However, if
the status is Indirect, and itis received as a parent indicator, its value will be updated

as defined in the connector configuration.
Currently, this status only applies to CrowdStrike and iSight feeds, where:

« For CrowdStrike, Indirectindicates that ThreatQ received the indicator from the

relations list for the parent indicator.

« ForiSight Partners, Indirectindicates that ThreatQ received an indicator that does

not have an attribute of Attack or Compromised.
Adding an Indicator Status

To add an indicator status that can be applied to any system indicator, complete the fol-

lowing procedure.

Procedure:
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1. From the main menu, select Settings [<1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations At oy St
" 1 Type

ATUSTE « DESCRPMON & EOTECTFRDM FEID OVERR] o8 ATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expirad Mo longer poses a serious threat, Q
Indirect Associated to an active indicator or event fi.e. pONS). ®))]

Revlew Requires further analysts. CD A5t
Whitelisted Poses NO risk and should never be deplayed. c
O Dema This Is a dema @

2. Click Add New Status.

The Add a Status dialog box opens.

Add a Status

Status Name

Status Description

Add Status | Cancel

3. Enter a Status Name.

4. Optionally, enter a Status Description.
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5. Click Add Status.

Editing an Indicator Status

To edit an existing indicator status, complete the following procedure. You cannot edit indic-

ator statuses provided by ThreatQ.

Procedure:

1. From the main menu, select Settings £%1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Indicator Stabuses deator Types Eveit Types By LOAP

STATUSES = DESCRIPTION & PEGTECT FRGIM FETR OVIRRIGE TOTAL MDICATGRS §
Actrn Prmes a threat and is being sxparted to detection toals, )
Expired Mo longer podes a serious threat. ®))]
Indirect Associated to an active indicator or event {i.e. pOMSL [E]
Resiew Requires further analysis CB
Whitelistad Peses MO risk and sheuld rever be depbayed. D)

O oema This Is a dema &)
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2. Determine the indicator you want to edit and click Edit in the far right column.

The Edit Status dialog box opens.

Edit Status

Status Name

Demo

— Status Description

This is a demo

3. Optionally, enter a new Status Name.
4. Optionally, enter a new Status Description.

5. Click Save Changes.

Deleting an Indicator Status

To delete an indicator status, complete the following procedure. You cannot edit and delete
indicator statuses provided by ThreatQ. Custom statuses can only be deleted if there are no

indicators using that status.

Procedure:
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1. From the main menu, select Settings 1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations Al e Status

Indicator Stanuses chcator Types Eveernt Types Browy LOAP General
FTATUSTE - DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL MDICATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expirad MO |onger poses a serious threat. $)]
Indirect Associated to an active indicator or event fi.e. pONS). ®))]
Revlew Requires further analysts @ 195
Whitelisted Poses NO risk and should never be deplayed. C

O Dema This is a dema @

2. Determine the indicator you want to delete and select the corresponding checkbox

in the first column.

3. Click the Delete icon in the upper right hand corner.

A confirmation dialog box appears.

Are You Sure?

Are you sure? This action cannot be undone

Delete statuses | Cancel

4. Click Delete Statuses.
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Indicator Types

The Indicator Types table allows you to view a list of indicator types found in ThreatQ and
the number of those indicators within the system. Indicators found within ThreatQ are listed
by type and number in the Indicator Types table.

To view Indicator Types found within ThreatQ:

1. From the main menu, select Settings 3 > System Configurations.

The System Configurations page opens.

DESCRIPTION &

Active Poses a threat and is being exported to detection toals,
Expired Mo lenger poses a serious threat,

Indirect hsmsociated tn an actie indicator or event (i pONS).
Review Requires further analysts

Whitelisted Poses NG risk and should never be deplayed.

860006

O Dema This is 3 dema
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2. Click the Indicator Types tab.

The Indicator Types tab opens.
THREATQ )  mrescioey & e

System Configurations

TOTAL INDICATORS &

GOST Hash

Hash IGN

Event Types

Event Types page allows you to view, add, and delete system events. Event Types provided
by ThreatQ cannot be edited or deleted, but you can add new event types and edit or delete

your event types.
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Custom statuses can only be deleted if there are no indicators using that event type. Events

found within ThreatQ are listed by type and number in the Event Types table.

System Configurations

EVENTTYRES « TOTAL EVENTS # TOTAL NDICATORS &

Anarymizatian
Cammand and Cantoal

Compromised PKI Certificate

- o = o

Db Attack
Exfiltration a
Host Characteristics
neident

Lagin Compromise
Malware
Spearphish

0L Injection Attack

Watchlist

2 o 2 o 8 e o o

Watering Hole

To view Event Types found withing ThreatQ:

1. From the main menu, select Settings £%1 > System Configurations.

The System Configurations page opens.

System Configurations [ETTT—

Indicator Slabuses drator Types Breernt Types Prixy LOAF General
STATUSES = DESCRIPTION & PROTECT FROM FEID CVIRRIDE TOTAL DICATORS §
Actrn Prmes a threat and is being sxparted to detection toals, )
Expired Mo longer poses a serious threat. §)]
Indirect Associated to an active indicator or event {i.e. pOMSL @
Review Requires firther analysis @ 4
Whitelisted Poses NO risk and sheuld never be deplayed. O

O oema This Is a dema &)
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2. Click the Event Types tab.

System Configurations
Indicator Statuses Indicator Types Event Types Frosy LOwP General
25
TOTAL EVENTS 8 TOTALINDICATORS 8
Anonymizatian [
Camrmard and Cantral 1
Campromised PRI Certificate a
DS Aftack 1
Exfiliration a
Host Characteristics a
neident Q
Lagin Compromise a
Mahware 1}
Spearphish a
S0L Injectian Attack a
Watchlist Q
Watering Hole 0

Event Types Table Functions:

Function Description

Changing the number of entries displayed in the table 1. Click the dropdown
menu at the top right of
the table and select

the desired option.

Sorting the table by a column 1. Click the column

header.

2. To reverse the column
sorting order, click the

header a second time.

Related Topics:
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o Editing an Event Type

« Editing an Event Type

o Deleting an Event Type

Adding an Event Type
To add an Event Type, complete the following procedure.

Procedure:

1. From the main menu, select Settings 1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

" 1 Type
ﬂﬂﬂﬂﬂﬂﬂﬂ L] PROTECT FROM FEED OVERRIDE TOTAL WDICATORS &
Active Poses a threat and is being sxported to detection toals. O
Expired Mo longer poses a serious threat. 9)]
Indirect Associated to an active indicatar or event {i.e. pONS). )]
Feview Requires firther analysis '$)] 49
Whitelisted Posss NO risk and sheuld never be deplayed. O
O Dema This isa dema 9)]
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations
Indicator Statuses Indicator Types Event Types Frosy LOwP General
25
TOTAL EVENTS 8 TOTALINDICATORS 8

Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics

ncidert

Lagin Compromise

Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Click Add New Event Type.

The Add Event Type dialog box opens.

Add Event Type

‘ Event Name

Add Type Cancel

4. Enter a Event Name.

5. Click Add Type.
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Editing an Event Type

To edit a user-generated Event Type, complete the following procedure.

ﬁ You cannot edit an Event Type provided by ThreatQ.

Procedure:

1. From the main menu, select Settings 1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations

Akl Waw Starus
Indicatar Slatuses Scator Types Evern Types Proay LDAP General
STATUSES & DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL INDICATORS &
Active Poses a threat and is being exparted to detection toals, O
Expired Mo lenger poses a serious threat. '9)]
Indirect Associated to an actie indicator or event {i.e. pOMS). @
Review Requires further analysis CD 1
Whitelisted Poses NO risk and should never be deplayed, O
O Demo This Is 2 dema '$)]
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations

Indicator Statuses Indicator Types Event Types Frosy LOWP General

TOTAL EVENTS & TOTAL INDICATORS &

Anonymizatian
Camrmand ard Cantral
Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics

ncidert

Lagin Compromise

Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Determine the Event Type you want to edit and click Edit in the far right column.

The Edit Event Type dialog box opens.

Edit Event Type

— Event Name
‘ Ransomware

Save Changes Cancel

4. Enter a new Event Name.

5. Click Save Changes.
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Deleting an Event Type

To delete a user-generated Event Type, complete the following procedure.

ﬂ You cannot delete an Event Type provided by ThreatQ.

Procedure:

1. From the main menu, select Settings 1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations Add N St

Indicator Stanuses dcator Types Evern Types Proay LDAP General
STATUSES & DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL INDICATORS &
Active Poses a threat and is being exparted to detection toals, b
Expired Mo lenger poses a serious threat. 9))
Indirect Associated to an actie indicator or event {i.e. pOMS). @
Revlew Requires further analysts: 8)] 4
Whitelisted Poses NO risk and should never be deplayed, O

O Demo This Is 2 dema $))
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations

Indicator Statuses Indicator Types Event Types Frosy LOWP General

25

EVENT TYPES = TOTAL EVENTS & TOTAL INDICATORS &

Anonymizatian

Camrmand ard Cantral

Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics
ncidert

Lagin Compromise
Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Determine the event type you want to delete and select the corresponding check-

box in the first column.

4. Click the Delete icon in the upper right hand corner.

A confirmation dialog box appears.

Are You Sure?

Are you sure? This action cannot be undone

Delete statuses | Cancel

5. Click Delete Types.
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Proxy

The System Configuration: Proxy page allows you to enable or disable proxies.

A Users are required to set their proxy server settings to use http: for their
https: traffic. The ThreatQ Proxy Configuration page can be found by nav-
igating to Settings > System Configuration > Proxy.

Access Proxies
To access proxies:
1. From the main menu, select Settings 1 > System Configurations.
The System Configurations page opens to the Indicator Statuses tab.

2. Click the Proxy tab.

The Proxy Configuration tab loads.

System Configurations

Indicator Typas Ewant Types Precey LDwR

Enable proxy for HTTP traffic
@ Enable proxy for HTTRS traffic
Protocal

-]
hatpe

Proxy Table Functions:
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Function Description

Enabling a proxy for HTTP or HTTPS 1. Check the correct proxy type and
traffic enter configuration details. Click
Save Changes. ThreatQ will check

that the proxy has been configured

properly.
Disabling a proxy for HTTP or HTTPS 1. Uncheck the proxy you wish to dis-
traffic able, and click Save Changes.

LDAP Authentication

ThreatQ allows you to configure system access via LDAP, the Lightweight Directory Access
Protocol. You can configure a basic LDAP or configure a secure connection to your LDAP

server.

To Access the LDAP tab:

1. From the main menu, select Settings [<1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Active Poses a threat and is being exported to detection toals,
Expirad Mo longer poses a serious threat.

Indirect Associated to an actiee indicator or event fi.e. pONS)L
Review Requires further analysis.

Whitelisted Poses NO risk and should never be deplayed.

66000868

O Dema This Is 2 dema
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2. Click the LDAP tab.

The LDAP tab opens.

THREATQ 3

System Configurations

LDAP D Enabled

Lightweight Directory Access Protoral (LIAF) is a lightweight chent-server pratocol for accessing directary services and is used for authentication and storing information. Complete the fiekds below to

Sl the prifmary Sserves SEings and mag your permission levels (o LDWP, How i work

Primary Server Settings Map Your Permission Levels to LDAP

iNote: You can not fist the some (0AP User Groap for Multiple permission leeis

ldapSuper
635
adrministrator
IdapAnalyst
Ho
IdapObserver
mermberlid
Yos
Peaple
uid

When configuring LDAP, it is important to note the following:

« Local users and LDAP users may exist on the same system.

« ThreatQ will check the LDAP user table first for any attempted login, then fall back
to the local user table if no entry is found in the LDAP directory.

Currently, ThreatQ supports LDAP authentication on LDAP servers run-
ning OpenLDAP 2.4, Active Directory 2008, and Active Directory 2012. If
you are using a different configuration, please contact ThreatQ Support.

Related Topics:
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« Required Information for Creating LDAP Authentication

o Configuring LDAP

o Configuring Secure LDAP

Required Information for Creating LDAP Authentication

Before you configure a connection to your LDAP server, you should work with your LDAP

administrator to collect, at minimum, the following information:

« the server name or IP address for the server where you plan to connect

« the server type of the server where you plan to connect, typically LDAP for basic
and LDAPS for secure LDAP

« if possible, the base distinguished name for the server directory where the user

names reside
Configuring LDAP

For ThreatQ to identify different user types, your LDAP server should include groups under

an organizational unit, OU, for each user role:

« Maintenance Account

Administrative Access

Primary Contributor Access

« Read Only Access

Note: Only users with an Administrative or Maintenance account can access
LDAP settings.
Procedure:

1. Choose the Settings icon > System Configurations.

2. Choose LDAP from the System Configurations toolbar.
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3. Configure the following server settings:

Server Address

Port #

LDAP Domain

Append Domain to

Username

Filter Field Name

Enter the name of the server where LDAP is hosted.

For example, Idap://[servername]

Typically, enter 389 for LDAP.

Enter the domain for which LDAP is configured to

authenticate.

For example: threatq.com

Choose from the following options:
« Yes for most Active Directory servers

« No for most Open Ldap servers

This field is specific to your LDAP directory con-

figuration.
Forexample:

« memberuid

o uid
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This field is specific to your LDAP directory con-

figuration.

Group Field Name For example:

e CN

« memberof
Choose from the following options:
Use RDN? « Yes to use Relative Distinguished Names.

« No to use full Distinguished Names

This field is specific to your LDAP directory con-
Organizational Unit
figuration. Your LDAP administrator should provide

(OU)
the correct value for this field.
This field is specific to your LDAP directory con-
figuration.

User Lookup Name For example:

« memberUid, for Active Directory

« uid, for Open LDAP

4. Next, Map Your Permission Levels to LDAP, using the user groups that your
LDAP administrator established for each user role. For roles not mapped, you
should enter a hyphen: "-." You cannot save the configuration without entering a

value in each field.
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Note: You can not list the same LDAP User Group for multiple permission

levels.

» For OpenLDAP, consider the following example:

Maintenance Account IdapSuper
Administrative Access administrator
Read Only Access IdapObserver

Primary Contributor Access = |dapAnalyst

« For Active Directory, consider the following example:

Main-
CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=c-
tenance
om
Account
Admin-
istrative CN=linux-admins,CN=Builtin,DC=yourdomain,DC=com
Access
Read Only . _
CN-=read-onlyCN=Builtin,DC=yourdomain,DC=com
Access
Primary Con-
_ CN=primary-contributor, CN=Builtin,DC=yourdomain,DC-
tributor
=com
Access
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5. Click the LDAP toggle switch to enable your LDAP configuration.
6. Click Save Changes.

If your LDAP fails to enable or fails to function properly, validate your inputs. If the con-

figuration continues to fail, please contact ThreatQ Support.

Configuring Secure LDAP
To configure secure LDAP, you must complete the following steps:

1. Enter your LDAP settings in the ThreatQ user interface.
2. Access the ThreatQ appliance command line as root and edit openldap.conf.

3. If necessary, run the ThreatQ LDAP utility, to retrieve your LDAP binding strings.

For ThreatQ to identify different user types, your LDAP server should include groups under

an organizational unit, OU, for each user role:

« Maintenance Account
« Administrative Access
» Primary Contributor Access

« Read Only Access

Note: Only users with an Administrative or Maintenance account can access
LDAP settings.
Procedure:

1. Choose the Settings icon > System Configurations.

2. Choose LDAP from the System Configurations toolbar.
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3. Configure the following server settings:

LDAP Domain

Server Address

Port #

Organizational Unit
(OU)

User Lookup Name

Use RDN?

Append Domain to

Username

Enter the domain for which LDAP is configured to

authenticate.

For example: threatq.com

Enter the name of the server where LDAP is hosted.

For example, Idaps:/[servername]

Typically, enter 636 for [daps

This field is specific to your LDAP directory con-
figuration. Your LDAP administrator should provide

the correct value for this field.

This field is specific to your LDAP directory con-

figuration.

Forexample:
« memberUid, for Active Directory
o uid, for Open LDAP

Choose from the following options:

» Yesto use Relative Distinguished Names.

« No to use full Distinguished Names

Choose from the following options:
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« Yes for most Active Directory servers

« No for most Open Ldap servers

This field is specific to your LDAP directory con-

figuration.

Group Field Name For example:

e CN

« memberof

This field is specific to your LDAP directory con-

figuration.

Filter Field Name For example:

« memberuid

e uid

4. Next, Map Your Permission Levels to LDAP, using the user groups that your
LDAP administrator established for each user role. For roles not mapped, you
should enter a hyphen: "-." You cannot save the configuration without entering a

value in each field.

Note: You can not list the same LDAP User Group for multiple permission

levels.
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« For OpenLDAP, consider the following example:

Maintenance Account IdapSuper
Administrative Access administrator
Read Only Access IdapObserver

Primary Contributor Access = IdapAnalyst

« For Active Directory, consider the following example:

Main-
CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=c-
tenance
om
Account
Admin-
istrative CN=linux-admins,CN=Builtin,DC=yourdomain,DC=com
Access
Read Only o _
CN-=read-only,CN=Builtin,DC=yourdomain,DC=com
Access
Primary Con- _ . o .
_ CN=primary-contributor, CN=Builtin,DC=yourdomain,DC-
tributor
=com
Access

5. Click the LDAP toggle switch to enable your LDAP configuration.
6. Click Save Changes.

7. Access the ThreatQ command line as root.
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8. Use vi to edit /etc/openldap/ldap.conf. Make sure that your settings are as follows:

#
# LDAP Defaults

#

# See ldap.conf(5) for details

# This file should be world readable but not world writable.

BASE dc=[your domain],dc=com

URI ldap://[your servername]:389 ldaps://[your servername] :636

#SIZELIMIT 12
#TIMELIMIT 15

#DEREF never
TLS_CACERTDIR /etc/openldap/certs

# Turning this off breaks GSSAPI used with krb5 when rdns =
false
SASL NOCANON on

TLS REQCERT allow

Caution: ThreatQ recommends that you edit Idap.conf on the appliance,
rather than editing off box and uploading it. If you do edit the file off box,
ensure that you use a linux editor. Windows and Mac editors may corrupt
the file.

If your LDAP fails to enable or fails to function properly, validate your inputs. If the con-

figuration continues to fail, please contact ThreatQ Support.
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Date and Time Format
You can configure the date and time format of your choice system-wide within the ThreatQ

platform.

Note: If you make changes to the date and time format while another user is
working concurrently in the same ThreatQ installation, that user must refresh
their browser for the changes to take effect.

Related Topics:

« Configuring Date and Time Format

Configuring Date and Time Format

1. From the main menu, select Settings 1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations A ow Status

Evert Types

STATUSES « DESCRIPTION & PROITECT FROW FEED: CIVIRRIDE TOTAL INDIKCATORS &

Artive Poses a threat and is being exported to detection toals.
Expired Mo longer poses a serious threat.

Indirect Associated toan acte indicator or event {i.e. pDMS)L
Resiew Requires further analysis.

Whitelisted Poses NO risk and should never be deplayed.

CH N N N N,

O bema This Is a dema
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2. Click the General tab.

The Date and Time Format tab opens.
THREATQ) 3

System Configurations

DATE AND TIME FORMAT

Date Format Time Format

MMIDDAYY @ 12 haur -]
DOMMAYY 24 haur
MDD

3. Select the desired Date Format.
4. Selectthe desired Time Format.

5. Click Submit to save your settings.
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Traffic Light Protocol (TLP)

Traffic Light Protocol (TLP) schema provides a set of designations used to ensure that sens-
itive information is shared with the appropriate audience. ThreatQ provides a method for des-
ignating the availability of intelligence information by their sources. Users can also use TLP

schema to filter objects when creating an export - see the Adding an Export topic for more

details.

Administrators have the ability to configure TLP visibility settings for the ThreatQ application.
THREATQ )

Data Management
Jematic Exgpiralic Seoring Whitelsied Indicatar
TLP (Traffic Light Protocol) Enabled

TLF I5 a set of des|gnations used to ensure that sensitive information i shared with the appropriate audience; it provides a method for designating the avallability of intelligence information by thair
sources. TLP employs four colors to indicate expected sharing boundaries for data,

Sowice Mame Default TLP
abuse ch Feodo Tracker Botnet C2 IP Blocklist NOME
admin@thraatg.com NOME
Analyst@threatg.oom NOME
ATTELCK Tooks @ RED

Cofense Inteligence NOME

TLP employs four lights to indicate the expected sharing boundaries for data:

Light | Designation Description
® Red Not for disclosure, restricted to participants only.
Amber Limited disclosure, restricted to participant's organizations.
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Green Limited disclosure, restricted to the community.
White Disclosure is not limited.
TLP Assignment Hierarchy

The ThreatQ TLP assignment hierarchy is as follows (highest to lowest precedence):

Method Details
Manually Using the Add New Source option when creating an object will allow
Set you to select a TLP designation.
Source
Provided TLP information received from ingested data.
Data
Source Administrators can set a source's default TLP designation. See the
Default Apply TLP Designation to Source topic for more details.
No TLP A TLP designation has not been set for the source.
Access TLP Settings

Users can manage TLP settings for system sources by accessing the TLP tab under the

Data Management page.

1. From the main menu, select Settings 1> Data Management.

The Data Management page will load with Automatic Expiration tab selected by
default
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2. Click on the TLP tab.

The TLP Setting page will open.

THREATQ )

Data Management

Auioenatic Expiation  Scering Whikeksted Indicatars

TLP (Traffic Light Protocal) ) cnabled

TLP Is a set of designations used to ensure that sensitive information s shared with the appropriate audience; it provides a method for designating the avallability of intelligence information by their
sources. TLF employs four colors to indicate expected shanng boundarias for data,

Source Hame Detault TL?
abuse ch Feods Tracker Batnetl £2 1P Blocklist NOMNE
admin@thraatg.com NONE
Analyst@threaty com NONE
ATTRCK Took @ RED

Cofense Inteligence HONE

Configure TLP Visibility

System administrators can set visibility settings to either hide or show TLP designation lights

to users.

From the TLP Settings Page (see the Access TLP Settings topic):
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1. Click on the Enable/Disable toggle switch.
THREATQ )

Data Management

Automatic Expiration Seoring
TLP (Traffic Light Protocol) @ enabled

TLP Is a set of des|gnations used to ensure that sensitive information s shared with the appropriate audience; it provides a method for designating the avallability of intalligence information by their
sources. TLP emplays four colors to indicate expected shanng boundaries for data, i I K

Source Name Detault TLP
abwge ch Feods Tracker Botnet C2 1P Blocklist NOMNE
admini@threatg.com NONE
Analyst@threatg.com NONE
ATTECK Took @ RED

Cofense Intefligence NONE

Enabled indicates that TLP designations are visible to users.

"

Administrators will not need to click on the Save button, changes
will be made upon clicking on the switch.

Apply TLP Designation to Source

From the TLP Settings Page (see the Access TLP Settings topic):

1. Locate the source to update from the list provided.

ThreatQ User Guide, Version 4.20 73



THREAT() /i~ Traffic Light Protocol (TLP)

e A
&
E' You can use the Filter by Source Name field to locate the desired
source.
THREATQ 3
Data Management
sulornatic Expiration  Seoring Whiteissed indicatars
TLP (Traffic Light Protocol)
TLP is a set of designations used to ensure that sensitive infarmation is shared with the appropriate audience; it provides a methed for designating the avallability of intelligence inform
sources. TLF employs four colors to indscate expected sharing boundaries for data. b rk
Source Name Default TLP
caf
Cofense Intelligence NONE
- J

2. Click on the TLP dropdown to the right of the source and select the appropriate

TLP designation.
THREATQ )

Data Management

Ausomartic Expisation

scoring T Wwihitalisted indicatars

TLP (Traffic Light Protocol) ) Enabled

TUP s a set of designations used to ensure that sensitive infarmation is shared with the appropriate audience; it prosides a method for designating the availability of intelligence information by their
spurces, TLP employs four colors to indicate expacted shanng boundaries for data, How it work

Saurce Nams Default TLP
LP Status
abiuse.ch Feodo Tracker Botnet C2 IP Blocklist NOME
L L=
adrnin@threatg eam AMEBER -
GREEN
Analyst@threaty com WHITE
NENE
ATTRLCK Tools & RED
Cofense Intelligence NOME

3. Click on Save.
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Update TLP Schema using TLP Default - Command

Use the following command to update the TLP schema for an Object Source or Object Attrib-

ute Source with the source's default TLP designation.

See Apply TLP Designation to Source topic for more details on setting a
default TLP designation for a source.

You should use this command to update your system to match default TLP configurations,
specifically attributes and sources that were added to the Threat Library prior to the release
of the TLP feature introduced with ThreatQ 4.11. This command will override previous

TLP schema settings for a source including ones set by users. You will be prompted to con-

firm the action after entering the command. All updates will be recorded in the audit log.

The command will update using the default TLP designation. If a default
designation is set to None, all references to the source will be updated to
None.

Update All Sources
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command:

sudo php artisan threatqg:apply-tlp-defaults

4. The application will warn you that this action is not reversible and will require user

confirmation before proceeding.
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5. Type Yes to confirm and proceed with the action.

The application will automatically be placed into maintenance
mode. After the command has completed its operation, the applic-
ation will be automatically be brought out of maintenance mode.

Update a Specific Source
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command:

sudo php artisan threatqg:apply-tlp-defaults --

sources="<your source>"

* . af
G You can apply the command to multiple sources by listing the
sources in a comma-delimited format.
Example: --sources="CrowdStrike, AlienVault"

4. The application will warn you that this action is not reversible and will require user

confirmation before proceeding.

5. Type Yes to confirm and proceed with the action.

The application will automatically be placed into maintenance
mode. After the command has completed its operation, the applic-
ation will be automatically be brought out of maintenance mode.
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Convert TLP Command

Use the following command to update all object sources and object attribute sources that
have TLP stored as an object attribute. This command will not affect TLP attributes that have
already been converted. Users should use this command for new incoming data, such as

migrating data into the system, which has TLP attributes but no TLP set.
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatqg:convert-tlp-attributes

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Use Scenarios:

Object has one or more TLP Attributes with an invalid TLP (not currently in the TLP

options)

« Ifthe Object has just one TLP Attribute - none of its Sources or Attribute Sources

will be updated.

« Ifthe Object has more than one TLP Attribute - any Sources or Attribute Sources
that match the Attribute Source of the TLP Attribute will not be updated.

Object has a single valid TLP Attribute

ThreatQ User Guide, Version 4.20 77



THREA Tﬂ H Traffic Light Protocol (TLP)

« All of the Object Sources and Object Attribute Sources will be updated to match the
value of the TLP Attribute.

Object has multiple TLP Attributes

« Each TLP Attribute will be evaluated separately.

« Any Object Sources or Object Attribute Sources whose source matches that of the
TLP Attribute will be updated with the value of the TLP Attribute.

« Any Object Sources or Object Attribute Sources whose sources do not match will

not be updated.

« Ifthere are no matches at all between the source of the TLP Attribute and any of the
Object Sources or Object Attribute Sources, a new Object Source will be added using
the Attribute's TLP value. Each of the Object Attributes will receive a new Object Attrib-

ute Source with the TLP value as well.

ThreatQ User Guide, Version 4.20 78



THREA Tf? H Threat Library

Threat Library

The Threat Library is the central repository within ThreatQ that organizes and combines

external and internal threat data.
The Threat Library can be broken down into three segments:

System Objects

Threat data, both ingested and manually added, is referred to as System Objects and is sor-

ted and categorized by object type.

Advanced Search

The Advanced Search page is the primary interface for the Threat Library that allows you to

search, filter, and sort through System Objects.

Object Details
The Object Details page allows you view detailed information about a specific object.

Advanced Search

The Advanced Search page is the primary interface for the Threat Library. You can search
for any system object within the application, filter returned system objects, and apply bulk

changes to search results. You can click on an individual object to navigate to its details

page.
Depending on how you have navigate to the Threat Library will determine which object
types appear on the page.

Threat Library Navigation Menu

You can click on Threat Library > Object Type to open the advanced search for a particular
object type or select Browse All. You can change or add additional object types using the
Global Filters.
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Search Link

You can click on Search > Advanced Search to open the advanced search for all object

types within the Threat Library.
Refining Search Results

You can use the Global and List filters to narrow down your search for a specific object or

object type.
Related Topics:

« Performing an Advanced Search

« Managing Search Columns

o Exporting Search Results to CSV

« Managing Searches

« Global Filters

« List Filters

Performing an Advanced Search

"l

You can also click on Threat Library > Browse All to navigate to the
advanced search page or click Threat Library >Object Type to navigate to
the advanced search page for a specific object type.

To perform an advanced search:

1. Choose the Search icon.

ThreatQ User Guide, Version 4.20 80



THREA TQH Threat Library

2. In the Search dialog box, choose Advanced Search.

The Advanced Search page opens.

THREAT(QQ 3 % Rrveabitiores L ARatycics
6 sdversaries 4 @ Threat Library
@ Attack Fatterns i All Objects M
0 Campaigns 4 Load Search = [ Save
6 Coursas of Action 2
@ Events 2 Indicators (626) M Manage Columns = m
@ Explait Targets 1 E Statn | %c ]
Files 1
WALUE = ™PE = DATE CREATED ~
€Y ricenis — ERER B - 05/13/2018 03:11pm
Indicators GBE L] IP Address 05/13/2019 031 1pm
& 182.176.132.213 IP Address 05/13/2019 0311 1pm
O Signatures 4
@ IP Address 05/13/2019 031 1pm
@T;ﬁlﬂ o
@ 186.31.189.232 IP Address 05/13/2019 03:11pm
TTPs @ F IP Address 05/13/2019 03:11pm
0 @ 201.238.152.20 IF Address 051372019 03;:11pm
Victims
@ IP Address 0512/2019 03:11pm
@ IP Address 05112019 03:11pm
£ IP Address 05/11/2019 03:11pm
<l 2 3 4 5 6 7 .. 69 > Rowsperpage 10 =

3. Choose your object search category by selecting an object type from the Global Fil-

ter dropdown list or selecting an object type from the left-hand list.

See the Global Filters and List Filters topics for more information on
narrowing down your search.

4. Press Enter or Return.

5. Optionally, repeat steps 3 and 4 to further narrow your search.
Managing Search Columns
You can choose which columns to display in your search results.

To select columns:
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1. Navigate to the Advanced Search page.

2. Choose Manage Columns.
@ Threat Library

All Objects - Q, search for keywords...

Load Search = [ Save

@ Indicators (686)

| Typa ~ | [ Status  + ] | Score  ~
VALUE = TYPE =

@ 217.199.175.216 IP Address
@ 201.203.99.129 IP Address
@ 189.213.208.168 IP Address
@ 64,62.228.170 IP Address
@ 216.71.120.100 IP Address
@ 46.28.109.151 IP Address

Filters =

M Manage Columns =

®

&

®

Date Created

Description

Expiration Date
Last Modified

Related Adversaries

Score

Sources

Status

pm

pm

am

05/02/2019 03:11pm

3. Select the columns you wish to display. Clear the columns you wish to hide.

Global Filters

Global filters allow you to filter advanced search results by specific details associated with

an object.
Additional Topics:

« Filtering by Attribute

o Filtering by Date Created

« Filtering by Keyword

« Filtering by Last Modified
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o Filtering by Object Type

« Filtering by Relationship

« Filtering by Value Contains

Filtering by Date Created

Complete the following procedure to filter Advanced Search results by the date the objects

were created.
Tofilter by Date Created:
1. Click on the Filters option and select Date Created.

The Date Created dialog box opens.
I ———

Date Created

is before b

‘ May v 9 hd 2019 v 0317 PM ® uTc -

2. Select one of the following options to determine how the filter is applied:

Option Result
is before Search results include items before a selected date
is after Search results include items after a selected date

is in the range _ _ _
Search results include items in a selected range of dates

of
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Result

Search results include items within the selected number of

is within the last
days.

3. Use the controls to select date options based upon the selection in step 2.

4. Click Save.
Filtering by Last Modified

Complete the following procedure to filter Advanced Search results by the date objects were

last modified.
To filter by Last Modified:
1. Click on the Filters option and select either Last Modified.

The Last Modified dialog box opens.
| SSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSssssssssssss>s>s>s>s>->>>>>>>>>>>> |

Last Modified

is before b

— Date " . Time . Time Zone

May - 9 v 2019 - 0319 PM © uTc -

2. Select one of the following options to determine how the filter is applied:

Option Result

is before Search results include items before a selected date

is after Search results include items after a selected date
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Option Result

is in the range

¢ Search results include items in a selected range of dates
o

L Search results include items within the selected number of
is within the last
days.

3. Use the controls to select date options based upon the selection in step 2.

4. Click Save.

Filtering by Attribute
You can filter the Threat Library list to include or exclude objects with a specific attribute.
From the search results:

1. Click on the Filters option and select either With Attribute or Without Attribute.

The Attribute Filter dialog box opens.

With Attribute *

2. Select an Attribute Type.

3. Enter an Attribute Value associated with the Attribute Type.

"l

Users can leave the Attribute Value field blank to filter for any value
associated with the selected Attribute Type.
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4. Click on the Plus icon to the right of the dialog box to add another attribute and

repeat steps 2-3. This step is optional.

5. Click on the Add button.
The filters will be applied to the search results.

The following section applies to using multiple attribute filters.

G The Match Any/All toggle option will allow users to configure the filter to
include objects that either fit one attribute filter or all. The Any option will
be selected by default. This means the filter will display results that fit any
of the attribute filters. The All option means the filter will display results that

fit all attribute filters.

Example:
ANY - Match Toggle Selection
Setting Field Value
Attribute Type Attack Phase
Filter A
Attribute Value C2
Attribute Type Severity
Filter B
Attribute Value High
Filter Options Any/All Toggle Any
Result Search Results are filtered to include/exclude objects with Attack
esu
Phase: C2 OR Severity: High attributes.
ALL - Match Toggle Selection
Setting Field Value
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Attribute Type Attack Phase
Filter A
Attribute Value C2
Attribute Type Severity
Filter B
Attribute Value High
Filter Options Any/All Toggle All
Resul Search Results are filtered to include/exclude objects with Attack
esult
Phase: C2 AND Severity: High attributes.

Common Scenarios
The following scenarios demonstrate the Attribute Filter option in use with search results.
Applying a "With Attribute" filter (All items with an Attribute Type and Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. Userclicks on the Filters button and select With Attribute.

The Attribute Filter dialog box opens.

3. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.

4. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results update to show all Indicators with an attribute of Attack

Pattern: C2.
Applying a "Without Attribute" filter (All items without an Attribute Type and Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filter button and select Without Attribute.
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The Attribute Filter dialog box opens.

3. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.
4. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results update to show all Indicators without an attribute of
Attack Pattern: C2.

Applying a "Without Attribute" filter (All items Without a specific Attribute Type with any

Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filters button and select Without Attribute.

The Attribute Filter dialog box opens.

3. User selects Attack Pattern as the Attribute Type and leave the Attribute Value
blank.

4. User clicks on Add.

The User will now see a search parameter Without Attribute with Attack Pattern
listed. The search results update to show all Indicators that do not have an Attrib-

ute Type of Attack Pattern assigned to them.

Applying keyword filters then applying a "With Attribute" filter

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User searches for keyword: demo.
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The User will see a search parameter listed Keyword: "demo" and the results

update to show only indicators that mention demo.

3. Userclicks on the Filters button and select With Attribute.

The Attribute Filter dialog box opens.

4. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.

5. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results will update to show all Indicators that mention the
keyword demo AND have an attribute of Attack Pattern: C2.

Editing multiple attributes that were applied as part of the search parameters

1. User clicks on the Threat Library tab and navigates to the Indicators tab.

2. User clicks on the Filter button and select With Attribute.

The Attribute Filter dialog box opens.

3. The User specifies two attributes:
» Attack Pattern:C2
« Severity: High

4. Userclicks on Add.

The User will now see two search parameters under the With Attribute section -

Attack Pattern: C2 and Severity: High. The search results updates to show all
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Indicators with an attribute of Attack Pattern: C2 and Severity: High. The search
parameter for attributes is defaulted to Any. This indicates that objects with an

attribute of Attack Pattern: C2 or Severity: High are displayed.

5. User clicks on the Filters option and selects With Attribute.

A form will load with all applied filter attributes.

6. The User clears the Attack Pattern's Attribute Value field and clicks Add.

The User will now see two search parameters under the With Attribute section:
Attack Pattern: Any and Severity: High. The search results updates to show all

Indicators with an attribute type of Attack Pattern OR Severity: High.
Add multiple attributes and toggle Match from Any to All

1. User applies two attribute filters to the indicators results: Attack Phase: C2 and

Severity:High.

The filtered results will display any indicators that has either of those attributes.

2. User clicks on the Any/All Match toggle button and select All.

The filtered results will display any indicator that has both of those attributes
Filtering by Relationship

The Relationship Filter option allows you to filter the Threat Library by related objects. Using

the Relationship filter, you can:
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« Filter search results to include objects related to a specific object.

« Filter search results to include objects using multiple related object filters. You will
also have the option to set the filter to include objects that fit one of the multiple fil-

ters or all.
To Filter by Related Object:
From the search results:
1. Click on the Filters option and select Relationship.

The Filter by Relationship dialog box opens.

Filter By Relationship

‘> Search for keywords...

2. Use the textbox provided to select an object.

ﬂ Repeat step 2 to add multiple object filters.

3. Click on Add to apply the filter.

'd N\

ﬂ The Match Any/All toggle option will allows you to configure the fil-
ter to include objects that either fit one related object filter or all. The
Any option will be selected by default. This means the filter will dis-
play results that fit any of the related object filters. The All option
means the filter will display results that fit all related object filters.
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Examples:
ANY - Match Toggle Selection
Setting Related Object
Filter A ABC Indicator
Filter B DEF Event
Filter Option Any
Search Results are filtered to
Result include objects related to the ABC
Indicator OR the DEF Event.
ALL - Match Toggle Selection
Setting Related Object
Filter A ABC Indicator
Filter B DEF Event
Filter Option All
Search Results are filtered to
Result include objects related to the ABC
Indicator AND the DEF Event.

Filtering using Tags

Using the Tags filter allows you to filter search results based on tags applied to an object.

From the search results:
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1. Click on the Filters option and select Tags.

The Filter by Tag row opens.

@ Global Filters

Adversaries -

Tag Add Tag =

2. Select Add Tag.
The Add Tag dialog box opens.

Add Tag -

dver
Phishing

ame 3 DDoS

‘I'I‘"”[D Au'r‘:l CH:I.T]' T

3. Use the supplied text field to select a tag.

4. Repeats steps 2-3 to apply multiple tag filters.

ﬂ The Match Any/All toggle option will allows you to configure the filter to
include objects that either fit one tag filter or all. The Any option will be
selected by default. This means the filter will display results that fit any of
the tag filters. The All option means the filter will display results that fit all-
tag filters.

Examples:
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ANY - Match Toggle Selection
Setting Tag
Filter A Phishing
Filter B DDoS
Filter Option Any
Search Results are filtered to
Result include items with either Phishing
OR the DDoS tags.
ALL - Match Toggle Selection
Setting Tags
Filter A Phishing
Filter B DDoS
Filter Option All
Search Results are filtered to
Result include items with both Phishing
AND DDoS tags.
Filtering by Object Type
You can filter the Threat Library by object type using the following methods:
Threat Library Navigation Menu:
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1. Click on the Threat Library navigation dropdown and select an Object Type.

() Threat Library ~ A Investiga

Adversaries
Campaigns
Courses of Action for keywords

© = P

Events

Exploit Targets

Files

< B

i)

”
s

Incidents

Indicators
Signatures Type

Tasks Usermname

C QR =)

TTPs

The Advanced Results page opens with the applied object type filter.

7 B L ——— B . o o @
Threat Library @ Global Filters
Saved Ssarchen = pe—— = |, Search for keywords “ m
[ indicatons 2
@ Indicators (2,050}
Type = l Stabes * ]
Value Type Dafe Created - Last Modified Status Score
frusime Lsamanme 12/04/2018 03:55pm 12/04/2016 04:22pm Active
99.248,17.200 IP Adidrass 120472018 03:54pm 12/04/2018 03:58pm Active
295.228.176.38 1P Addrass 12/04/2018 03:54pm 12/04/201 B 03:56pm Active
B8B.5.202 134 IP Addrass 12/04/201B 03:54pm 12/04/201 6 03:58pm Hctive
GEL2E 150 86 IP Agdrass 120452018 03:54pm 121044201 B 03:58pm Aotive

Object Global Filter Dropdown List
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You can use the Global Filter dropdown list to select more than one object type.

1. Click on the Object Type dropdown list and select one or more object types.

() Home (% Threat Library ~ A Inves

@ Gilobal Filters

Saved Searches - Indicators - O, Search for keywi

(M} Indicators

O All Objects
O Adversaries
O Campaigns

O Courses of Action

O Events L:E -
O Exploit Targets mame
O Files
O Incidents
i ] "

Indicators Addrest
O Signatures > Addres:
[J Tasks

T 9B.5.202.1349 P Addres:

The Advanced Search Results page updates the list with the selected object type
(s)
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THREATQ ) @ vome 0 meattivan -

Threat Library @ Global Filters

Saved Searches ~ Events, Indicators = Cl, Search f

(" Events
@ Indicators (@ Indicators (2,050)
Type ~ Status v
Value Ty
trustme Ut

Filtering by Keyword
You can filter the Threat Library items on the Advanced Search by keyword.
To filter by keyword:

1. Navigate to the Advanced Search page.

2. Enter a keyword in the Keyword text field and press <Enter> or <Return>.

ﬂ Repeat Step 2 to apply multiple keyword filters
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Each keyword filter appears in a box below the keyword text field. "
) Global Filters

All Cojacts - I

oorss (I D

3. Click on the X for each filter to remove it or select Clear All Filters to remove all fil-

ters
Filtering by Value Contains

You can now filter Threat Library objects by a specific value or string within the value using

the Value Contains filter.
To filter by contains:

1. Click on the Filters option and select Value Contains.

The Contains dialog box opens.

Value Contains

2. Select an Object, enter a Value, and click Add to apply the filter.

List Filters

List filters allow you to apply object type-specific filters to the advanced search results.
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"1

List filter options vary based the object type currently being viewed.
Example: the score filter can only be applied to indicators.

o Filtering by Type

o Filtering by Status

o Filtering by Score

Filtering by Type

You can filter Indicators, Signatures and Files by specific types of each.
Example: Filter the Signature list to include YARA types only.

To filter by status:

1. Click on the Type button and select a type from the dropdown menu.

ﬂ You can select multiple types using the check boxes.

The search results will update with the applied filter.

A flag icon at the top of the results list will indicate that a filter is in use.

Title

GPL IMAP login buffer overflow attempt (2101842:16)
GPL IMAP find overflow attempt (2101904:8)
GPL IMAP fetch overlow attempt (2103070:3)

GPL IMAP examine overlow attempt (2103068:2)

Filtering by Status

You can filter Indicators, Signatures and Tasks by Status.
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Tofilter by status:

1. Click on the Status button and select a status from the dropdown menu.

ﬂ You can select multiple statuses using the check boxes.

The search results will update with the applied filter.

A flag icon at the top of the results list will indicate that a filter is in use.

Indicators (73,021)
Value Type
113.160.148.100 IP Address
113.0.21.200 IP Address
114.33.160.65 IP Address

Filtering by Score

You can filter indicators in the advanced search results by score.

ﬂ This option is only available for indicators.

To filter by score:

1. Navigate to the Advanced Search results page by selecting Search > Advanced

Search then selecting Indicators from the left-hand object type menu.

"l

You can also select Threat Library > Indicators from the main
menu.
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2. Enter a keyword in the Keyword field and press <Enter> or <Return>. This step is

optional.

3. Select the Score filter option.

The Scoring Filter dialog dropdown opens.

Score -

(=] Define your score Claar

? 9

2o | 8o |

N )

{ ﬂ The scale offers a range of 1-10.

4. Adjust the score scale to filter the results.
Filtering by Scoring Range
You can move the two scale markers to select a scoring range.

Example: Move the left marker to 6 and the right marker to 8 to filter the search

results to include indicators with a score between 6 and 8.

Filtering by Specific Score
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You can move the scale makers to the same scoring number to filter by a specific

Score.

Example: Move the left and right markers to 8 to filter the search results to

only include indicators with a score of 8.

5. Select Submit to apply the filter.

ﬂ Select the Score filter again and select Clear to remove the filter.

Managing Searches

If you are following a particular area of interest, you can create a Saved Search. Saved

Searches can then be run at any time.
Related Topics:

o Saving Searches

« Running Saved Searches

o Deleting Saved Search

Saving Searches
To save a search:

1. Choose the Search icon.

2. In the Search dialog box, choose Advanced Search.

"l

You can also select Threat Library > Object Type to navigate to the
advanced search page for a specific object type.

3. Perform an Advanced Search.
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4. Choose Save.

The Save Search dialog box opens.

Save Search

Name Your Search

5. Enter a name for the search in the Save Search dialog box.

6. Choose Save Search.

Running Saved Searches
To run a saved search:

1. Navigate to the Advanced Search page.
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2. Click on the Load Search dropdown list and then select the desired saved search

from the list.

@ Threat Library

All Objects v Q Search for keyw

Load Search = [8) Save

SaveThatSearch

ThreatQ Search T

Deleting Saved Search
To delete a saved search:

1. Navigate to the Advanced Search page.

2. Click on the Load Search dropdown, hover the mouse over the saved search to
delete, and click on the I icon.
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3. Click on Delete Search to confirm.

Are You Sure?

This will delete your search from the list.

Delete Search ‘ Cance

Exporting Search Results to CSV

You can export your search results as a CSV file, which allows you to use the data in

another application, such as external spreadsheet software.

4 Y
"1

ﬂ If you export a file with too many search results, the file may be too large to
open in desktop applications. If you encounter this issue, you should sep-
arate your exports into smaller chunks of data.

ﬂ When exporting search results to a CSV file, if you include additional
columns beyond the default, this modification will impact the performance
of the export process.

A J/

To export search results to a CSV file:

1. Navigate to the Advanced Search page.

2. Perform your search.
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3. Choose Export.
@ Threat Library

All Objects - Q. search for keyword

Load Search + [0 Save

@ Indicators (660)

I Type - ‘ I Status o l I Score

VALUE # TYPE
@ 189.213.208.168 IP Address
@ (462228170 IP Address

The CSV file downloads to your desktop.

System Objects

ear all filters Filters =

(0 Manage Columns =

DATE CREATED -

05/03/2019 03:11pm

05/02/2019 03:117om

Threat data, both ingested and manually added, is referred to as System Objects and is sor-

ted and categorized by object type.

See the topics below to learn more about each object type and how to manage them.

System Objects:

Adversaries
« Events
o Files

Indicators

Signatures
STIX Overview
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Adversaries

Adversaries are the suspected groups that are attempting to do malicious activity.

Related Topics

o Adding Adversaries

« Editing Adversaries

« Deleting Adversaries

Adding Adversaries
To create an Adversary:

1. Go to Create > Adversary.

The Add an Adversary dialog box opens.
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Add An Adversary

Source

Add new source

Description

Add Adversary

2. Enter a name.
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3. Select a Source from the dropdown provided.

-

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo
Selact a source

Status

L

4. Enter a description.

5. Click Add Adversary.

Editing Adversaries
To edit the name of an Adversary:

1. Locate and click the adversary.

The Adversary Details page opens.
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THREATQ 3 i\ Threat Library

Claw ¢ Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17pm

@ Context

@) Attributes (2) | (0 ATTRIBUTETYP

@ Attributes

&3 Sources (1) Q Start typing

2. Click on Edit next to the Adversary name.

The Edit Adversary dialog box opens.

Edit Adversary

‘ Claw

3. Make the desired change to the Adversary name.
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4. Click on Save Adversary.
Deleting Adversaries
To delete an Adversary:

1. Locate and click on the adversary.

The Adversary Details page opens.
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THREATQ 3 i\ Threat Library

Claw ¢ Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17pm

@ Context

@) Attributes (2) | (0 ATTRIBUTETYP

@ Attributes

&3 Sources (1) Q Start typing
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2. Click on the Actions menu and select Delete Adversary.
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Claw & Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17f

@ Attribu

@ @ Context

(

o | ® Add Attribute O  ATTRIBUT
2 Add Comment

(= Q Starti
¢ Add Relationship

R O Confidenc
5 Add Source

& | O MalwareT

© Create Task

&
Generate PDF
J

@I il Delete Adversary =1 Source

Tasks (2)
@ () Self Monitor
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A confirmation dialog box appears.

Are You Sure?

Deleting this Adversary can not be undone.

Delete Adversary | Cancel |

3. Click on Delete Adversary.

Events

Events are observations made by the threat intelligence community of adversaries’ mali-

cious attempts.
Related Topics:

« Adding Events

« Editing Events

« Deleting Events

Adding Events
To add an Event:

1. Go to Create > Event.
The Add Event dialog box opens.
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Add Event *

— Type
Spearphish

Source

Add new source

Provide the content you'd like to be parsed for the spearphish event.

> m

Drag your file here or click to browse

Copy/Paste content here..

Supported files include: eml, emlx, msg, and txt

2. Selectthe Event Type.

3. Select a Source from the dropdown list provided.

-

n

You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo

Select a source

Status
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4. Add the date and time the event occurred in the Date of Occurrence fields.

5. Add an Event Title.
6. Click Add Event.

Editing Events

To edit an Event:

You can also update the Event Type by clicking on the Type dropdown
located to the top-right of the Event's Object Details page.

1. Locate and click on the event.

The Event Details page opens.
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THREATQ 3 i\ Threat Library A In

Help Desk DoS Attack ¢edit
EVENT: DOS ATTACK

Created: 04/17/2019  Event Date: 04/17/2019 10:38am  F

@ Context

@ Attributes (1) | (0 ATTRIBUTE TYPE

@ Attributes (1)

O Sources (2) Q Start typing...
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2. Click on Edit next to the Event name.

The Edit Event dialog box opens.

Edit Event %

‘ Help Desk DoS Attack ‘

‘ April v 17 - 2019 v 10:38 AM ® uTC -

3. Make the desired change to the Event Name and Event Date.

4. Click on Save Event.
Deleting Events
To delete an Event:

1. Locate and click the event.

The Events Details page opens.
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THREATQ 3 i\ Threat Library A In

Help Desk DoS Attack ¢edit
EVENT: DOS ATTACK

Created: 04/17/2019  Event Date: 04/17/2019 10:38am  F

@ Context

@ Attributes (1) | (0 ATTRIBUTE TYPE

@ Attributes (1)

O Sources (2) Q Start typing...
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2. Click on the Actions menu and select Delete Event.
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Created: 04/17/2019 Event Date: 04/1

G Context

[¢

@ «
o © Add Attribute ]

2 Add Comment
=1
& Add Relationship

< C
5 Add Source

@ |
© Create Task

& |
Generate PDF

@| E
] Delete Event |

] . .
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A confirmation dialog box appears.

Are You Sure?

Deleting this Event can not be undone.

Delete Event Cancel

3. Click on Delete Event.

Files

Files are received from various intelligence providers and contain information on indicators,

adversaries, and events within ThreatQ.

Related Topics:

o Adding Files
« Editing Files

o Deleting Files

Adding Files
To add a File:

1. Click Create New > File.

The Add a File dialog box opens.

ThreatQ User Guide, Version 4.20

123



THREA TG m Threat Library

ADD A FILE

&

Drag your file here or click to browse.
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2. Drag the file into the dialog box or browse and locate the file.

The Add a File Dialog box will update.

Add a File %
emailrhino.png
— Title

emailrhino.png

Source il

Add new source

— Category
‘ Actor Overview -
Malware Safety Lock
: off Q) on
Enabling this will .zip malware files for safer
downloading.
Tags

Type here and press enter

3. Update the Title if desired.
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4. Select a Source from the dropdown list provided.

4 Y

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo
Selact a source

Status

| 5

5. Select a Category.

6. Select whether to have the Malware Safety Lock on or off.

"l

Enabling the safety lock will create a .zip file so any malware is safer
for download.

7. Add any desired tags.

ﬂ Tags added appear on the File Details page.

8. Click Save File.
Editing Files
To edit a File Name:

1. Locate and click on the file.

The File Details page opens.
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THREATQ 3 i\ Threat Library

spam_email.txt ¢ Edit
FILE: GENERIC TEXT

Created: 03/12/2019 First Seen: 03/12/2019 07:27am

@ Context

2 Attrilabac 113 I M ATTRIBUTE TY

@ Attribute

2. Click on Edit next to the File name.

The Edit File dialog box opens.

Edit File

Title
spam_email txt

spam_email.txt

3. Make the desired change to the File Name.
4. Click on Save File.
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Deleting Files
To delete a File:
1. Locate and click the file.
The File Details page opens.
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THREATQ 3 i\ Threat Library

spam_email.txt ¢ Edit
FILE: GENERIC TEXT

Created: 03/12/2019 First Seen: 03/12/2019 07:27am

@ Context

2 Attrilabac 113 I M ATTRIBUTE TY

@ Attribute
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2. Click on Actions menu and select Delete File.
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G Context

@ Add Attribute

DIy,
2 Add Comment
af
& Add Relationship
79
& Add Source
> 1
© Create Task
3 |
Generate PDF ,
) |

3' ] Delete File

A confirmation dialog box appears.

ThreatQ User Guide, Version 4.20 131



THR EA TO” Threat Library

Are You Sure?

Deleting this File can not be undone.

Delete File Cancel

3. Click on Delete File.

Indicators

Indicators are the so called "finger prints" associated with a malicious attempt or adversary

group.

Indicators can be scored to allow you to apply weighting using contextual information, such
as sources, attributes, and indicator types, as they are added to ThreatQ. You can also seta

manual score per indicator.

You can also apply expiration dates to an indicator to when it is determined to pose less of a

threat to your infrastructure than other indicators.
Related Topics:

Adding an Indicator

Parsing for an Indicator

Indicator Search

Indicator Expiration

Automatic Expiration and Policies

Indicator Scoring
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« Whitelisted Indicators

« Indicator URL Normalization

Adding an Indicator
To add an Indicator:

1. Click on Create > Indicator.

"1

You can also select Indicator Parser from the Create menu if import-
ing a file. The option is located under the Import section of the
Create menu. See the Parsing for an Indicator topic.

The Add Indicators dialog box opens.

Add Indicators "

Parse For Indicators Add Indicator
Value
ype -

Source -

Add new source

Status *

2. Enter a value in the Value field.

3. Select the Type of Indicator.
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4. Select a Source from the provided dropdown list.

4 Y

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo
Selact a source

Status

| N

5. Select a Status for the indicator.

6. Click Add Indicator.
Parsing for an Indicator

1. Click on the Create button, located at the top of the dashboard and select Indicator

Parser under the Import heading.

"1

You can also click on Create > Indicator and then select the Parse
for Indicators option at the top of the Add Indicators modal.
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The Add Indicators dialog box will load.

Add Indicators "

Parse For Indicators Add Indicator

Provide the content you'd like to be parsed for indicators.

& :

Drag your files here or click to browse

Supported files include: xml, plain text, csv.

Normalize URL Indicators

e — |

2. Do one of the following:
« Drag yourfile(s) into the left pane.
« Click on Click to Browse, and locate the file you wish to upload.
« Copy/paste the contentin the right pane.

3. Select the Parser to use and click on Next Step.

4. Select whether to save or delete the file after the import.

"

Steps 5-7 pertain to saving the file. Skip to step 8 if you are not sav-
ing the file after import.

5. Update the File Title if needed.

6. Enter an optional File Description.
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7. Confirm or update the File Category.

8. Select a Source from the dropdown menu provided.

e

ﬂ Users can also click on Add a New Source if the desired source is
not listed in the dropdown menu. If administrators have enabled TLP
view settings, users can select a TLP classification light for the new
source in the dropdown menu provided. See the Traffic Light Pro-
tocol (TLP) topic for more information on TLP classifications.

Add Indicators

Parse For Indicators Add Indicator

demao

Select a source

[ |
9. Select a Status to be applied to the extracted indicators.
10. Select any optional Attributes to be applied.
11. Click on Next Step.
ﬂ If the file contains events that are detected, the Step 2: Review
Events page opens. Indicators may be new or pre-existing. Pre-exist-
ing indicators are identified by a badge within the table. You can isol-
ate new and pre-existing indicators by using the tabs at the top of the
right hand panel.
12. Locate and select one or more indicators using one of the following options:
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« From within the contents (on the left)
« From the table (on the right)
» By using the Select dropdown menu
13. Once you have selected one or more indicators, you can perform these functions:

1. Add Info - Click the Add Info button to open the Add Info dialog box where you

can perform the following functions:

« Add Attributes to the indicator: add one or more attributes to the selected

indicator(s). Once completed, click Add Attributes.

« Link to Another Object: Link the selected indicator(s) to another object

(indicator, event, adversary, file) and click Link Object.
« Set Status: Select a status and click Set Status.

2. Edit the type or status of an indicator by clicking its type or status in the table and

selecting an option from the dropdown menu.

3. Add Indicator - If you notice an indicator on the left that was not extracted, you

can add it by clicking Add Indicator and completing the process.

4. If you wantto search within the table, use the fields at the top of the columns.

If at any point, you wish to abandon the import, click x ABANDON THIS
IMPORT.

15. Click on Finish Import.
CSV File Format - Parsing

When importing a .csv file to parse for indicators using the ThreatQ CSV File Parser, the .csv

file must meet the following criteria:
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o The file must be comma-delimited.
« The file mustinclude at least the following columns:
o Indicator

o Type: This column cannot contain types that are not already established in
ThreatQ. You cannot add custom indicator types and indicator types are case

sensitive. Choose from the following:
« CIDR Block
« CVE
« Email Address
« Email Attachment
o Email Subject
» File Path
» Filename
« FQDN
o Fuzzy Hash
o GOST Hash
« IP Address
. MD5
o Mutex
» Password
« Registry Key
o SHA-1
o SHA-256
. SHA-384
o SHA-512
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o String
. URL
« URL Path
« User-agent
» Username
« X-Mailer

o Status

If the file is not properly delimited, missing a required column, or containing a valid type, it

will fail upon upload.
Editing Indicators
To edit an Indicator:

1. Locate and click on the indicator.

The Indicator Details page opens.

THREA TQ 3 i\ Threat Library

2.50.52.255 & Edit
INDICATOR: IP Address

Created: 04/17/2019  First Seen: 04/12/2019 07:49pi
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2. Click on Edit next to the Indicator name.

The Edit Indicator dialog box opens.

Edit Indicator

Value
zzygdx.com

Type
FQDN v

3. Make the desired change to the indicator Value and Type.

4. Click on Save Indicator.
Deleting Indicators
To delete an Indicator:

1. Locate and click on the Indicator.

The Indicator Details page opens.
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Demo & Edit
INDICATOR: Email Subject

Created: 04/17/2019  First Seen: 04/17/2019 07:16pm  Expires: add date =

@ Attributes

@ Context
@ «
@ Add Attribute No attributes have
@ ! Click the Add button to add atl
& Add Comment
B¢
& Add Relationship
] Add S
jua} ource
7 =7 sources
|

@ Create Task

‘5) I ATT&CK Tools

[ Generate PDF

O

W Delete Indicator

= ) Tags

x Operations

2. Click on Delete this Indicator located to the top right of the page.

A confirmation dialog box appears.

Are You Sure?

Deleting this Indicator can not be undone.

Delete Indicator Cancel

3. Click on Delete Indicator.
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Indicator Search

Indicator Search allows you to search indicators based on a wide range of modifiers and
search criteria. For example, when searching for an event, the results will include all indic-

ators related to that event.

Using indicator search will provide the total number of indicators matching
the criteria of your search, however, the page will only load 1,000 indic-
ators within the results table.

With respect to searching for IP Address or CIDR Block indicators, your results will be as fol-

lows:

« If searching for an IP Address, CIDR blocks will be returned if they fall within the

range.

« If searching for CIDR blocks, IP addresses will be returned if they fall within the

range.

This will search indicator values as well as Attribute of type “IP Address”
(for instance, if an IP address is associated to another IP address through
a passive DNS relationship).

Performing an Indicator Search

To perform an Indicator Search:
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1. From the main menu, click the Search icon.

The Search dialog box appears.

SEARCH

Advanced Search Indicator Search

During a search, you may use a percent sign (%) ta match characters in a string. For example,
specifying net% matches netwark, netware, netscape, and so on: See more examples.

2. Click Indicator Search.
The Indicator Search page appears.
THREATQ 3 iy Threat Library A Inw Lk Analytics

Q, Indicator Search

Select a search filter - - u
e ] lide Form =

3. Select the desired search parameters and operators using the dropdowns, and

enter the values.

Parameter Operator
Is
' Is not
Indicator Class
Is Blank
Is Not Blank
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Parameter Operator

Indicator Value

Contains

Does Not Contain
Is

Is not

Is Blank

Is Not Blank

List of Indicators

Contains

Does Not Contain
Is

Is not

Is Blank

Is Not Blank

Indicator Status

Is

Is not

Is Blank

Is Not Blank

Indicator Type

Is

Is not

Is Blank

Is Not Blank

Date Created

Is

Is not

Is after

Is before

Is in the range of
Is Blank

Is Not Blank

Date Last Modified

Is

Is not

Is after

Is before

Is in the range of
Is Blank

Is Not Blank
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Parameter Operator

Contains
Does Not Contain
) Is
Attachment Title
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Adversary
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Event Title
Is not
Is Blank

Is Not Blank

Is

Is not

Is Blank

Is Not Blank

Event Type

Contains
Does Not Contain
) Is
Attribute
Is not
Is Blank

Is Not Blank

Click + to add more parameters. When your search consists of more than one para-

meter, you can select and or or using the dropdown between the search parameters.
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4. Click Search.
Search results are displayed in a search results table.
THREATO 3 il Threat Library Lo Investigations Lid Analytics

Q, Indicator Search

Indicator Status - Is - Active - n

[ Reset Recent Searches = Hide Form =
Search :QESU|[._: ‘Make Bulk Changes to 1,000 Indicators
Showing 1 te 25 of 1000 Row count: 25 3

M INDICATOR & TYPE & S{EU.CE STATUS & SCORE & DATE CREATED & EXPIRATION DATE & AE‘WERS#.RIES

1.178.179,217 IP Address J:yhlj‘ Active a 03/15/2019 07:04pm

1.179.170.7 |P Address J:yT' Active Q 03/15/2019 07:04pm

101.187.28.8 IP Address Jrf’yhlj" Active a 03/15/2019 07:04pm

B 103.13.29.158 1P Address J:JI‘_’," Active 0 03/15/2019 07:04pm

103.16.131.20 IP Address JI'ID;"T- Active ] 03/15/2019 07:04pm

5. (Optional) Change the number of entries shown in the search results table by

clicking the dropdown menu at the top right and selecting the desired option.

6. (Optional) Click a column header to sort the data by column, and click again to

reverse sort order.

7. (Optional) Search within a column by clicking within the search field at the top of

the column, entering a search keyword, and pressing Enter.
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Results will be shown below the search query.
THREATQ )  m ety

Q Indicator Search

Indicator Status - Is - Active - n
m [ Recent Searches Hide Form =

Search Resulis Make Bulk Changes to 1,000 Indicators

Showing 1 to 25 of 1000 Row count: 25 3
M INDICATOR & TYFE & s?UICE STATUS @ SCORE & DATE CREATED & EXPIRATION DATE & aEVFRSARIES
1.178.179.217 IP Address J:thj‘ Active 0 03/15/2019 07:04pm
B 1.1791470.7 1P Address JI'IC;'T- Active 0 03/15/2009 OT:04pm
101.187.28.8 IP Address J:yhl;" Active 0 03/15/2019 OT:04pm
@ 103.13.29.158 1P Address J:JI‘J’" Active 0 03/15/2019 07:04pm
103.16.131.20 IP Address J:y?- Active 1] 03/15/2019 O7:04pm

You can hide the query to view more of the search results.
Making Bulk Updates to Search Results

The bulk update tool allows you to make batch changes to the objects in your Search res-

ults. The tool is limited to 1000 objects per update.

To make bulk updates to search results:
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1. From the main menu, click the Search icon.

The Search dialog box appears.

SEARCH

Advanced Search Indicator Search

During a search, you may use a percent sign (%) ta match characters in a string. For example,
specifying net% matches netwark, netware, netscape, and so on: See more examples.

2. Click Indicator Search.

The Indicator Search page appears.
THREATQ 3 i\ Threat Library

Q, Indicator Search

Select a search filter - - u
, ‘ Hide Form =

3. Perform your Indicator Search.
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4. Atthe top of the Search Results, choose Make Bulk Changes to 1,000 Indicators.

The Bulk Update Tool appears.
THREATO 3 () Home ) Threat Library ~ s Investigations

Bulk Update Tool Your changes will affect 1,000 Indicators
Apply a new status

Provide an additional source
Select a source o
Add new source

Apply Attributes

- v Selact a source -

Add new source

Relate 1o ancther object (e.g. an indicator, event, adversary, etc...)

Update Expiration Policy

Extend Date

Add a number of days to expiration date:

5. Optionally, apply a new object status by choosing from the dropdown.
6. Optionally, enter an additional source.
7. Optionally, apply one or more attributes:

a. Choose an Attribute Type from the dropdown.

b. Enter an Attribute Value.

c. Enter an Attribute Source.

d. Optionally, choose the add icon to apply additional attributes.

8. Optionally, relate your search results to another object in the platform. As you

enter the related object, ThreatQ offers type-ahead suggestions.

ThreatQ User Guide, Version 4.20 149



THREA TQH’ Threat Library

9. Optionally, update the object's expiration policy, by choosing an option from the

Update Expiration Policy dropdown.

10. Click Apply Changes.

Indicator Status
Every indicator in the system will have a status applied to it.

The default statuses that ship with a standard installation of ThreatQ are as follows:

Status Description

Active Poses a threat and is being exported to detection tools.
Indirect Associated to an active indicator or event (i.e. pDNS).
Review Requires further analysis.

Whitelisted | Poses NO risk and should never be deployed.

Expired Indicator has reached its expiration and has been is deemed by an ana-

lyst to pose less of a threat to their infrastructure than other indicators.

"1

You cannot delete a default status but you can add new custom statuses
to be used. See Adding an Indicator Status and the Related Topics sec-
tion below for more details.

A J

Most exports in ThreatQ are configured to use the Active status to signal deployment to
external devices. However this can be modified and each status can be used however your

organization sees fit.
Related Topics:

« Changing the Status of an Indicator

« Indicator Statuses
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o Indicator Expiration

« Automatic Expiration and Policies

Changing the Status of an Indicator

Changing an indicator’s status is straightforward, except in the case of whitelisting CIDR
Block indicators. When whitelisting a CIDR Block indicator, this process generates a whitel-

isting rule. See Whitelisted Indicators for more information.

Changing the status of an indicator:

1. Locate and click the indicator to open its details page.

2. Click the status dropdown menu, and select the desired status.

SCORE: o0-Verylow =~ (i) STATUS: [ Active

Expired

No longer poses a serious threat.

Indirect

iated to an active indicator or event (i.e. pDNS).

Review
Requires further analysis.

ided. Whitelisted
to this object. Poses NO risk and should never be deployed.

The status will be updated.
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N

ﬂ If an Administrator or the Primary Contributor are whitelisting a CIDR
BLOCK indicator, there is a different process, as this actually gen-
erates a whitelisting rule. For more information, see the Creating a
Whitelist Rule topic.

. J

Indicator Expiration

Expiration ("Expired") is a status that can be assigned to an indicator. The expired status
should be used when an indicator is deemed by an analyst to pose less of a threat to their

infrastructure than other indicators.
Related Topics:

Ways an Indicator can Expire

Expiration Date Displays

Changing an Individual Indicator's Date

« Automatic Expiration and Policies

Ways an Indicator can Expire

- An analyst manually changes an indicator(s) status to "Expired"

This can be achieved by visiting an individual indicator's details page, then using the

Status dropdown in the top right hand comer of the page to change the status.

If the analyst wishes to change the status of multiple indicators at the same time, they
can use the advanced search tool to find the indicators they'd like to update, then click

the Bulk Update button found directly to the right above the search results.
« An analyst manually sets an expiration date for a specific indicator

Each indicator has the option to have an expiration date set, which once past, will

toggle the status of that indicator from it's current status to "Expired".
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« An expiration policy has been applied to the source reporting an indicator and

therefore an expiration date is automatically set for that indicator during inges-

tion

Using the “Expiration” tab on the Indicator Management page, a ThreatQ admin has
the ability to apply expiration policies to all ingested information, both new and exist-

ing, coming from a specific intelligence source.

ﬂ If an indicator is reported by multiple sources that have expiration policies,
the date will be set using the greater expiration date. For example, if both
Feed A (with a 5 day policy) and Feed B (with a 3 day policy) report the
same indicator on the same day, that indicator will automatically expire 5
days from now.

&

Changing an Individual Indicator's Date

When viewing a specific indicator, its expiration date can be changed by clicking on the link

next to the expiration information.

THREATO 3 iify Threat Library 2 Investigations Lul Analytics

195.123.245.83:447/tt0002/william-
pc_w629200.f71819bb1edf5078c2b2ab2aff931102/5/bcclientdll64/
INDICATOR: URL

Created: 05/09/2019  First Seen: 05/09/2019 07:31am  Expires: add date -
Add 7 days
. Add 14 days
@ Attributes (10) Y
(@ context Protect from auto-expiration
@ Attributes (10) | O ATTRIBUTETYPE = Remove current expiration date JE =

= Caciemns AL

Options include:

ThreatQ User Guide, Version 4.20 153



THR EA TO” Threat Library

Add 7 Days This will extend the current expiration date by 7 days.
Add 14 Days This will extend the current expiration date by 14 days.
Protect from This will set the indicator to "Never Expire". Once set, this indic-

Auto-Expiration ator will be exempt from all automated expiration processes
regardless of circumstances. The only way for this indicator to

expire moving forward is by analyst choice.

Remove Current | This will remove the currently set expiration date. If this indicator

Expiration Date | is reported by an intelligence feed (with an expiration policy) in

the future, a new expiration date will be added at that point in time.

Expiration Date Displays

Option Image Description
No expir- . In this example, the indicator will not automatically expire
ation date E‘m:”rl)E'Si %gg—gﬁ-te%(ﬁramon date has not been specified.

has been set
This status will be changed if an analyst sets an expiration date
or a new source (wjth an expiration policy applied to it) reports

this indicator in thelfuture.

An expir- Expires I thigsexample, the indicator has an expiration date set of
ation date is 1/20/2017. This means that this indicator will expire when the cal;
set endar day changes frgm the 19th to the 20th of January (based

on ThreatQ's server tir|ne, not the user's local time).

ExpiresYMh)e@a?@ %Rj@}i(;n date is less than 7 days away, ThreatQ will
switch to show a relative version of the date.

Protected %ometim s an analyst will want an indicator to stay "Active" regard-
Never Expire (change) =
from auto- less of any automated circumstances. In this case you can set an
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Description
matic expir- indicator to be protected from auto-expiration, which will display the
ation (Never words "Never Expire". This can only be "overwritten" by an analyst.
Expire)

Automatic Expiration and Policies

Automatic expiration allows you to deprecate stale intelligence based on a set of defined cri-
teria. As the data becomes less relevant, ThreatQ sets the status to Expired, which relieves

the data burden on your team or infrastructure.
You can configure automatic expiration from the Data Management page.

1. From the navigation menu, click on settings icon 1 and select Data Management.

The Data Management page will open with the Automatic Expiration tab selected by
default.

Related Topics:

 How ThreatQ Calculates Expiration Dates

Selecting an Expiration Policy per Feed

Applying Expiration Policy Changes to Data

Adding Exceptions

Common Expiration Policy Scenarios

How ThreatQ Calculates Expiration Dates

Scenario Description

Indicator If an indicator has an expiration date and it's reported by a new

Reported by source that has an expiration policy, ThreatQ will set the expiration
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Source with an | date using the policy with the greater expiration date.

Expiration

Policy

Indicator If an indicator has an expiration date and it's reported by a new
Report by a source that has an expiration policy of Never Expire, ThreatQ sets

Source with an | that indicator to Never Expire.
Expiration
Policy of Never

Expire

Indicator If an indicator is reported by a source that has an exception for the
Reported by a | indicator, the exception expiration date will be used regardless of
Source with an | the greater expiration date.

Exception for

that Indicator G An exception takes precedence over the source’s

expire policy.
Indicator If an indicator is reported by a source with an Expiration Policy and
Reported by then reported by a second source with another Expiration Policy, the

Two Different | greatest expiration date is selected to set the expiration date. The
Sources expiration date will be set based on the date the second source

reported the indicator.

Indicator If an indicator is reported by a source that has an exception for the
Reported by indicator and then reported by a second source, the greatest expir-
Two Different | ation date is selected despite the exception. The expiration date will
Sources, one be set based on the date the second source reported the indicator.
with an Excep-

tion
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Selecting an Expiration Policy per Feed

You can choose from three options when configuring an expiration policy for a source of

intelligence:
Option Description
Don't automatically ThreatQ sets all feeds to Don't Automatically Expire until an
expire (No policy set) analyst decides otherwise. When set, indicators reported from

this specific feed do not have an expiration date automatically
applied to them.

If an indicator is reported by Source A (an intelligence feed
without an expiration policy), and is later reported by Source B
(an intelligence feed that expires data in 7 days), ThreatQ sets

the indicators to automatically expire in 7 days.

Automatically Expire When setting a specific intelligence feed to Automatically
Indicators Expire Indicators, ThreatQ requires you to provide a specific
number of days. After you configure this setting, it applies to all
intelligence currently in the system, as well as new intel-
ligence as itis ingested. ThreatQ calculates the appropriate
expiration date based on the number of days from ingestion.
Once an indicator's expiration date is met, its status changes

to Expired.

Automatic Expiration

Unburden your teamn from the task of manually deprecating intelligence. Based on a set of eriteria defined and controlled by you, threat intelligence will automatically
expire as it becomes |ess relevant to your team and infrastructure. How it works

abuse.ch SSLBL IP Blacklist Don't automatically expire - & Exceptions =

Exceptions

INDICATOR TVPE & POLIEY &

Binary String - Expire | 25 days after ingestion. | Delete
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Option Description

Never Expire Using this setting ensures that all intelligence reported by a

specific feed is protected from automatic expiration, regard-

less of scenario.

Applying Expiration Policy Changes to Data

When updating an expiration policy, the system now applies the update to all selected
existing data in the platform to honor the new policy. This process can take a while based on

system resources and the number of indicators in the system.

Refer to the following table for estimates on the total time required for the system to apply the

selected policy to existing data, based on the following criteria:

« Dataset: 6 Million Indicators

« System Specifications: 32GB VM 4 vCPU

Indicators to reset

Reset and Recal- Total Time for
expiration out of - Expire Indicators
culate Expiration Reset
6m total indicators
50,000 3 hours and 30 53 seconds
_ 3 hours 31 minutes
minutes
100,000 4 hours and 51 1.8 minutes
. 4 hours 53 minutes
minutes
200,000 10 hours 20 minutes | 3.5 minutes 10 hours 24
minutes
1.2 million 2 days 7 hours 4 35 minutes 2 days 7 hours 40
minutes minutes
3.1 million 3 days 16 hours 42 | 3.5 hours 3 days 20 hours
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Indicators to reset .
Reset and Recal- Total Time for

expiration out of - Expire Indicators
culate Expiration Reset

6m total indicators

minutes

4 days 7 hours 17
5.3 million _ 4.7 hours 4 days 12 hours
minutes

Adding Exceptions

ThreatQ allows you to add exceptions based on specific indicator types within in a feed in
addition to setting an expiration policy at a global level for all intelligence ingested by a spe-

cific feed.
To Add an Exception:

1. Navigate to the Automatic Expiration tab under Data Management.
2. Locate the source.

3. Click Exceptions to expand the option.

The Exceptions option menu opens.

Data Management

Whitelisted Indicatars Autpenatic Expiration Seoring

Automatic Expiration

Unburden your team from the task of manually deprecating intelligence, Based on a set of criteria defined and controlled by you, threat intelligence will automarically expire as it becomes less
Falevant Do your team and infrasiructure, How il works

abuse.ch Feodo Tracker Botnet C2 1P Don't automatically expire - Exceptions »
Blecklist

admin@threatg.com Don't automatically expire - Exceptions ¢
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4 N\
"1

The number of existing exceptions for a source will be listed next to
its Exceptions link.

€ Exceptions »

4. Click Add Exception.
5. Select the Indicator Type from the dropdown.

6. Enter the number of days after the item has been ingested before expiring.

ﬁ Repeat steps 4-6 to add multiple

7. Click on Delete next to the row to delete an exception.

8. Click on Save.

Common Expiration Policy Scenarios

Scenario Description

An indicator is reported by a single 1. On 10/1, Source A reports the indicator
source (with an expiration policy) and the expiration date is setto 10/8.

2. When the date switches from 10/7 to 10/8,
this indicator is queued to have its status

changed to Expired.

An indicator is reported by Source A 1. On 10/1, Source A reports the indicator
(with an expiration policy of 7 days) and the expiration date is setto 10/8.

and 3 days later is reported by 2. Source B reports the same indicator 3
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Scenario Description

Source B (with an expiration policy of days later (10/4). The indicator's expir-

10 days). ation date is set using the greatest expir-
ation date between the two sources. In
this example, the new expiration date will
be 10/14 (10 days from when it was repor-
ted by Source B).

3. When the date switches from 10/14 to
10/15, this indicator is queued to have its

status changed to Expired.

An indicator is reported by Source A 1. On 10/1, Source A reports the indicator

(with an expiration policy of 7 days) and the expiration date is set to 7 days.
and is later reported by Source B 2. Source B reports the same indicator 3
(with an expiration policy of Never days later with a policy of Never Expire.
Expire). The indicator’s expiration date is removed

and the indicator is now set to Protect

from auto-expiration.

An indicator is currently set to 1. On 10/1, an indicator is in ThreatQ with a
Expired and is reported by Source A status of Expired.

(with an expiration policy of 7days). | 2 On 10/1, Source A reports the indicator.
The status of the indicator changes to
whatever the default status is for Source A

and the expiration date is set to 10/8.

3. When the date switches from 10/7 to 10/8,
this indicator is queued to have its status

changed to Expired.

An indicator is currently set to 1. Anindicator is in ThreatQ with a status of
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Scenario Description

Expired and is reported by Source A

(with an expiration policy of Never

Expire).

. Source A, with an expiration policy of

Expired.

Never Expire, reports the indicator. The
expiration of that indicator changes to Pro-

tect from auto-expiration.

A FQDN indicator is reported by
Source A (with an expiration policy of
10 days with an exception for 5 days
for FQDN indicators) and is later
reported by Source B (with an expir-
ation policy of 15 days).

. On 10/1, Source A reports the FQDN indic-

. Source B reports the same indicator 1 day

. When the date switches from 10/17 to

ator and the expiration date is set to 10/6.

"

An exception takes pre-
cedence over the
source’s expire policy.

later (10/2). The indicator's expiration date
is set using the greatest expiration date
between the two sources. In this example,
the new expiration date will be 10/17 (15
days from when it was reported by Source
B).

10/18, this indicator is queued to have its

status changed to Expired.

Indicator Scoring

Indicator scoring allows you to apply weighting to indicators and their contextual information,

such as sources, attributes, and indicator types, as they are added to ThreatQ. Indicator scor-

ing allows you to set manual scores or you can rely on ThreatQ’s scoring algorithm to cal-
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culate scores. After scores are calculated, you can change the score as desired to your cus-

tom value or accept the calculated value.
Related Topics:

« Configure Indicator Scoring

« Building a Scoring Algorithm

« Overriding the Scoring Algorithm with a Manual Score

Configure Indicator Scoring

1. From the navigation menu, click on settings icon 1 and select Data Management.

The Data Management page will open with the Automatic Expiration tab selected by
default.

2. Click on the Scoring tab.
THREATQ ) m wvescionn

Data Management

Whiteisted indicators ALTOmatic Expiration 5 T utl

Scoring Sensitivity Configuration

Indicatar scoring allows you 1o apply weighting to contextual information, such as sources, attributes, and indicator types. After scores are calculated, you can change the score as desired on
the individual indicator pages. For each subset of data below, you can increase or decrease the score,

WRCALOF SOUFCE Atributes Adversary Relationship
nadic
Binary String DECREASED ? INCREASED 0=
CIDR Black DECREASED ? INCREASED o
CVE DECREASED . ? . INCREASED o :
Email Address DECREASED . ? e e e INCREASED o :

“ After clicking sawe, these changes will take time to process and will not immediately take effect
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Building a Scoring Algorithm

As you build a scoring algorithm, you influence indicator scores based on the following cri-

teria:

Indicator Type

Indicator Source

Attributes

Adversary Relationship

Use the slider to determine the sensitivity of the criterion you select. By default, the slider is
positioned in neutral position, which in isolation produces an indicator score of zero. You

may increase the score up to 10, which creates a score of Very High. You may also

decrease the score, which creates a score of Very Low.
THREATQ )  mmeescinny

Data Management

‘Whitelisted Indicators Automatic Expiration

Scoring Sensitivity Configuration

Indicatar scoring allows you to apply weighting to contextual informaticn, such as sowrces, attributes, and indicator types, After scores are calculated, you can change the score as desired on
the individual indicator pages, For each subset of data below, you can increase or decrease the score.

LoF 5 Anrik 4 f
Binary String DECREASED ? INCREASED 10
CIDR Block DECREASED ? INCREASED 0=
CVE DECREASED ? INCREASED ]
Email Address DECREASED . ? . INCREASED o =

m Afer clicking sawe, these changes will ke time 1o process and will not immesately take effect

Influencing Score Based on Attributes
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1. Navigate to the Attributes category under Scoring.
Scoring Sensitivity Configuration
Indicator scoring allows you to apply weighting to contextual information, such as sources, attributes, and indicator types. After scores are calculated, you can change the

score as desired on the individual indicator pages. For each subset of data below, you can increase or decrease the score.

ndicater Type ndicater Source  Attributes Adversary Relationship

score ~ |is B DECREASEDF - - - - - - - - 4? S INCREASED 2 -

2. Click Add

3. Designate an Attribute Key / Value Pair
4. Adjust the sensitivity using the slider.

5. Click Save.

Influencing Score based on Adversary Relationship

1. Navigate to the Adversary category under Scoring.
Scoring Sensitivity Configuration

Indicator scoring allows you ta apply weighting to contextual information, such as sources, attributes, and indicator types. After scores are calculated, you can change the
score as desired on the individual indicator pages. For each subset of data below, you can increase or decrease the score.

Indicator Type ndicator Source Attributes #dversary Relationship

| Agitated Rhinoceras * DECREASED I : ? SRR «= - INCREASED 0 = Delete

2. Click Add

3. Select an Adversary.

4. Adjust the sensitivity using the slider.
5. Click Save.

Overriding the Scoring Algorithm with a Manual Score

Setting a manual Indicator Score:
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1. Navigate to an Indicator's Details page.

2. Click the Score dropdown and select a score.

THREATQ 3

Demo
INDICATOR: Email Subject

£ Edit

Created: 041772019 First Seen: 041772019 07:16pm

(©) context

@ sxriaues 0)

¢§’ Relationships

{2} comments (0}
}& Operations

B audit Log

@ Attributes

& sources

W ATTRCK Toch

) Tags

[&7 Description

Expires: add dee -~

SCORE: | O-Verylow = | (i) STATUS:

10- Very High
- High
| 8 - Medium

© Add
7 - Madium

Fom
5-Llow
4 -Wery Low
3 -Very Low
2 -Very Low
1= Very Low

O -Very Low

& Edit
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Optionally, you may revert to the calculated score by clicking on the Score dropdown

and selecting Generated Score.

SCORE: (i) STATUS: Active ~

I 10 - Very High

8 Add to Watchlist

9 - High

8 - Medium

_ © Add
7 - Medium

6 - Low
5-Low
© Add
4 -Very Low
3 -Very Low
2 -Very Low

1 -Very Low

0 - Very Low

10 - Generated Score

Whitelisted Indicators

There are some indicators that should be considered to be whitelisted, or non-malicious,

and we do not want those indicators going out to other systems. For example, a company’s
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own domain name would never need to be blocked.

The whitelisting process creates rules that apply to particular indicators, so that when those

indicators come in in the future, they will be automatically whitelisted.
Within this section, the following options are available:

Viewing Existing Whitelist Rules

Creating a Whitelist Rule

Editing a Whitelist Rule

Removing a Whitelist Rule

Viewing Existing Whitelist Rules

To view existing whitelist rules:

1. Click on the settings icon E] and select Data Management.

2. Select the Whitelisted Indicators tab

The Whitelist Rules page opens. Existing whitelist rules are listed in the Whitelist
Rules table.
THREATQ 3

Data Management

cenatic Expiration Seoving

Whitelisted Indicators n

Whitelisting indicators designates therm as non-malicious, which ean apply 1o yeur company's demain name of any ether domain your rganization knows L be safe, Threatl) provides you with

the ahility to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted autemarically. How iTwork

(m] RULEVALUE INDICATOR TYPE AFFECTED 2 ACTIONS
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Creating a Whitelist Rule

The process of creating a whitelist rule is almost exclusively available via the Tools menu.
However, itis important to note that whitelisting a CIDR Block indicator also creates a whitel-

istrule.

To create a whitelist rule:

1. Click on the settings icon E! and select Data Management.

The Data Management page opens.
THREATQ 3

Data Management

Automatic Expiration

Unburden your team from the task of manually deprecating intelligence. Sased on aset of criteria defined and controlled by you, threat intelligence will automatically expire as it becomes less relevant
ta your team and infrastructure

abuse.ch Feodo Tracker Batnet C2 1P Blocklist | Doet automatically exgire - Exceptions ¢
admin@threatq. com Do Autormatically expire - Exceptions
ATTELK Teals Dierrt automatically expire v Exceptions ¢
Cofense inteliparce Disrit autarmatically expire - Excoptions ¢

m A ickieg apedy, i chargges il ke e 2 prscirss at wll ot invraciatty 1ok afToct

ThreatQ User Guide, Version 4.20 169



THR EA TO” Threat Library

2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.
THREATQ )  movestoony A esgaions 1o ansiyics

Data Management

Autormatic Expiration Stonng TP

Whitelisted Indicators n

Wiitelisting indicators designates them as sen-malicious, which can apply 1o yeur company’s demain name or any other demain your soganization knows to be safe, ThreatQ pravides you with
the ability to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted automatically. How T works

D RULE VALUE + INDICATOR TYPE AFFECTED 3 ACTIONS

3. Click Add Rule.

The Add Whitelist Rules page opens.

Add Whitelist Rule

— Which indicator type will this rule apply to?
CVE

— Rule Value

CVE-2015-1461

4. Selectthe Indicator type the rule will apply to.
5. Add a Rule Value.

6. Click Next.
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Affected indicators are listed in the dialog box.

Add Whitelist Rule

Continue Editing This Rule

7. Review the affected indicators to determine if you are satisfied with the rule.

"l

The rule has not been applied yet, so you still have time to edit it
based on whether you are satisfied with how it affects the indicators.

8. Click Continue Editing this Rule.
9. Ifyou are satisfied with the rule, click Add Rule.

The rule is applied to existing indicators, and it is entered into the Whitelist Rules

table.
Any new indicators will also have the rule applied to them as they enter the system.

Editing a Whitelist Rule

"

Important: Editing a whitelist rule will not undo any changes the rule had
made prior to being edited.

To edit a whitelist rule:
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1. Click on the settings icon ['3 and select Data Management.

The Data Management page opens.

THREATQ )

Data Management

Tk Vititmisted indlcators

Automatic Expiration

unburden your team from the task of manually deprecating intelligence. Based on aset of crireria defined and conerolled by you, threat intelligence wil automatically expire as it becomes bess relevant

ta your beam and infrastructure

abuse.ch Feodo Tracker Baret C2 IF Blocklist | Do automatically expire * Exceptions »
admin@threatq. com Dt automatically expire Exceptions ¢
ATTECK Tesals Dt autarmatically expine - Exceptions ¢
Cofanse intelipance Dot Butomatically expire Excoptions ¢

BEETI o s i s g i s s el ity b o

2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.

THREATQ :, B ThrestUbrory A (mestiabons Ll Anayics

Data Management

Automatic Expration Sonng TP

Whitelisted Indicators n

Whitelisting indicators designates them as non-malicious, which can apply to your company’s demain name or any other domain your organization knows to be safe, ThreatQ provides you with
the ability to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted automatically. How it work

D RULE WALUE INDICATOR TYPE AFFECTED = ACTIONS

3. Inthe Whitelist Rules table, locate the rule you wish to edit.
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4. Click Edit.

The Edit Whitelist Rule dialog box opens.

Edit Whitelist Rule

Which indicator type will this rule apply to?

CVE

— Rule Value

CVE-2015-1461

5. Make the desired edits and click Next.

Affected indicators are listed in the dialog box.

Edit Whitelist Rule *

Continue Editing This Rule
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6. Review the affected indicators to determine if you are satisfied with the rule.

The rule has not been applied yet, so you still have time to edit it
based on whether you are satisfied with how it affects the indicators.

7. If you are satisfied, click Edit Rule.
The rule is applied to existing indicators, and itis updated in the Whitelist Rules table.

Any new indicators will also have the rule applied to them as they enter the system.
Removing a Whitelist Rule

To remove a whitelist rule:

1. Click on the settings icon E and select Data Management.

The Data Management page opens.
THREATQ 3

Data Management

Automatic Expiration

Unburden your team frem the task of manually deprecating intelligence. Sased on aset of craeria defined and carerolled by yau, threat imtzlligence wil automatically expire as it becomes bess relevant
ta your team and infrastructurs

abusech Fecds Tracker Botnet C2 IP Blocklist | Don™ automatcally expire Exceptions

admin@rhrears. cam Dt autoratically expire Excepaions ¥

ATT&CK Toals Dot aUtormatically expine Excepeions
i Lefig Doer automatical Excups
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2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.

THREATQ 3 W ThrestUbrery A Investigotions Ll Analytcs

Data Management

Automatic Expiration Seoring TLe

Whitelisted Indicators n

wihitelisting indicators designates them as non-malicious, which can apply to yeur company’s demain name o any other domain your organization knows to be safe, ThreatQ provides you with
the ability to create rules that apply 1o those particular indicatars, so that when those indicators are ingested in the future, they will be whitelisted automarically. How 17 wocks

D RULE WALUE INDICATOR TYPE AFFECTED = ACTIONS

3. Locate and select the rule(s) from the table that you wish to remove.

4 Click on the delete Icon B

A confirmation dialog box opens, asking if you are sure.

Are You Sure?

This action cannot be undone.

The status of each indicator will remain whitelisted until manually changed.

Delete Whitelist Rule Cancel
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5. Click Delete Whitelist Rule.

The rule is deleted and a confirmation alert appears in an alert bar at the top of the

page.
Indicator URL Normalization
Remove Quotes from the Beginning and/or End of an Indicator

Single and double quote characters are removed if they are the first or last character of an

indicator.

Remove Unneeded Spaces found within an Indicator

All spaces irrelevant of their position in the Indicator value are removed (when applicable).
Adjust leading protocol from indicators

Indicators with a leading protocol [http:/, hitps:/, ftp://, or ftps://] are extracted and included as
an attribute. When applicable, this indicator adjustment could change the indicator type from
URL to FQDN.

Example: Original URL indicator of http://fevilsubdomain.no-ip.biz/ would convert to a FQDN

= evildomain.no-ip.biz.
Adjust the Port from an IP Address

An IP address with a port [ex. 199.7.136.88:8143] will be truncated to the IP address and the

port assignment will be added as an attribute.

Using the previous example the following indicator/attribute will be created:

Field Value

URL 199.7.136.88

Attribute > Port 8143

Adjust Defanged/Neutered Indicators
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Indicators that have been defanged/neutered in order to “safely” share them (i.e. www [dot]
3322 [dot] org or badguy [at] gmail.com) need to be adjusted during import in order to ensure

the indicators are properly deployed.
Create an IP Address from a URL (when applicable)

Using the previous example the following indicators will be created:

Field Value

URL 51.255.131.66/civis/viewforum.php

IP Address 51.255.131.66

Create a FQDN from a URL (when applicable)

When a URL contains a domain [ex. bat99-11611.co/gate777.php] a second indicator will
be created for the domain [bat99-11611.co].

Using the previous example, the following indicators will be created:

Field Value
bat99-11611.co/g-
URL
ate777.php
FQDN bat99-11611.co

Extract HTTP Parameters from a URL Indicator

HTTP parameters [chained.j3oil-
gasinc.net/civis/iviewforum.php?keywords=9obo&amp;fid0=c27] are important but can sig-
nificantly limit pattern-matching detection capabilities due to the likelihood of parameter
deviations, as well as, hamper the volume of URL indicators being deployed. To increase

the probability of detection the http parameters are extracted and created as attributes.

In this example:
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Field

Value

URL IOC chained.j3oilgasinc.net/civis/viewforum.php

Attribute =HTTP Para-

meter = keywords

9obo&amp;fid0=c27

Maintain “WWW” on FQDN Indicators

When parsing or importing a FQDN the “www” will be maintained.

Replace and/or Remove Special Characters

ASCIl Values <32
ASCII Values > 127

<space>

Replacement

Ascii 96

Ascii145

Ascii146

Ascii147

Ascii148

Ascii151

carriage return and line feed

<space>

Control Characters

Remove

Convertto UTF8

null characters.

Remove leading and trailing space, tab, newline, carriage return, vertical tabs and
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Supported Defanging Techniques
The table below lists all supported indicator defanging techniques.
[] =>
[dot] =>
(dot) =>
[d] =>
-dot- =>
_dot_ =>
hxxp:// => http://
hxxx:// => http://
hxxps:// => https://
hxxxs:// => https://
[hxxp] => http
hxtp:// => http://
htxp:// => http://
hxtps:// => https://
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htxps://

[http]

[hitp:/N

[https]

[https:/

[at]

-at-

_at_

_@_

(@]

[www]

Signatures

https://

http

http://

https

https://

WwWw

ThreatQ allows you to ingest and manage Signatures, such as Snort and OpenlOC. While

importing, ThreatQ parses the signature file for Indicators to add. Once signatures are

included in your deployment, you can add contextual information and correlate them with

Indicators, Events, Adversaries, and Files.

Related Topics:
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o Signhatures Management Page

« Adding a Signature

o Adding a Yara Signature

Signatures Management Page

The Signatures Overview page displays all signatures in the platform. For each signature,

the table displays the Date Created, Signature Type, and Signature Title.

You can filter the table based on criteria to view specific signatures. For each signature, you

can click to view expanded details.
From the Signatures Overview page, you can do the following:

« View all signatures in the platform and details for each signature
« Filter signatures by Date Created, Signature Type, and Signature Title

« Add new signatures
Adding a Signature

To add a Signature:
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1. From the main menu, choose Create > Signature.

The Add Signatures dialog box opens.
THREATQ 3 i Threat Library A Investigations Lad Analytics

Add Signatures

Pravide the content you'd like to be parsed for signatures.
@ or
Drag your files here or click to browse

Supported file types inchude: rules, ioc, xml, b

Parse signature for indicators

Extracted Signatures

Step 1: Tell us about the import » Step 2@ Review Signatures

2. Choose the type of signature from the drop-down .

ﬂ For Yara, see Adding a Yara Signature.

3. Select a Source from the dropdown provided.

Vs

"l

You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.
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4 N\

E ."\ "
Source

Demo
Selact a source

Status

| N

5. Do one of the following:

« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste content into the right pane.

6. Optionally, select to parse the signature for indicators.
7. Choose a Signature Status from the drop-down menu.
8. Optionally, Apply attributes to all extracted signatures:

« Select an Attribute Type.

» Enter an Attribute Value.

« Enter an Attribute Source.

« Optionally, click the Add icon for additional attributes.

9. Optionally, relate the signature to another object by entering the object in the

Relate signatures to another object field.
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10. Click Next Step.

If signatures are discovered, the Results dialog box appears.

Results

We've found 979 signatures.

How would you like to proceed?

11. You can either select Submit Import to finish adding the signatures or Review to
customize what data is imported.

If you selected to review signatures, the Add Signatures Step 2: Review page
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loads.
THREATQ )

B Threat Library

Add Signatures

979 Signatures Extracted

m]

BROWSER-IE Microsoft Internet Explerer CDocument use after free attempt (268 Active

20:1)

BROWSER-IE Microsoft Internet Explerer CTreeNode use after free memary corr Active

uption attempt (26889:1)

BROWSER-IE Microsoft Internet Explorer CTreeNode use after free memary corr Active

uption attempt (26888:2)

BROWSER-IE Microsoft Internet Explorer anscroll use after free attempt (26887 Active

5

BROWSER-IE Microseft Internet Explorer onscrall use after free attemnpt (26B86:  Active

5)

BROWSER-IE Microsoft Internet Explorer anscrall use after free attempt (26B85:  Active

5)

Step 1: Tell us about the impaort » Step 2: Review Signatures

12. Select one or more signatures and click Delete.

15 Attributes

15 Attributes

15 Attributes

13 attributes

13 attributes

14 Attributes

0 Indicators

0 Indicators

0 Indicators

O Indicators

O Indicators

0 Indicators

Show Details »

Show Details »

Show Details »

Show Details ¥

Show Detalls ¥

Show Detalls »

13. Click on Show Details for a signature to review individual items in a signature.

Use the checkboxes to select unwanted signature items and click Delete.

A warning dialog box appears.

[iS

Are You Sure?

This will delete the selected Signature items from the import.

Cancel

14. Click Delete to remove the unwanted items.
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15. Click Create Signatures when finished.

Adding a Yara Signature
To add a Signature:

1. From the main menu, choose Create > Signature.

The Add Signatures dialog box opens.
THREATQ 3 i\ Threat Library A Investigations s Analytics

Add Signatures

Add new source

Pravide the content you'd like to be parsed for signatures.

&

Drag your files here or click to browse

Supported file types inchude: rules, .ioc, xr

Parse signature for indicators

Extracted Signatures

Step 1: Tell us about the import » Step 2: Review Signatures

2. Select Yara as the type of signature from the drop-down .

3. Select a Source from the dropdown provided.

-

"1

You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.
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10.

N

E * B
Source

Demo

Selact a source

Status

| 5

. Do one of the following:

« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste content into the right pane.

Optionally, select to parse the signature for indicators.

Determine the method to use if multiple signatures are discovered:
« Save independently as unique signatures

« Save as a single signature
Choose a Signature Status from the drop-down menu.
Optionally, Apply attributes to all extracted signatures:

« Select an Attribute Type.

« Enter an Attribute Value.

« Enter an Attribute Source.

« Optionally, click the Add icon for additional attributes.

Optionally, relate the signature to another object by entering the object in the

Relate signatures to another object field.
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11. Click Next Step.

If signatures are discovered, the Results dialog box appears.

Results

We've found 979 signatures.

How would you like to proceed?

12. You can either select Submit Import to finish adding the signatures or Review to
customize what data is imported.

If you selected to review signatures, the Add Signatures Step 2: Review page
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loads.
THREATQ )

B Threat Library

Add Signatures

979 Signatures Extracted

m]

BROWSER-IE Microsoft Internet Explerer CDocument use after free attempt (268 Active

20:1)

BROWSER-IE Microsoft Internet Explerer CTreeNode use after free memary corr Active

uption attempt (26889:1)

BROWSER-IE Microsoft Internet Explorer CTreeNode use after free memary corr Active

uption attempt (26888:2)

BROWSER-IE Microsoft Internet Explorer anscroll use after free attempt (26887 Active

5

BROWSER-IE Microseft Internet Explorer onscrall use after free attemnpt (26B86:  Active

5)

BROWSER-IE Microsoft Internet Explorer anscrall use after free attempt (26B85:  Active

5)

Step 1: Tell us about the impaort » Step 2: Review Signatures

13. Select one or more signatures and click Delete.

15 Attributes

15 Attributes

15 Attributes

13 attributes

13 attributes

14 Attributes

0 Indicators

0 Indicators

0 Indicators

O Indicators

O Indicators

0 Indicators

Show Details »

Show Details »

Show Details »

Show Details ¥

Show Detalls ¥

Show Detalls »

14. Click on Show Details for a signature to review individual items in a signature.

Use the checkboxes to select unwanted signature items and click Delete.

A warning dialog box appears.

[iS

Are You Sure?

This will delete the selected Signature items from the import.

Cancel

15. Click Delete to remove the unwanted items.
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16. Click Create Signatures when finished..

STIX
The following describes how to use STIX in ThreatQ:

STIX Overview

ThreatQ STIX Object Types

« STIX Data Mapping

Parsing a STIX File for Indicators

STIX Overview
ThreatQ allows you to ingest and manage STIX files. You can ingest STIX data in two ways:

« You can setup a STIX/TAXII Feed, as described in STIX/Taxii Feeds.

« You can upload a STIX file orinsert STIX data to parse for indicators, as described

in Parsing a STIX File for Indicators.

ﬁ ThreatQ supports STIX 1.1.1 and STIX 1.2.

Related Topics

« STIX Data Mapping

o ThreatQ STIX Object Types

ThreatQ STIX Object Types
STIX integration provides ThreatQ with the following additional object types.

o Campaigns
o Courses of Action

« Exploit Targets
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« Incidents

o TTP objects

These objects enable better understanding and communication of STIX data. STIX data will

be mapped to these objects and existing objects in the system.
STIX Data Mapping

The following sections display how STIX data becomes mapped to indicator objects and
attributes in ThreatQ.

o STIX Threat Actors Mapping

« STIX Indicators Mapping

« STIX Exploit Targets Mapping

o STIX Observables Mapping

o STIX Campaigns Mapping

o STIX Courses of Action Mapping

« STIX Incidents Mapping

o STIXTTP Mapping

« STIX CIQ Identity Mapping

STIX Threat Actors Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Identity Adversary.value
ID Adversary.attribute STIX Reference ID
Title Adversary.value
Type Adversary.attribute Type
Timestamp Adversary.published_at
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STIX Field ThreatQ Field Mapping ThreatQ Name
Description Adversary.attribute Description
Motivation Adversary.attribute Motivation
Sophistication Adversary.attribute Sophistication
Intended_Effect Adversary.attribute Intended Effect
Role Adversary.attribute Role
Confidence Adversary.attribute Confidence
Handling Adversary tlp
Observed TTPs TTP
Associated_Actors Adversary
Associated_Campaigns Campaign

Related Topics

STIX Data Mapping

STIX Threat Actors Mapping

STIX Indicators Mapping

STIX Exploit Targets Mapping

STIX Observables Mapping

STIX Courses of Action Mapping

STIX Incidents Mapping

STIX TTP Mapping

STIX CIQ Identity Mapping
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STIX Indicators Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Indicator.attribute Indicator Title
ID Indicator.attribute STIX Reference ID
Timestamp Indicator.published_at
Type Indicator.attribute Indicator Type
Description Indicator.attribute Description
Short Description Indicator.attribute Short Description
Producer Indicator.source
Observable Indicator
Indicated_TTP TTP
Kill_Chain_Phases Indicator.attribute Kill Chain Phase
Likely_Impact Indicator.attribute Likely Impact
Suggested_COAs Course of Action
Handling Indicator.tlp
Confidence Indicator.attribute Confidence
Indicator.attribute.source
Related Observables
Related_Indicators Indicator
Related_Campaigns Campaign
Signature
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STIX Field ThreatQ Field Mapping ThreatQ Name

Signature.type ="Snort"

Signature.value

Indicator.source

Course of Action

Indicator.attribute Start Time

Indicator.attribute End Time

Indicator.published_at

Related Topics

« STIX Data Mapping

« STIX Indicators Mapping

o STIX Threat Actors Mapping

o STIX Exploit Targets Mapping

o STIX Observables Mapping

« STIX Courses of Action Mapping

o STIX Incidents Mapping

« STIXTTP Mapping

« STIX CIQ Identity Mapping

STIX Exploit Targets Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Exploit Target.value
ID Exploit Target.attribute | STIX Reference ID
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STIX Field ThreatQ Field Mapping ThreatQ Name
Description Exploit Target.attribute | Description
Short Description Exploit Target.attribute | Short Description
Weakness Exploit Target.attribute | CWE ID
Weakness Exploit Target.attribute | Weakness Description
Configuration Exploit Target.attribute | CCE ID
Configuration Exploit Target.attribute | Configuration Description
Configuration Exploit Target.attribute | Configuration Short Description
Vulnerability Exploit Target.attribute | CVE ID
Potential_COAs Course of Action
Related_Exploit_Targets | Exploit Target

Related Topics

« STIX Data Mapping

« STIX Exploit Targets Mapping

o STIX Threat Actors Mapping

o STIX Indicators Mapping

o STIX Observables Mapping

« STIX Courses of Action Mapping

o STIX Incidents Mapping

« STIXTTP Mapping

« STIX CIQ Identity Mapping
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STIX Observables Mapping
STIX Field ThreatQ Field Mapping ThreatQ Name
ID Indicator.attribute STIX Reference ID
Indicator.attribute Description
Indicator.type IP Address
Indicator.value
Indicator.type Filename
Indicator.value
Indicator.type File Path
Indicator.value
Indicator.attribute File Size
Indicator.attribute File Format
Indicator.attribute Packer
Indicator.type MD5
Indicator.type SHA-256
Indicator.type SHA-1
Indicator.type SHA-512
Indicator.value
Indicator.type SSDEEP
Indicator.value
Indicator.type FQDN
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STIX Field ThreatQ Field Mapping ThreatQ Name
Indicator.value
Indicator.type URL
Indicator.value
Indicator.type Email Subject
Indicator.value
Indicator.type Email Address
Indicator.value
Indicator.type IP Address
Indicator.value
Indicator.type User-agent
Indicator.value
Indicator.type Filename
Indicator.value
Indicator.type Mutex
Indicator.value
Indicator.attribute Port
Indicator.attribute Protocol
Object.Description
Spearphish.value
Indicator.type Registry Key
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STIX Field ThreatQ Field Mapping ThreatQ Name

Indicator.value

Indicator.attribute Hive

Related Topics

« STIX Data Mapping

« STIX Observables Mapping

o STIX Threat Actors Mapping

o STIX Indicators Mapping

o STIX Exploit Targets Mapping

« STIX Courses of Action Mapping

o STIX Incidents Mapping

« STIXTTP Mapping

« STIX CIQ Identity Mapping

STIX Campaigns Mapping
STIX Field ThreatQ Field Mapping ThreatQ Name
Title Campaign.value
ID Campaign.attribute STIX Reference ID
Description Campaign.attribute Description
Short Description Campaign.attribute Short Description
Timestamp Campaign.started_at
Names Campaign.attribute Alias
Status Campaign.attribute Status
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STIX Field ThreatQ Field Mapping ThreatQ Name
Intended_Effect Campaign.attribute Intended Effect
Confidence Campaign.attribute Confidence
Activity Campaign.attribute Activity
Related TTPs TTP
Related Incidents Incident
Attribution Adversary
Associated_Campaigns Campaign

Related Topics

« STIX Data Mapping

o STIX Threat Actors Mapping

o STIX Indicators Mapping

o STIX Exploit Targets Mapping

o STIX Observables Mapping

« STIX Courses of Action Mapping

o STIX Incidents Mapping

« STIXTTP Mapping

« STIX CIQ Identity Mapping

STIX Courses of Action Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Course of Action.value
ID Course of Action.attribute STIX Reference ID
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STIX Field ThreatQ Field Mapping ThreatQ Name
Description Course of Action.attribute Description
Stage Course of Action.attribute Stage
Objective Course of Action.attribute Objective

Objective Confidence

Course of Action.attribute

Objective Confidence

Type Course of Action.attribute Type

Short Description Course of Action.attribute Short Description
Parameter_Observables Indicator

Impact Course of Action.attribute Impact

Cost Course of Action.attribute Cost

Efficacy Course of Action.attribute Efficacy

Related _COAs

Course of Action

Related Topics

« STIX Data Mapping

o STIX Courses of Action Mapping

o STIX Threat Actors Mapping

o STIX Indicators Mapping

o STIX Exploit Targets Mapping

« STIX Observables Mapping

o STIX Incidents Mapping

« STIXTTP Mapping

« STIX CIQ Identity Mapping
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STIX Incidents Mapping
STIX Field ThreatQ Field Mapping ThreatQ Name
Title Incident.value
ID Incident.attribute STIX Reference ID
Timestamp Incident.published_at
Description Incident.attribute Description
Categories Incident.attribute Category

First Malicious Action

Incident.attribute

First Malicious Action

Initial_Compromise

Incident.attribute

Initial Compromise

First_Data_Exfiltration

Incident.attribute

First Data Exfiltration

Incident_Discovery

Incident.attribute

Incident Discovery

Incident_Opened

Incident.attribute

Incident Opened

Incident_Opened

Incident.started_at

Containment_Achieved

Incident.attribute

Containment Achieved

Restoration_Achieved

Incident.attribute

Restoration Achieved

Incident_Reported

Incident.attribute

Incident Reported

Incident_Closed

Incident.attribute

Incident Closed

Incident_Closed

Coordinator

Incident.attribute

Coordinator

Incident.attribute

Coordinator

Reporter

Incident.attribute

Reporter
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STIX Field ThreatQ Field Mapping ThreatQ Name

Incident.attribute Reporter

Responder Incident.attribute Responder
Incident.attribute Responder

Victim Incident.attribute Victim
Incident.attribute Victim

Related Indicators Indicator

Related Observables Indicator

Leveraged_TTPs TTP

Intended_ Effect

Incident.attribute

Intended Effect

COA_Requested

Course of Action

COA_Taken

Course of Action

Confidence

Incident.attribute

Confidence

Attributed_Threat_Actors

Adversary

Discovery_Method

Incident.attribute

Discovery Method

Related Incidents

Incident

Related Topics

« STIX Data Mapping

« STIX Incidents Mapping

o STIX Threat Actors Mapping

o STIX Indicators Mapping
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o STIX Exploit Targets Mapping

STIX Observables Mapping

STIX Courses of Action Mapping

o STIXTTP Mapping

STIX CIQ Identity Mapping

STIXTTP Mapping
STIX Field ThreatQ Field Mapping ThreatQ Name
Title TTP.value
ID TTP.attribute STIX Reference ID
Description TTP.attribute Description
Handling TTP.tp

Kill_Chain_Phases | TTP.attribute

Kill Chain Phase

Intended_Effect TTP.attribute

Intended Effect

TTP.attribute

CAPEC ID

Behavior TTP.attribute

Attack Pattern

TTP.attribute

Attack Pattern Description

TTP.attribute

Attack Pattern Short Description

TTP.attribute

Malware Type

TTP.attribute

Malware Name

TTP.attribute

Malware Description
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STIX Field

ThreatQ Field Mapping

TTP.attribute

ThreatQ Name

Malware Short Description

TTP.attribute

Malware Detection Vendor

TTP.attribute

Malware Family

TTP.attribute

Exploit

TTP.attribute

Exploit Description

TTP.attribute Exploit Short Description
Exploit_Targets Exploit Target
Related_TTPs TTP
Resources TTP.attribute Tool
TTP.attribute Tool
TTP.attribute Tool Type
TTP.attribute Tool Description
TTP.attribute Tool Short Description
TTP.attribute Infrastructure Type
TTP.attribute Infrastructure
TTP.attribute Infrastructure Short Description
TTP.attribute Infrastructure Description
Indicator
TTP.attribute Persona
Victim Targeting TTP.attribute Victim Name
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STIX Field ThreatQ Field Mapping ThreatQ Name
TTP.attribute Victim <CIQ Identity Name>
TTP.attribute Targeted Systems
TTP.attribute Targeted Information
Indicator
Related Topics

« STIX Data Mapping

o STIXTTP Mapping

o STIX Threat Actors Mapping

o STIX Indicators Mapping

o STIX Exploit Targets Mapping

« STIX Observables Mapping

o STIX Courses of Action Mapping

« STIX Incidents Mapping

« STIX CIQ Identity Mapping

STIX CIQ Identity Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Party Name Object.attribute Name
Organization Name Object.attribute Organization
Industry Sector Object.attribute Industry
Nationality Object.attribute Nationality
Languages Object.attribute Language
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STIX Field ThreatQ Field Mapping ThreatQ Name
Address Object.attribute Country
Email Address Object.attribute E-Mail Address
Chat Handle Object.attribute Chat Handle
Phone Object.attribute Phone
Related Topics

« STIX Data Mapping

o STIX CIQ Identity Mapping

o STIX Threat Actors Mapping

o STIX Indicators Mapping

o STIX Exploit Targets Mapping

« STIX Observables Mapping

o STIX Courses of Action Mapping

« STIX Incidents Mapping

o STIXTTP Mapping

Parsing a STIX File for Indicators
ThreatQ allows you to upload a STIX file orinsert STIX data to parse. for indicators.
To parse a STIX file for indicators:

1. Click on the Create button, located at the top of the dashboard and select STIX
Parser under the Import heading.

The Parse For Intelligence dialog box will load.

2. Do one of the following:
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« Drag yourfile(s) into the left pane.
« Click on Click to Browse, and locate the file you wish to upload.
« Copy/paste the contentin the right pane.

3. Select or clear the Normalize URL Indicators check box. See Indicator URL

Normalization for more information.

4. Click Next Step.
5. Enter an optional Name.

6. Select a Source from the dropdown menu provided.

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

7. Select any optional Attributes to be applied.
8. Optionally, enter a comment.
9. Optionally, use the Add relationships search field to add object relationships.

10. Optionally, add any desired Tags.

G‘L If at any point, you wish to abandon the import, click Cancel. J

11. Click Apply.

New objects will become available in the Threat Library.

Object Details Page

You can click on an object within the ThreatQ application to access its details page. The

Object Details page provides you with an in-depth look at an individual object. You can

ThreatQ User Guide, Version 4.20 207



THREAT() A

Threat Library

enter comments for others to view, link related objects, and view an audit log of all activity

associated with the object.

Specific objects, such as Indicators, will display additional information such as the indic-

ator's status, score, and expiration data.

INDICATOR: FOOM

@ example.com &

SCDRE:-_’.EJ- STATUS:  actwe

2
Created: 03/08/201% First Seen: 03708/2019 06:02pm Expires: 3dd gace - 6 X Ad 5 Watehl
e |
® comex: (=) Attributes 7 © A
€ Atributes [7) 19
¥ sources (3) 19 E Sources a  Ada
@ s 19
& Descriotion (1) 19
(f" Relationships O Tags 9
0 Aoharearies [2) 19
®Fen @19
[& Description 10 & Edit
0 ncheaters (153 19
@ a2 19
) comments (1) 18 9 Adversaries 11 & Link
3% operations 19
Files 12 & Link
[ Audicrog 19 G
@ Indicators 13 # Link
@ Tasks 14 & Craate & Link
{2 Comments 15 0 Adg
2& Operations 16
B Audit Log 17
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ltems marked with an * in the Object Details Legend indicate an option
only available to specific object types.

Object Details Page Legend

Header Section
Number Field Description Reference
1 Edit Object Link | The Edit link allows you to edit Editing Adversaries
specific details about an object. Editing Events
Edit fields will differ based on the
Editing Files
type of object.
Editing Indicators
2 Score Selection* | The Score Selection dropdown Overriding the Scoring
Applies to Indicator | gllows you to override an indic- Algorithm with a Manual Score
Object Types Only | ator's score set by the scoring
algorithm.
3 Scoring Influence* | You can click on the icon to Configure Indicator Scoring
Apelies tondicator | review the criteria utilized by the Building a Scoring Algorithm
Object Types Only | anpication's scoring algorithm to
generate the Indicator's score.
4 Status* The Status dropdown menu Indicator Status
Applies to Indicator | gllows you to manually set the
Object Types Only | statys of an indicator. Default
statuses include: Active,
Expired, Indirect, Review, and
Whitelisted.
5 Add to Watchlist | The Watchlist toggle button Configuring the Watchlist
allows you to add and remove
the object from the Watchlist wid-
get.
6 Expiration* The Expire link allows you to set Indicator Expiration
Apelies tondicator | an expiration date for the indic- Automatic Expiration and
Object Types Only | ator, protect from auto-expiration Policies
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Object Details Page Legend

policies, and remove an existing

set expiration date.

Details Section

Number

Pane

Description

Reference

7

Attributes

The Attributes pane displays
attributes associated with the
object. You can Add, Edit, and
Delete attributes found in this

section.

Attributes Pane

Sources

The Sources pane displays
sources associated with the
object. You can Add additional

sources to an object.

Adding a Source to an Object

Tags

The Tags pane displays tags
associated with the object. You
can Add and Delete tags found in

this section.

Managing Tags

10

Description

The Description pane allows you
to add general information about

the object.

Description Pane

11

Adversaries

The Adversaries pane displays
adversaries associated with the

object.

Adversaries Pane

12

Files

The Files pane displays files

associated with the object.

Files Pane

13

Indicators

The Indicators pane displays
indicators associated with the

object.

Indicators Pane

14

Tasks

The Tasks pane displays tasks

associated with the object.

Tasks Pane
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Object Details Page Legend

10 Related Objects | There are several different related « Relationships Panes

panes depending on the types of

objects linked to the object.

You can use these panes to view
and add/remove linked indicators,
files, signatures, events, adversar-

ies, tasks, and investigations.

15 Comments The Comments pane allows you « Comments Pane

to record comments about the
object for other users to read and

reference.

16 Operations The Operations pane allows you to « Operations Overview

associate third-party attributes and « ThreatQ Operations Devel-

related indicators to the indicator.

opment Guide

Note: This options requires the
installation of Operations. See the
Operations Overview topic for
more details.

17 Audit Log The Audit Log panel displays all o« Common Enrichment and
actions and changes made to an Audit Log Questions
Object.

Number Field Description Reference
18 Action Menu The Actions menu allows you to o Actions Menu

execute the following actions for
an object:

« Add a New Attribute

« Add a New Comment

o Create a Task
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Object Details Page Legend

« Generate a Report
« AddaRelationship
« Add a Source

« Delete Object

19 Details Navigation | This allows you tojumptoapar- | N/A
Tabs ticular pane on the Object Details
page.

Actions Menu

The Action Menu, located on the left-hand of the Object Details page, allows users to quickly

execute system object processes.
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G Context
{

@ Add Attribute
2 Add Comment
¢ Add Relationship

& Add Source

© Create Task

Generate PDF

| ] Delete Indicator

Actions Include:
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Action

Add Attrib-

ute

Function

Brings up the Add Details dialog box to add an

attribute to the object.

Reference

Adding an
Attribute to

an Object

Add Com-

ment

Creates a new text box entry in the comment

pane.

Adding Com-
ments

Add Rela-

tionship

Brings up the Add Relationships dialog box to link

other system objects to the object.

Linking
Adversaries
Linking
Events
Linking Files
Linking Indic-

ators
Linking Sig-
natures
Linking
Tasks

Add Source

Brings up the Add Details dialog box to add a

source to the object.

« Adding a
Source to

an Object

Create Task

Opens up the Add Task dialog box.

Assigning a
Task

Generate

Report

Generates a PDF report of the object.

Generating
Reports

Delete
Object

Delete the system object.

N/A
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Context Panes

The Context section of the object details page displays attributes, sources, and tags asso-

ciated with the system object.
Related Topics:

Attributes Pane

Adding a Source to an Object

Managing Tags

Description Pane

Attributes Pane

The Attributes Pane displays any attributes associated with the system object. You can
review attribute details as well as add and remove attributes from this pane.

@ Attributes (2) © pdd

O ATTRIBUTETYPE = ATTRIBUTE VALUE = SOURCES DATE CREATED -

- abusa.£h Foodo Trackes Bstnet 02 1P Bloc o

O  Destination Fort 3 b 05/05/2019 0311 prm
kit
abusa.£h Faodo Trackir Batnit C2 1P Bloc

O Malware Type Kt 05520159 031 1pm

Related Topics:

o Adding an Attribute to an Object

o Deleting an Attribute

« Deleting an Attribute Source

Adding an Attribute to an Object

You can link adversaries to a system object.
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To add an attribute:

1.

Locate the Attributes pane on the object details page.

2. Click on the + Add Details link located to the top-right.

The Add Details dialog box opens with the Add Attributes tab selected by default.

Add Details

Add Attributes Add Source

Add new source

3. Select an Attribute Type from the Attributes dropdown and enter an Attribute

Value and Source.

ﬂ You can select the + icon to add additional attributes.

4. Select Add Attributes.

Deleting an Attribute

You can delete an attribute from the object details page.

To delete an attribute:

1.

Locate the Attributes pane on the object details page.

2. Select the checkbox next to the attribute to delete.

ﬂ You can select more than one attribute to delete
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3. Select Delete.

The confirmation dialog box opens.

Are You Sure?

Deleting the selected attributes can not be undone.

Delete Attributes Cancel

4. Select Delete Attributes.
Deleting an Attribute Source
You can delete an attribute's source from the object details page.
To delete an attribute source:

1. Locate the Attributes pane on the object details page.

2. Selectthe X next to the attribute's source.

The confirmation dialog box opens.

Are You Sure?

Deleting this attribute source can not be undone

Delete Attribute Source Cancel

3. Select Delete Attribute Source.
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Adding a Source to an Object

You can add sources to a system object in its details pane.
To add a source:

1. Locate the Sources pane on the object details page.

2. Click on the + Add link located to the top-right.
The Add Details dialog box opens with the Add Source tab selected by default.

Add Details

Add Attributes Add Source

Add new source

3. Select a Source from the dropdown provided.

-
"1

You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo
Selact a source

Status

A

4. Select Add Sources.
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Managing Tags
You can add and remove tags in the Tags pane on the object details page.
To add a tag:

1. Locate the Tags pane on the object details page.
2. Selectthe Tags text field and enter the tag.

3. Press [Enter] or [Return].

ﬂ\ Repeat steps 2-3 to add additional tags.

To delete a tag:

1. Locate the Details pane on the object details page.

2. Select the X next to the tag to delete.

Description Pane

The Description Pane section of the object details page allows you to add a description for

the system object.
To update the Description pane:

1. Locate the Description pane on the object details page.
2. Select Edit.

3. Make the required changes and select Save.

Relationships Panes

The Relationship section of the object details page displays other system objects that have

been related to the current object.
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You can link/unlink system objects from relationship panes and perform bulk updates

(related indicators pane only). You can click on a related object to navigate to its object

details page.

"1

Relationships panes will only appear if a system object is already related
to the object. Use the Actions button to relate the initial object: Actions >
Add Relationship.

Related Topics:

« Indicators Pane

« Adversaries Pane

» Files Pane

o Investigations Pane

o Signatures Pane

« Events Pane

Adversaries Pane

The Adversaries Pane allows you to link and unlink adversary to an object. You can also
add comments and adjust the adversary's confidence level. You can click on the Show in
Threat Library link to view the related adversaries in the Threat Library or on a specific
adversary name to open its object details page.

e Adversaries (1) # Show in Threat Library & Link

Confidence

© 4dd Comment

Praview
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"1

The Adversary pane will only load if there is an existing adversary linked
to the object. Click on the Action Menu and select Add Relationship to
add the first adversary.

Related Topics:

« Linking Adversaries

Configuring Confidence Level

Commenting on Related Adversaries

Unlinking Related Adversaries

Linking Adversaries
You can link adversaries to a system object.
To link an adversary:

1. Locate the Adversaries pane on the object details page.

"

The Adversary pane will only load if there is an existing adversary
linked to the object. Click on the Action Menu and select Add Rela-
tionship to add the first adversary.
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2 Selectthe ¢ Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple adversaries.

4. Click Add.

Configuring Confidence Level
You can configure a related adversary's confidence level from the Adversaries pane.
To configure the confidence level of a related adversary:

1. Locate the Adversaries pane on the object details page.

2. Click the dropdown arrow to the right of the adversary, and slide the scale to the

desired confidence level.
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0 Adversaries (1) il Showin Threat Library & Link

O @ adversary

Confidence

© Add Comment

G\ The confidence level can be setto 0, 25, 50, 75, and 100. ]

The displayed confidence level will be modified to reflect your selection.

Commenting on Related Adversaries
You can add, edit, and remove comments to related adversaries.
To add a comment to a related adversary:

1. Locate the Adversaries pane on the object details page.

2. Select Add a Comment.

The Comments text field opens.

e Adversaries {1} i) Show in Threat Library & Link

25%" ~

Confidence

ar

3. Enter a comment.

4. Click Add Comment.

To edit a related adversary comment:
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1. Locate the Related Adversaries pane on the object details page.
2. Select Edit under the comment to update.

3. Update the comment.
4

. Click Save Changes.
To delete arelated adversary comment:

1. Locate the Related Adversaries pane on the object details page.

2. Select Delete under the comment to update.

A confirmation dialog box opens.

Are You Sure?

Deleting this comment can not be undone.

Delete Comment Cancel

3. Select Delete Comment.

Unlinking Related Adversaries
You can unlink related adversaries for an object.
To unlink related adversaries:

1. Locate the Adversaries pane on the object details page.
2. Select the checkbox(es) next to the adversary(ies) to unlink.

3. Select the i unink icon.
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Indicators Pane

The Indicators Pane allows users to link and unlink indicators to an object as well as perform

a bulk update to selected linked indicators.

Indicators (2) @ Show in Threat Library & Link

(] VALUE = SCORE STATUS = REFORTED = TYPE =

o @ 10 Review 024/3019 031 1pm P Address

- ] 0 Antive DAZ5E0E 0311 pm 1# Address
P

"l

The Indicators pane will only load if there is an existing indicator linked to
the object. Click on the Action Menu and select Add Relationship to add
the first indicator.

Related Topics:

o Linking Indicators

o Performing Bulk Updates to Related Indicators

« Unlinking Related Indicators

Linking Indicators
You can link indicators to a system object.
To link an indicator:

1. Locate the Indicators pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships

Q

3. Use the supplied text field to select an indicator.

ﬂ Repeat Step 3 to select multiple indicators.

4. Click Add.

Performing Bulk Updates to Related Indicators
You can perform bulk updates to linked indicators listed in the Indicators pane of an object.
To perform a bulk update:

1. Locate the Indicators pane on the object details page.

2. Select the checkbox(es) next to the indicator(s) to update.
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3. Select the # Bulkupdate jcon.

Bulk Update Tool Your changes will affect 2 Indicators

Prowide an additional source

Apply Attributes

Extend Date

The Bulk Update form loads.

4. Select the desired changes and click Apply Changes.

Unlinking Related Indicators
You can unlink related indicators for an object.
To unlink related indicators:

1. Locate the Indicators pane on the object details page.
2. Select the checkbox(es) next to the indicators to unlink.

3. Select the i unink icon.
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Files Pane

The Files Pane allows you to link and unlink files to an object.

%

Files (1) @ Shawin Threat Library

0 TITLE 2 SOURCES DATE ADDED =

o @ % Threat Quatient 03/12/2019 07:27am

You can view a quick summary of the file by clicking the on the eye icon to the left of the file
name or click on the name itself to navigate to its object details page. You can click on the

Show in Threat Library link to view the related events in the Threat Library or download a
copy of the file by clicking on the + icon .

The Files pane will only load if there is an existing file linked to the object.
Click on the Action Menu and select Add Relationship to add the first file.

Related Topics:

« Linking Files
« Unlinking Related Files

Linking Files
You can link Files to a system object.
Tolink afile:

1. Locate the Files pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple files.

4. Click Add.

Unlinking Related Files
You can unlink related files for an object.
To unlink related files:

1. Locate the Files pane on the object details page.
2. Select the checkbox(es) next to the files to unlink.

3. Select the i unirk icon.
Signatures Pane

The Signatures Pane allows you to link and unlink signature to an object. You can click on

the Show in Threat Library link to view the related signatures in the Threat Library or on a
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specific signature name to open its object details page.

0 Slgnatl.lres (1) iR Show in Threat Library & Link

[m] NAME = TYPE = DATE CREATED

o @ W i " B ONS traf tpct £45F snort 05N 2015031 Tpm

"1

The Signatures pane will only load if there is an existing signature linked
to the object. Click on the Action Menu and select Add Relationship to
add the first signature.

Related Topics:

« Linking Signatures

o Unlinking Related Signatures

Linking Signatures
You can link Signatures to a system object.
Tolink afile:

1. Locate the Signatures pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

{ ﬂ Repeat Step 3 to select multiple signatures.

4. Click Add.

Unlinking Related Signatures
You can unlink related signatures for an object.
To unlink related indicators:

1. Locate the Signatures pane on the object details page.
2. Select the checkbox(es) next to the signatures to unlink.

3. Select the # unink icon.

Investigations Pane

. L . .
{ Q ThreatQ Investigations requires a separate license.
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The Related Investigations pane displays any ThreatQ Investigation related to the object.
Adding and removing an object to an investigation is controlled through the Investigations

interface.
You can click on the investigation to open ThreatQ Investigations.
Events Pane

The Events Pane allows you to link and unlink events to a system object. You can click on
the Show in Threat Library link to view the related events in the Threat Library or on a spe-

cific event name to open its object details page.
9 Events (1) @ Show in Theeat Library & Link

[m] NAME = QCCURRED = TWPE =

(] @ 044172019 10-38am DS Attack

The Events pane will only load if there is an existing adversary linked to
the object. Click on the Action Menu and select Add Relationship to add
the first event.

Related Topics:

o Linking Events

o Unlinking Related Events

Linking Events
You can link events to a system object.
Tolink an event:

1. Locate the Events pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple events.

4. Click Add.

Unlinking Related Events
You can unlink related events for an object.
To unlink related events:

1. Locate the Events pane on the object details page.
2. Select the checkbox(es) next to the event(s) to unlink.

3. Select = unink icon.
Tasks Pane

The Tasks Pane allows you to create, link, unlink, and delete tasks associated with an
object. You can click on the Show in Threat Library link to view the related tasks in the

Threat Library or on a specific task name to open its object details page. You can also view
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a quick summary of the task by clicking the on the eye icon to the left of the task name.
@ Tasks (1) B Showin Theeat Library © Create & Link

[m] i NAME = ASSIGNED TO STATUS = PRICRITY =

O = & wvestigate th Daveid Klees To Da Mediurmn

"1

The Tasks pane will only load if there is an existing task linked to the
object. Click on the Action Menu and select Create Task to add the first
task.

Related Topics:

« Linking Tasks

« Unlinking Related Tasks

« Deleting Related Tasks

Linking Tasks

You can link Tasks to a system object from its object details page.

ﬁ You can also related a task to a system object while creating a task.

To link a task:

1. Locate the Tasks pane on the object details page.
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2 Selectthe ¢ Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple files.

4. Click Add.

Unlinking Related Tasks
You can unlink related tasks for an object.
To unlink related tasks:

1. Locate the Tasks pane on the object details page.
2. Select the checkbox(es) next to the files to unlink.

3. Select the # unink icon.
Deleting Related Tasks

You can delete Tasks related to a system object from its object details page.

To delete a task:
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1. Locate the Tasks pane on the object details page.
2. Select the checkbox next to the task to delete.

3. Selectthe @ oelete icon.

A confirmation dialog box opens.

Are You Sure?

Deleting this task can not be undone.

Delete Task Cancel

4. Select Delete Task.

Comments Pane

The Comments pane allows users to record comments about the system object for other

users to see.
The following functions can be performed:

o Adding Comments

o Editing Comments

o Deleting Comments

Adding Comments

ﬂ Users can also click on the Actions menu and select the Comment option.

From the Object Details page:
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1. Click on the expand icon [Zl to expand the Comments pane.

2. Click on the Add Comment link located at the top-right and lower-left of the pane.

The new comment text box opens.

E COMMENTS

David Klees (10/15/2018 06:45pm)
Suspicious Activity from IP

edit delate

David Klees (10/15/2018 06:46pm)

DDoS-related attack possible

edit delete

3. Enter a comment.

4. Click on the Add Comment button.

Editing Comments

From the Object Details page:
1. Click on the expand icon [£l to expand the Comments pane.

2. Click on the Edit link located beneath the comment to update.

The edit comment text box opens.

E COMMENTS + Add Comment

David Klees (10/15/2018 06:45pm) Hide

Suspicious Activity from IP

David Klees (10/15/2018 06:46pm) Hide
DDoS-related attack possible
adit  delate

Add a Comment
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3. Editthe comment.

4. Click on the Save Changes button.
Deleting Comments

From the Object Details page:
1. Click on the expand icon &l to expand the Comments pane.

2. Click on the Edit link located beneath the comment to update..

The delete confirmation dialog text box opens.

ARE YOU SURE?

Once deleted this comment can not be recovered

Delete Comment Cancel

3. Click on the Delete Comment button.
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Analytics

The Analytics tab provides a summary view of Adversary, Event, File, Indicator, and Sig-

nature Object Types.

"l

Global and List filters are not available for these views nor can you modify

the types of columns used. Use the Advanced Search to utilize these
options.

Analytics pages include:

« Adversaries Overview

Events Overview

« Files Overview

Indicators Overview

Signatures Overview

Adversaries Overview

The Adversaries page provides an overview of all the adversaries within ThreatQ as well as

overlapping use of specific indicators.
There are three sections:

o Adversaries Summary Table

o Adversaries Overlap Table.

« Indicator Distribution Pie Chart
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Adversaries Summary Table

The Adversaries Summary table lists adversaries by name, number of indicators, date cre-

ated, and the most recent event date associated with the adversary.

ADVERSARIES

Showing 1 to 10 of 32 Row count: 10 3
ADVERSARY NAME &« NUMEER OF INDICATORS DATE CREATED & MOST RECENT EVENT DATE &
1 typing Start typing start typing.
Adversary Bravo 03/1872019 01:05pm
Agitated Rhinoceros 037182019 01:09pm
Ajax Team 031872019 01:24pm
Albino Rhino 03/18/2019 01:18pm
ANCHOR PANDA 03/1572019 06:31 pm 05292
ANDROMEDA SPIDER 03/1572019 0631 pm OEM1/20E 09:00pm
Appetizing Ferret 031872019 01:0%9pm
APT1 03/18/20139 01:04pm
Astonishing Pheasant 03/1872019 01:0%pm
BERSERK EEAR 0371572019 0B:32pm 102D E Ddddam

The following functions are available:

Function Details

Opening the Adversary 1. Click the name in the Adversary Name column.
Details page for an

adversary

Performing a search for 1. Click the number in the Number of Indicators column to
related indicators set the adversary name as a search criterion and open

the Advanced Search page.

Opening the Event 1. Click the date in the Most Recent Event Date to open
Details page for an the Event Details page.

adversary event
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Function Details

Changing the number 1. Click the paging batch option located to the bottom-

of entries displayed in right of the table.

the table

Sorting the table by a 1. Click the column header. To reverse the column sorting
column order, click the header a second time.

Searching within the 1. Click within the search box at the top of the column,
Adversary Name and enter your search criteria.

column

Adversaries Overlap Table

The Adversary Overlap table lists adversaries, the date and time they were created, their

type, and any overlapping indicators.

ADVERSARY OVERLAP

DATE = OVERLAPPING ADVERSARIES = ADVERSARY NAMES 3 TYPE % OVERLAPPING INIHCATOR +

040272015 0Z10pm 2 ABCThreat, nameAdversary Email Subject test123

The following functions are available:

Function Details

Opening the Adversary Details 1. Click the name in the Adversary Name

page for an adversary column.

Opening the Indicator Details 1. Click the identity in the Overlapping Indicator
page for an overlapping indicator column.

Changing the number of entries 1. Click the paging batch option located to the
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Function Details

displayed in the table bottom-right of the table.

Sorting the table by a column 1. Click the column header. To reverse the
column sorting order, click the header a

second time.

Searching within a column 1. Click within the search box at the top of the

column, and enter your search criteria.

Indicator Distribution Pie Chart

The Adversary Overlap table lists adversaries, the date and time they were created, their

type, and any overlapping indicators.

INDICATOR DISTRIEUTION
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The following functions are available:

Function Details

Viewing more information 1. Hover over a colored section of the pie chart to open

about a selected value a popup identifying the indicator.

The number of times the indicator was found within the

specified time frame, and what percentage of the total
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Function Details

number of indicators it represents.

Hiding or unhiding one of
the values from the pie
chart

1. Click the indicator on the left of the pie chart to

remove it; click a second time to reinstate it.

Adjusting the time frame
of the information dis-

played

1. Click the dropdown menu at the top right and select

the desired timeframe.
You can select from:

o Last24 Hours
o Last7 Days
o Last30 Days
o LastYear

« User-set custom range

Printing the graph or sav-
ing itas a PNG, JPEG,
PDF, or SVG

1. Click the hamburger menu = and select the desired

option.

Events Overview

The Events page provides a high-level view of what types of events have occurred and how

frequently they are occurring.
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Events Overview

Analylics Mew Events

EVENTS TIMELINE [ Last 30 Days =
a‘ —
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To Access the Events Overview page:
1. In the navigation menu, choose Analytics > Events.
The Events Overview page opens.
The tab options include:

o Events History Scatter Plot

o Monthly Heatmap

« New Events Summary

Events History Scatter Plot

The scatter plot points are plotted by date (x-axis) and hour (y-axis). The legend under the

scatter plot identifies the different kinds of events shown.
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The following functions are available:

.
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Function Details

of the event types

Viewing an event’s name, date 1. Hover your mouse over an event on the scatter
and time, and source plot to see its name, date and time, and source.
21

:s;;lue:tsl?d}%???%é:ggéﬁ:mﬁﬁm issued to dionaea.carnivore.it with common name Nepenthes Development Team ¥
E 12 ' . = > " ; - + 0
9 b - "
. » l . ] L s L ]
0 ''m [ ] ] L ] n ] [ ] [ ] [ ]
Opening the Event Details 1. Click the event in the scatter plot.
page for one of the events _ . . )
For more information, see Object Details Page.
Hiding or unhiding one or more 1. Click the event type in the legend immediately

below the scatter plot to remove it from the

graph; click it again to reinstate it.
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Function Details

Adjusting the time frame of the 1. Click the dropdown menu at the top right and

information displayed select the desired time frame.
You can select from:

Last 24 Hours

o Last7 Days
Last 30 Days

Last Year

« User-set custom range

Printing or downloading the 1. Click the hamburger menu = and select the
scatter plot as a PNG, JPEG, desired option.

PDF, or SVGfile
Monthly Heatmap

The Monthly Heatmap table lists events that happened per adversary each month. Shading
of the monthly totals is used to allow you to quickly scan for patterns in the events and to

quickly detect events with higher monthly counts.

MONTHLY HEATMAP {3 Last Year =

Jan 20l& wh 201E Mar 201R Apr 2018 May 201& Jun 2018 Jul 201d ug 1018 Sep 201A Ot F01A MHov Fia e JO1H Jam 3018 =
1% team o o o o o o o a o 1 o o o
o Q 1 o o o o L] Q o b o o o
@ 2| o o o o o a o b o o b 05
o 1 o o o o 1 o a o o o o o
apl-23 L] 1 o o o [ L @ [ b o o b
apt-37 L] 1 a o o o " a o a a o a 1
cyber-berkut ] 1 a » 0 [ [ ] o o a o o
farcy bear L] ] a i o [ 2 L] o o @ o o
group 123 L] r] a ) Ul L) L) a ) a a o a L¥
hidden cobra ] o a ) 1 o n L] o o a o o
TR 1 — o ) 1 o 1] L] o o o o o N
oilrig o 1 o o o o o a o o o o o
T A P o o o o 1 o L L] L] o o o o I
seancnadt Q 1 a o o [ L a o b o o L 5
teng pasda Q o o o 1 o L a o b o o b
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ThreatQ User Guide, Version 4.20 246



THREA TQ R Analytics

The following functions are available:

Function Details

Viewing an event’'s name and 1. Hover your mouse over an event on the
monthly count heatmap to see its name and monthly
count.
Jan 2018 Feb 2018 Mar 2018 Apr 2018 May 2018 Jun
338 team 0 anonymous: 2 0 o 0
anonplus 0 February 2018 0 0 0
anonymous. 0 2/7 0 [ 0
apt 1 1 0 0 0 0
apt-28 0 1 0 0 0
apt-37 0 1 0 0 0
cyber-berkut 0 1 0 0 0
fancy bear 0 0 0 0 0
group 123 0 2 0 [} 0
hidden cobra 0 0 0 0 1
oilrig 0 1 0 0 0
operation darkseoul 0 o 0 0 1
scarcruft 0 1 0 0 0
stone panda 0 0 0 0 1
Adjusting the time frame of the 1. Click the dropdown menu at the top right
information displayed and select the desired time frame.

You can select from:

o Last24 Hours

Last 7 Days
o Last30 Days
o LastYear

« User-set custom range

Printing the graph or Saving itas a 1. Click the hamburger menu = and select

PNG, JPEG, PDF, or SVG the desired option.
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New Events Summary

The New Events Summary table provides a breakdown of events by date, type, title, and

sources.
DATE - TYRE = TME = SOURCES
by date : Start t
11/21/2018 DZ:44pm Exfiltraticn Attack Event: 110 Johnryu
1119/2018 12:44am Login Compromise Attack Event: 109 JehnnyU
11172018 08:44pm ‘Watchlist Attack Event: 107 JohnryU
11/11/2018 07:44am Dos Amack Attack Event: 108 Johnmyu
11/06/201 8 05:44am SQL Injection Attack Attack Event: 112 JohnmyU
1170372018 11:44pm Malware Attack Event: 106 Johnryu
11/03/201 8 12:44am Command and Control Attack Event: 111 Johnmyll
10/28/2018 05:44pm Login Compromise Attack Event: 102 JohnryU
10/26/2018 01:44pm Exfiltration Attack Event: 103 Johnmyu
10/19/201 8 04:44am Command and Contral Attack Event: 104 Johnryl

<l z 3 45 6 7> Rowsperpage 10 =

The following functions are available:

Function Details

Opening the Event Details page 1. Click the eventtitle.

for one of the events _ _ ) )
For more information, see Object Details Page.

Changing the number of entries 1. Click the dropdown menu at the top right of
displayed in the table the table, and select the desired option.
Sorting the table by a column 1. Click the column header.

2. Click the header a second time to reverse sort

order.

_ o 1. Click within the search box at the top of the
Searching within a column o
column, and enter your search criteria.
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Files Overview

The Files Overview page provides you with a pie chart displays the percentage of different
types of files within the system and a table that lists the files, the date and time they were cre-
ated, their title, their source, their category, and associated keywords.

Files Overview

OVERVIEW

ThreatQ C5V File: 1%

Crowdstrike Intelligence: 2%
FireEye Analysis: 3%
Ceneric Test 7%

8

=

=

STIX: BE%
DATE = TITLE = SOURCE CATEGORY KEYWORDS
O Filter by date A, Start fyping, L Start typing, 1 Start typéing.
0320/2019 05:33pm Eenerate_campaign.py threatg@threatg.com CrowdStrike Intelligence &
03/20/2019 05:30pm techsupport.txt threatg@threatg.com CrowdStrike |ntelligence o
N tgt_threatq_et-cabbb0d2-2f16-43
03182019 01:4%9pm ] BOer-b3341 5463891 sl Super@threatg.com STIX &

Available views include:

« Files Pie Chart

« Files Table
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Files Pie Chart

The File Types pie chart displays the percentage of different types of files within the system.

OVERVIEW

Threald CFV File: 1% i Cuckos: 1%

CrawdStrike Intelligence: 2%

Threar] CSW Filie
FircEye Analysis: 3%

Files: 1

Ceneric Text: 7%

Values

STIX: BER

The following function is available:

Function Details

Viewing more information 1. Hover over a colored section of the pie chart to

about a selected file open a popup that gives the number of attach-

ment types.

Cuckoo: 1% FireEye Analysis
Files: 3

CrowdS 2%

FireEye Analysis: 3%

Generic Text: 7%

Printing the graph or Saving it 1. Click the hamburger menu = and select the
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Function Details

as a PNG, JPEG, PDF, or desired option.
SVG

Files Table

Immediately below the Browse pie chartis a table that lists the files, the date and time they

were created, their title, their source, their category, and associated keywords.

DATE TILE = SOURCE CATEGOAY KEYWORDS
Filter by date SEAMT typing... SEart typing... 3

03/20/2019 05:33pm generate_campaign.py threatg@threatg.com CrowdStrike Intelligence i

03/20/2019 05:30pm techsuppart . txt threatg@threatg.com CrowdStrike Intelligence iy
tgt_threatq_et-cabbbOd2-2f16-43

03/18/2019 01:49pm ) e :.}}41 e Super@threats.com STIX &y

03/18/2019 01:4gpm 71T PRCIABETEAER A Super@threatq.com STIX &
nd_threatq_indicator-cfbcdfod-d

03/18/2019 01:4%pm 068-4dc8-a57b-cda54868bf28.x Super@threats.com STIX )
m
nd_threatq_indicator-20788288-

03/18/201901:48pm 9690-4766-a314-6bBa18325a%91, Superi@threatq.com STIX =)
M
nd_threatq_indicator-443e4e59.

031872019 01:48pm Th29-4243-BeB0-5af3b7M07a34.x Super@threat.com STIX i
m
coa_threatq_coa-ccf236e2-3126

03/18/2019 01:47pm ryiiirs l—._, 2817 CA06H om Super@threatq.com STIX o)

031872019 01:47pm Campaign.xml Super@threats.com STIX iy
cam_threatq_campaign-8a56607

03/18/201901:46pm 2-5h&1-dfaf-aced-16525ba 144 x Super@threatqg.com aTix )

m

(“2 3 4 5 6 7 .. 11 » Rowsperpage 10 ~

The following function is available:

Function Details

Opening the File Details page for a 1. Click the name in the Title column.

file

Changing the number of entries dis- 1. Click the paging batch option located to the
played in the table per page bottom-right of the table.
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Function Details

Sorting the table by a column 1. Click the column header.

2. To reverse the column sorting order,

click the header a second time.

Searching within a column 1. Click within the search box at the top of

a column, and enter your search criteria.

Downloading a file 1. Click the download icon #=.

Indicators Overview

The Indicators Overview page provides an insight into what indicators have been added to
the system within the last 15 days, as well as an overview of how many indicators fall under

each indicator type.
To Access the Indicators Overview Page:

1. From the navigation menu, click on Analytics and choose Indicators.
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The Indicators Overview page will open with three view tab options at the to of the

page.
THREATQ 3

Indicators Overview

Cverview Mitwaork Hess

RECENTLY CREATED INDICATORS

25

12
10
5 4
; l
. N

Apr2 Apri Aprd Apr 7 Apr§ Aprg Apri0 Apr 11 Apri2 .\\pﬂ; Apr 14 hpr!s Aprig  Apriy

Indicators Created
o

STATUS HETWORK HOST TOTAL
Active 339 1] 339
Expired

Indirect

Review 2m
Whitelisted

Totals 541 541

The page is broken down into different Indicator class views that are accessible via the
tabbed navigation located at the top of the page.

The tab options include:

« Overview
« Network (Indicator Class = Network)

« Host (Indicator Class = Host)
Summaries included on the Indicator Overview Page Include:

o Recently Created Indicators Histogram

o Summary Status (Overview view only)
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« Most Recent 100 Indicators

Attributes Table (Network and Host views only)

Recent Sources (Network and Host views only)

Attack Phases (Network and Host views only)

Attack Phases

Attack Phases are the ways an indicator might be used and are listed as indicator attributes.
The Attack Phases pie chart displays the number of indicators that fall under each attack
phase.

ATTACK PHASES [ Lt 30 Days =

The following functions are available:

Function Details
View the Number of 1. Hover the mouse over a portion of the pie chart to view
Indicators for an Attack a popup the Attack Phase and number of indicators
Phase associated with it.

2. Clicking on a pie chart section will open the Indicator

Search page with the specific filter settings used for
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Function Details

that selection.

Q_ Indicator Search

Adjust the Date Range | The default Date Range is 30 days.
for the Information Dis-
laved 1. Click the date range icon located to the top-right of the
aye
pay chart and use the dropdown menu select the desired

range.
Users can select from:

Last 24 Hours

« Last7 Days
Last 30 Days

Last Year

o User-set custom range

Hide a Values from the 1. Click on a Attack Phase in the legend to the left of the
Pie Chart pie chart to hide it.

The Attack Phase will be removed from the pie chart and

the source in the legend appear greyed out.
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Function Details

2. Click on the Attack Phase again to add it back to the
pie chart.

Attributes Table

The attributes list on the left side displays attributes related to indicators in your system.

ATTRIBUTES

Select an attribute below:

Showing 1o 10 of 30 fowcount: 10 v
L = Hee Please select an attribute on the left.
Altack Phase 526,415 >
Audience 221,038 >
Compie Time 121 »
Confidence 1,523,494 >
CPE 192,802 >
CrowgStrike Domain Type T
CrowdStnie Intel News 6 >
CrowdStrke P Address Type T
CrowdStike Status 140 >
CrowdStnke Tnreat Type 1,863,109 »

=3 =

The following functions are available:

Function Details

Change the Number of 1. Click the Row Count icon located to the top-right of the
Entries Displayed in chart and select a new display count from the drop-

the Table down.

Search/Filter Attributes 1. Click within the search box at the top of the column,

and Values and enter your search criteria.
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Function Details

View More Information
About a Selected Attrib-

ute

1.

Click on an attribute row in the table to view additional

information in the right pane.

ATTRIBUTES

Select an attribute below:
Attack Phase

Showing 1 t0 10 of 30 Rowcounl 10 v

Type N Values

221,038 >
121>
1523494 >
192,802 >
753

8>

75

140 ¥ Shawing 1107 of 7 Rowcount | 10 v

1653.109 3

Value

Hover the mouse over different portions of the pie chart

to reveal the segment's value.

Click on an Attribute Value in the summary table below
the pie chart to open the Indicator Search page with

those attribute values applied.
THREATQ )  mrrain & inesign

Lal Analytics

Q Indicator Search

Aot : El
Aitribute typs Attribute valu n
Attack Phase Is . cz

Recent Searches ~

Search Results

Mfake Bulk Changes to 4 indicators

B wocsTor - e & SOURCE & sTaTus 4 scoRe ¢ DATE CREATED

i FQDN Johnnyu Active ) 03/15/2019 07:10pm itla
=] FQDN Johnnyl Active 0 03/15/2019 07:10pm irla
B FQDN Johnny Active 0 03/15/2019 07:10pm 1
B FQDN Johnnyu Active 0 03152013 07:10pm
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Most Recent 100 Indicators

The Most Recent 100 Indicators list displays the 100 most recently reported indicators.

Most Recent 100 Indicators

Showing 1 to 25 of 100 Row count il

Indicator

1002018 05:30pm BC1423c4C ro06e2031 2030805500 55903 [ MDOS AClve CrowdSnke
10008/2018 05: 30pm Abcla 1997 92bTeS4ed 5dbT 8T aSca0M B4 2288 [ SHA-1 Active CrowdSirile

1000872018 05 30pm CB39CEA50019Teed2T 17efc0262 54500ad el 18 0 SHA-256 Arlive CrowdSirike

100082018 05 30pm 6 ledefc20chf9edcildaifanTod5eans [ SHA-256 Ariive CrowdSirike

10W0E201E 05 30pm 16a5122515eTE2eebe 1 6dTEace0041c 1 MDS Aciive CrowdStrike

1000672018 05:30pm diaelSc2Tectatnhibbr8aaisn5684ae2 33003358 [ SHA-1 Active CrowdStnke

100082018 05 30pm 41587 34e0cbAmare0oactlals F 37 4V ed0ebbd 20t S04b4 3 [ SHA-256 Arlive CrowdStnke
14bEdai 1eet

100082018 05.30pm 91dbbEbM 98622c957 23327904 2868de 0 MDS Active CrowdSlrike

100082018 05:M0pm 13790 1801679003331 21 55¢e 319316731 509502 306bocd 105 0 SHA-256 Arlive CrowdStrike
B05acee309916C

100082018 05 30pm Oa4reTa7IeTorner? GO73404217 08129 [H SHA-1 Aclive CrowdShike

10/0E201E 05:30pm B2 Ahacdn0cfaGaCnadc3anZhas 147 [+ MDS Acive CrowdStnke

10082018 05:30pm ededaalascis2an3absdcnlasbsartatdsdcaria [H BHA-1 AClive CrowdSinke

10008/2018 05: 30pm T4664bE24T5ac3 113264 23T TedddaTid 1 calfe 5663 T8e5efb [ SHA-256 Active CrowdSirike
9931391030

1000872018 05:30pm 37404eds471800d33c3edTaTe 19bE3E2 0 MDS Aclive CrowdSirike

The following functions are available:

Function Details

Resort the Table 1. Click on the different table headings to resort that

table by that column.

Search and Filter Table 1. Click on one of the search boxes at the top of the

Results columns and enter a keyword to filter the results.

You can use the supplied dropdown selections for
the Status and Type columns to filter by system-avail-

able values.

Modify the Number of 1. Click on the Row Count icon located to the top-
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THREAT() ™
right of the chart and select a new display count

Rows Displayed

from the dropdown.

Access the Indicator 1. Click on the specific Indicator to review to open

Details Page for a Specific the Indicator Details page.

Indicator

Recent Sources
The Recent Sources Scatter plot displays how many indicators were provided by a given

source each day within a specified time frame.
RECENT SOURCES 4 Last 30 Days -
24 —
- Y r T I s
a 2 @ 2 2000 €@
: L A | L 4 L B 1 ;@
21 _: =1 LJI :.J\ e . = L 2
] 2 @ (@) 2 s 00 ¢ @
‘ - W L & oo *+ Q0
18 & = & o O & € ® O A -
L28éaSie 2 < '\{{:/‘{/:\I,?;?
-y y h 4 "
TTER "Cit @ ‘\OY'/I/ .I:-'Q v ‘g’l_
15 w e & &9 ,1_’-_,:'\ Py I e Tee 0
99 ® e+ 0 o9 8 e  BIEN IK
. * PP 8 ¢ o o [ K @ o e
3 12 e 2 o @O O @ & & ¢ e & @
T - e 6 O B . - 4
| o e & & ‘B M ON ] ] (]
—~ A - = -y g r
& ® § 9 J\l R 2 @ w 3 L
E] s - & ¢ [ N ) e =]
vTo o9 ] ] @ e y
;.\ s o @ p P o @ L]
3 By o @ [ > @ e @& . =]
o0 @9 o 000 0
o ® & & » @ } & @
BN ] ‘ ® @ e & o ©
& = & &
) { = .’- ] b 1 If"i/ "?(.-:I ﬁ' .', o ) .
0 M & s X o PURNE & s & - - - W
Sep & Sepi0  Sepi2  Sep14  Sep16  Sepid  Sep20  Sep22  Sep2d  SepdE Sepla  Sep a0
0 cmwasuike 0 iSight Pariners ‘abuse.ch Feodo P Blockist @ Alienvaut OTX Bambenek Consuling - C2 Al Indcators

The following functions are available:

Function Details

Hover the mouse over one of the scatter plot circles
to view a popup with the Source, Date, Time and

View the Date and Number 1.

of Indicators from a Given
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Function Details

Source Number of Indicators.

RECENT SOURCES

2. Click on the one of the scatter plot circles to open a

filtered Indicator Search page with those values.

Q Indicator Search

— -] [e o] [ et : [+
and

“ - |

Published Date - s - 04162019 =]
o -] [ <] [ coene iattence - [ -]+
=

Indicator Class - s - Network -
‘ &

Date Created - s - 0471672019 o]
Source - s - Cofense Intelligence - ﬂ -

Adjust the Date Range of | The default date range is 30 days.

the Information Displayed
1. Click the date range icon located to the top-right of

the chart and use the dropdown menu select the

desired range.
You can select from:

o Last 24 Hours

ThreatQ User Guide, Version 4.20 260



THREA TG m Analytics

Function Details

o Last7 Days

Last 30 Days

Last Year

User-set custom range

Hide Values from the Scat- 1. Click on a source in the legend under the scatter

terplot plot to hide it.

The Source will be removed from the scatter plot and

the source in the legend appear grayed out.

2. Click on the source again to add it back to the scat-

ter plot.

Recently Created Indicators Histogram

The histogram is organized by date. Daily indicator totals are at the top of each column.

Each bar is broken down into colors, one for each indicator type.

RECENTLY CREATED INDICATORS

25k

20,691
2k 18,590
16,284

15

14,796 15,176 15,267 15,404
13,248 13,138 13,412
10,674 1247 10,850
! 8,697 8,635
I 6.860
[ I
oct 1 oct2 Oct 3 Oct 4 Oct & Oct &

Sap23 Sep2d4 Sep28  Sep26  Sep27 Sep28  Sep29  Sep30 O 7 Oct 8

Indicators Craatad
2 o
L -

=]
=

[=}

The following functions are available:
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Function Details

Viewing the number of 1. Hover over a colored section to view a popup show-
indicators created each ing how many attempts of a particular type (for
day by type example, MD5, SHA-1, SHA-256) were made on

that date.

25k —

18,590

20k
16,351
15 14,79 15176 15,267 15,404
e 13,138 13,412
1064 1297 10,850

™ asor 8,635

I 6,860 I
) I
ok

5ep23  Sep2d  Sep25 Sep26  Sep27 Sep2d Sep23 Sepdd  Coli  Od2  Otd  Ocd  Ods 06 Gd7  Ocd@

Zooming in for a closer 1. Drag your mouse over a section of the histogram,

Ingicators Crealed

view and your view will be magnified.

RECENTLY CREATED INDICATORS

22,185
21,193

12,657

Incates Creatsa

7,022

7347
5819 5,700
A 5,062 4,947  age7 5161 4,967
5 4,566 4,523 . 4,026
I I I I l l l I ™
« ]

Sep23 Sep24 Sep2S  Sep2  Sep27  Sep28  Sep2? SepM Qo1 OGm2  Odt3 o4 Ots  Oct6 Od7  Oclb

RECENTLY CREATED INDICATORS

Resetzoom =

25k
22,165
EL
15k
10k
. I 5,062 4523 4,947
ok - - -
Sep28 Sep28 Sep 3D

oat1

Indicatars Created

2. Click Reset Zoom to return to the full histogram.

Printing the histogram or 1. Click the hamburger menu =, and select the desired

downloading itas a PNG, option.
JPEG, PDF, or SVGfile
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Summary Status

The Status Summary table is located under the Overview tab.

The Status Summary table provides a breakdown of Indicators, categorized by Status, for

the Network and Host Indicator Classes.

Stabis Metwiork Hoat Total
Active 1,551,333 1,942,423 3,473,758
Enpired ]

Indirect B, 06 I 728 T3 a2
Rovew 8 45 17

Wit stad o o o

Tonsls 2086, 487 2119208 4,205,884

The following functions are available:

Function Details

Search By Indicator Status 1. Click on a Status to load the Indicator Search page

with that status applied to the search.

THREATQ 3 W Threstlbrary A v
Q Indicator Search
pr— - [ 2 &= - B
Search Results Miake Bulk Changes fo 1000 Indicators
Showing 1 to 25 of 1000 Row count: 25 §
@ WDIKATOR - e § SOURCE & STATUS & SCORE & DATE CREATED $ EXPIRATION DATE 3 ADVERSARIES &
(=] Mutex Jehnmyy Review [ 03/18/2019 01:20pm
B #@336fdst Mutex Johnnyy Review o 03/18/2019 01:20pm
B #@sDEFew) Mutex Johnnyl Review [ 03/18/2019 01:20pm
= Mutex JohnmyU  Rewle W a 031842019 01:20pm

Search by Indicator Class or 1. Click on an indicator value to load the Indicator
Indicator Class with a Spe- Search page with the selected indicator class and

cific Status status applied to the search.
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Function Details

Q_ Indicator Search

Indicator Status - Is v Active - n

Signatures Overview
The Signatures page provides an overview of all the signatures within ThreatQ.

You can perform the following functions:

Function Details

Filtering table by Date 1. Click within the search box at the top of the

column, and enter your search criteria.

Opening the Signature Details 1. Click the name in the Signature Title column.

page for an signature

Filtering table by Signature 1. Click the on dropdown at the top of the Sig-
Type nature Type column and select a type.
Changing the number of 1. Click the paging dropdown option located to the
entries displayed in the table top-right of the table and select a value.

Sorting the table by a column 1. Click the column header. To reverse the column

sorting order, click the header a second time.
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Function Details
Searching within the Sig- 1. Click within the search box at the top of the
nature Title column column, and enter your search criteria.
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Incoming Feeds

The following describes how to use incoming feeds to ingest threat intelligence data.

o Incoming Feeds Overview

« Managing Incoming Feeds

o Historic Feed Pulls

Incoming Feeds Overview

You can enable and manage incoming feeds in ThreatQ to ingest threat intelligence data.

Incoming feeds are organized into the following categories:

Commercial

o OSINT or Open Source
o STIX/TAXII Feeds
« Labs

Commercial Feeds

Commercial feeds are provided by paid feed providers as a service. To enable these feeds
in ThreatQ, you will need an API ID or API Key from the provider. Commercial feeds typically
provide highly contextual threat intelligence data. You can learn more about these feeds on

their vendor's websites.

OSINT Feeds

OSINT feeds are open source threat intelligence feeds. Open source feeds are free to use,

but some may require you to register with the feed provider to attain an API Key.
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STIX/Taxii Feeds

STIX stands for Standard Threat Information Expression, itis an emerging standard for the
sharing of machine readable intelligence and incident data. A STIX package is an XML doc-
ument that can contain many indicators and related context information. For the automated
sharing of STIX packages, a protocol called TAXII (Trusted Automated eXchange of Indic-

ator Information) is used to provide a feed to consumers.
ThreatQ provides a feature for consuming STIX/Taxii feeds.
Related Topic

Adding a New STIX/Taxii Feed

Labs Feeds

Labs (formerly known as ThreatQ Labs) are driven by ThreatQuotient’s Threat Intelligence
Services Team. Labs feeds provide a solution for data ingestion that is not provided by the
feeds pre-configured with the ThreatQ platform. You should inquire with a Threat Intel-

ligence Engineer to see what Labs are available.

Managing Incoming Feeds
Manage threat intelligence feeds on the Incoming Feeds page.

The following table describes the actions you can take to manage Incoming Feeds.
To Do this..

Toggle the switch next to the feed
Turn a feed on or off
name.

Click Feed Settings for the feed you
Editing a feed’s display name or URL _ _ _ .
wish to edit, and make desired edits.
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Install/Upgrade Configuration Driven See the Installing or Upgrading a CDF
Feed (CDF) from the ThreatQ Interface topic.
Uninstall Configuration Driven Feed See the Uninstalling a CDF from the
(CDF) ThreatQ Interface topic.

Install/lUpgrade CDF Command

Use the steps below to install or upgrade a Configuration Driven Feed (CDF) using the Com-
mand Line Interface (CLI). The command creates connectors for each feed defined in the

feed definition file.
To install a CDF:
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatq:feed-install <Feed

Definition File>

ﬂ The application will notify you if the feed(s) in the feed definition file
already exists in the system and will cancel the installation. See the
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N
"1

To Upgrade a CDF and Changes in User Configurations sections

below for more information.

threatq:feed-install 6266 Started > 2019-02-21 18:47:24
threatq:feed-install 6266 Command failed:

The provided definition file contains the following installed feeds:
Testing at 5 AM. Proceed with the update by usihg the --upgrade flag.

. J

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

To Upgrade a CDF

e N
x

This command can be used to update a feed's Category and Namespace.
If the category exists on the appliance, the command will update both
fields and link the feed to the designated category. ThreatQ will confirm
that the defined category exists before completing the update command. If
the category does not exist, ThreatQ will not update the feed.

1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatqg:feed-install <Feed

Definition File> —--upgrade

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Changes in User Configurations
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When upgrading an existing feed using the --upgrade flag, the application will compare the
existing version of the feed with the new version for differences in the user configuration. If a
difference is detected, the application will inform you that the current user configuration for

that feed will be overwritten. The application will require user input to continue with the feed

threatq:feed-install 6674 Started > 2019-02-21 18:48:28
threatq:feed-install 6674 Warning: The provided definition file
contains updated user configurations. It is highly recommended to
create a copy of the configuration values for the following feeds
before proceeding with the update: Testing at 5 AM.

Do you want to continue? (Y/N) Y

threatq:feed-install 6674 Number of connectors in the definition file:
1

threatq:feed-install 6674 Number of existing connectors updated: 1

threatq:feed-install 6674 Finished > 2019-02-21 18:48:34 > 6.19s
upgrade.

Itis recommended that you create a copy of the existing configuration val-
ues before proceeding with the upgrade.

Command Flag Help

You can also see a full list of command flags using the following command while under the

Ivar/lwww/api directory:

sudo php artisan threatqg:feed-install --help

Installing or Upgrading a CDF from the ThreatQ Interface

You can install or upgrade a CDF from the Incoming Feeds page of the ThreatQ interface.

ﬂx The process to upgrade a CDF is the same as installing a new CDF.

To install a CDF from the ThreatQ Interface:
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1. Go to System Settings [ > Incoming Feeds.

2. Click on the Add New Feed button.
THREATQ 3 i} Threat Library

Incoming Feeds m

Commercial (1% Labs (1) CISINT (B8)
(D Cofense Intelligence Feed Settings b
D Crowdstrike Feed Settings ¢
(I Deepsight Advanced IP Reputation Attack XML Feed Feed Settings
() DeepSight Advanced IF Reputation Bot XML Feed Feed Settings
(3 DeepSight Advanced IP Reputation CnC XML Feed Faed Settings »
CD DeepSight Advanced IP Reputation Fraud XML Feed Feed Settings »

The Add New Feed dialog box opens.

Add New Feed

Add New Feed Add TAXIl Feed

Drag your feed definition here or click to browse

Supported files include: yaml

3. Select the file to upload by either clicking and dragging the file onto the dialog box

or using the link supplied to browse for the file on your local machine.
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—_

o Feeds >

S~

bitsight.yaml

"1

Existing Feeds
ThreatQ will inform you if the feed already exists on the platform and
will require user confirmation before proceeding.

Upgrade Feed

The provided definition file contains the following installed feeds: BitSight.

Would you like to proceed with upgrading?

e [

User Configurations

ThreatQ will also inform you if the new version of the CDF contains
changes to the user configuration. The new user configurations will
overwrite the existing ones for the feed. The platform will require
user confirmation before proceeding.
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Upgrade Feed

Warning: The provided definition file contains updated user configurations. It is highly
recommended to create a copy of the configuration values for the following feeds
before proceeding with the update: BitSight.

Would you like to proceed with upgrading?

o [

4. The new feed(s) will be installed.

THREATQ 3
Incoming Feeds Add New Feed
Commercial (19) abs (2} DSINT (B8]
D Alienvault OTX Pulse Feed Settings
CD BitSight Feed Settings »
4 . .
Q You will need to configure and enable the feed after install.

Uninstalling a CDF from the ThreatQ Interface

You can uninstall CDFs from the Incoming Feeds page of the ThreatQ interface.

ﬁ This feature only applies to CDFs. ]

To uninstall a CDF from the ThreatQ Interface:
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1. Go to System Settings [ > Incoming Feeds.

2. Click on the Feed Settings link for the feed.
THREATO 3 i & Investigations Ll Analytics

Incoming Feeds

Commercial (19) abs (Z) OSINT (88)

Q) Alienvault OTX Pulse

(D sitsight

3. Click on the Uninstall Feed button.
D eitsight

Bitsight

T

The Uninstall Feed dialog box opens.

Uninstall Feed

Are you sure you want to uninstall BitSight?

4. Click on Uninstall.

Add New Feed

Feed Settings »

Feed Sattings #

Feed Settings =
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5. The feed will be uninstalled.
THREA TQ 3 il &4 Imvestigations L Analytics

Incoming Feeds

Commercial (19) abs (2} OSINT (88)

(@) AlienVault OTX Pulse Feed Settings

Enabling a Commercial Feed

To enable a commercial feed, you will need an API ID and API Key provided by the feed pro-

vider.
Procedure:

1. Choose the Settings icon > Incoming Feeds.

2. Click the toggle switch next to the feed you want to enable.
Green indicates enabled.

3. Expand Feed Settings.
4. On the Connection tab, enter:
« Feed Name - the name displayed in ThreatQ
« APIID - provided by the feed vendor for authorization
« API Key - provided the feed vendor for authorization
« Feed URL - this field is autofilled
5. On the Settings tab, select:
« the status that incoming indicators from this feed will receive.
« the frequency that ThreatQ pulls information from the feed.

6. Click Save Changes.
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Enabling an OSINT Feed

OSINT feeds do not require API IDs, but some may require an API key from the feed pro-

vider.
Procedure:

1. Choose the Settings icon > Incoming Feeds.

2. Click the toggle switch next to the feed you want to enable.
Green indicates enabled.

3. Expand Feed Settings.
4. On the Connection tab, enter:
« Feed Name - the name displayed in ThreatQ
« APIKey (if required) - provided the feed vendor for authorization
» Feed URL - this field is autofilled
5. On the Settings tab, select:
« the status thatincoming indicators from this feed will receive.
« the frequency that ThreatQ pulls information from the feed.

6. Click Save Changes.

Viewing Feed Queues

When upgrading a feed, itis recommended to allow the previous implementation the feed to
complete processing of the data it has already downloaded, prior to upgrade, to avoid any

data loss.

Perform the following steps to confirm that the queues have been cleared.
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1. Run the following command:

/var/www/api/artisan threatqg:list-queues -p

feeds

2. Locate and confirm that the feed’s Indicators and Reports rows display a value of

"0" for the Messages Ready and Messages Unacknowledged columns.

The queues should be cleared, reporting 0 values, before pro-
ceeding with the update.

Adding a New STIX/Taxii Feed
Complete the following steps to add a new STIX/TAXIl indicator feed.

Procedure:

1. Click on the Settings icon E*] and select Incoming Feeds.

The Incoming Feeds page will load.

mercial (1%) Labs (1) OSINT (28)

CD Cofensze Intelligence Feed Settings »
() CrowdsStrike Feed Settings ¥
(D DeepSight Advanced IP Reputation Attack XML Feed Feed Settings ¥
(I Deepsight Advanced IP Reputation Bot XML Feed Feed Settings
Q) DeepSight Advanced IP Reputation CnC XML Feed Feed Settings *
CD DeepSight Advanced IP Reputation Fraud XML Feed Feed Settings »
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2. Click on Add New Feed.

The Add New Feed dialog box opens.

Add New Feed

Add New Feed Add TAXII Feed

b

Drag your feed definition here or click to browse

Supported files include: yaml
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3. Click on Add TAXII Feed.
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The Add TAXIl Feed form loads.
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Add New Feed .

Add New Feed Add TAXIl Feed

What would you like to name this feed?

How often would you like to pull new data from this feed?

4k

Every Hour

TAXII Connection Settings

Discovery URL: @

Poll URL (Optional): @

Collection Name: @

Client User Authentication (if applicable)

Username: @

Password: @

Client TLS/SSL Authentication (if applicable)

Client Certificate: @

Client Kev: 3
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4. Complete the following fields:

Field Instructions

What would you like to name this Enter the feed's name that will be displayed
feed? throughout ThreatQ. The name must be at

least 5 characters long

"

It does not need to match
the Collection Name.

How often would you like to pull Choose Every Hour or Every Day.

new data from this feed?

TAXII Connection Settings

Discovery URL This is where the TAXII server can be

reached.

ﬁ This field is required.

Poll URL An optional URL that specifies a specific
endpoint on the TAXII Server to poll for
data.

Collection Name The name of the collection of data in the

feed you will access.

1 Thisfield is required.

Client User Authentication

Username Enter a username if required for the feed.
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Field Instructions

Password Enter a password if required for the feed.

Client TLS/SSL Authentication

Client Certificate Enter a certificate if required for the feed.

Client Key Enter a private key if required for the feed.

Server Authentication

Verify SSL Leave the checkbox checked to require
that the TAXII client verify the provider's
SSL certificate.

Host CA Certificate Bundle The provider's CA Certificate used to verify
SSL.

'a \

ﬂ The Host CA Certificate
Bundle will not be
honored if the Verify SSL
option is not selected.

5. Click on Add TAXII Feed.

CrowdStrike CDF

Starting with ThreatQ version 4.2, the CrowdStrike feed will be updated to use the con-
figuration driven method. This update will allow users to review an Activity Log that will

provide a summary of the feed and including important details such as:

« how the feed was triggered,

« startand completion time,
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« raw response received from the vendor,

« how many objects were processed by ThreatQ.
Query Range

Query Range is a new feature with this update that uses the exact date/time that ThreatQ

queried CrowdStrike’s API for information.

This feature, unique to the updated CrowdStrike feed, ensures that there isn't a gap in feed
coverage in the event of a feed run failure or server downtime. ThreatQ will use the last com-

pleted run time when performing a new run.

Example: Customer has CrowdStrike configured to perform scheduled runs every hour. The
customer powers down the server for three hours for maintenance. The next time the feed
runs, it will automatically use the last successful run time in its range which will cover the

three-hour gap when the server was down.
PlaceHolder Files

The Placeholder file conceptis currently used by the updated CrowdStrike feed with expan-
ded support to other feeds to be added in future releases. Placeholder files prevent linking
information delays between the vendor and ThreatQ by creating a placeholder file imme-
diately after receiving a file or report from the vendor. ThreatQ will fulfill the placeholder and
update the object information accordingly. ThreatQ will mark placeholder files on the details

and file overview pages.
Related Information

o CrowdStrike Update Instructions

« Performing Manual Feed Runs
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CrowdStrike Update Instructions

A CrowdStrike users must update their proxy server settings to use http: for
their https: traffic before upgrading CrowdStrike.

Prior to upgrade, and to avoid any data loss, itis recommended to allow the previous imple-

mentation of CrowdStrike to complete processing of the data it has already downloaded.
Perform the following steps to confirm that the queues have been cleared.
1. Run the following command:

/var/www/api/artisan threatq:list-queues -p

feeds

2. Locate and confirm that the CrowdStrike Indicators and Reports rows display a

value of "0" for the Messages Ready and Messages Unacknowledged columns.

The queues must be cleared, reporting 0 values, before proceeding
with the update.

3. Proceed with the standard feed update procedures.

G The update process is quick. A confirmation message will confirm
that the update process is complete. The Activity Log feature will
load once CrowdStrike is enabled and a feed run instance has been
created or completed.

. J

Source Consolidation Command

Use the steps below to consolidate/deduplicate similarly named sources and to remove
unused sources from the ThreatQ application. A source that have been removed or merged

will have its data mapped to a new source.
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' . . q
G The command does not require recalculation of scoring.

1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatg:consolidate-sources

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Example Scenario:

—

. User manually adds ABC as a source.

2. Userenables ABC.

There are now two ABC sources in the system.

w

User runs consolidation command.

N

. The application merges the sources and remaps any items linked to the correct

source.

Source Merge Command

Use the steps below to merge a user-created source (source origin) with another source
(source destination). After merging, the source origin will be deleted and source changes will

be reflected in the Auditlog (Example: Source A become Source B).
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"1

The command does not affect date stamps nor does it require a recal-
culation of scoring.

1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:
sudo php artisan threatg:merge-sources —--ori-
gin-source="<source a>"” --destination-source-

e=“<source b>"

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Example Scenarios:
Scenario Details
Merge user-created 1. User places the platform into maintenance mode.

source (origin source) . User runs Source Merge command.

with a system source . User is presented with merge confirmation dialog.

2

3
(destination source).
4. User consents to the merge.
5

. The platform will merge the origin source into the des-
tination source and then delete the origin source after

completion.

6. The platform will record the source merge in the audit

ThreatQ User Guide, Version 4.20 287



THREA TQ H Incoming Feeds

Scenario Details

log for affected data.
7. The userreceives a command success message.

8. The user brings the platform out of maintenance mode.

Merge system source 1. User places the platform into maintenance mode.

(origin source) with a 2. User runs Source Merge command.

user-created source -
3. The platform will inform the user that a system source

ination rce). .
(destination source) cannot be merged into another source.

4. The user brings the platform out of maintenance mode.

Merge user-created 1. User places the platform into maintenance mode.

source (origin source) 2. User runs Source Merge command.

with a system source 3. The platform will inform the user that there are duplic-

tination I
(destination source) ate records between the two sources and prompt the

with duplicate records. user to run the Source Consolidation Command

before proceeding with the merge.

User runs the Source Consolidation command.
User runs Source Merge command.

User is presented with merge confirmation dialog.

User consents to the merge.

® N o 0 &

The platform will merge the origin source into the des-
tination source and then delete the origin source after

completion.

9. The platform will record the source merge in the audit

log for affected data.

10. The user receives a command success message.

11. The user brings the platform out of maintenance mode.
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Scenario Details

Merge user-created 1. User places the platform into maintenance mode.
source (origin source) . User runs Source Merge command.

with a system source . User is presented with merge confirmation dialog.
(destination source)

2

3
_ _ 4. User consents to the merge.
with an assigned TLP.
5

. The platform will merge the origin source into the des-
tination source, and then delete the origin source after

completion.

6. The platform will then apply the destination source's
default TLP settings to the merged data and record the

source merge in the audit log for affected data.
7. The userreceives a command success message.

8. The user brings the platform out of maintenance mode.

Feed Activity Log

The feed activity log summarizes each feed run, including information such as how the feed
was triggered, its start time, completion time, the raw response received from the feed

vendor, and how many objects were processed.
The activity log is currently available for the following Configuration-Driven Feeds (CDF):
Commercial Feeds

CrowdStrike

Cofense Intelligence (formerly known as Phishme Intelligence)

Emerging Threats IQRisk Rep List FQDNs

Emerging Threats IQRisk Rep List IPs
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OSINT Feeds

AlienVault OTX

All abuse.ch feeds, except for abuse.ch SSBL (Extended)
Bambenek

BitSight

Cl Army List IPs

Cybercrime Tracker

Emerging Threats Block IPs
Emerging Threats Compromised IPs
malcOde Domain

malcOde IP

Malware Domain List (IP)

Malware Patrol

Phishtank

www.dan.me.uk Tor Node List

Viewing a Feed's Activity Log

To view a feed's activity log, that feed must be enabled.

Procedure

1.

From the main menu, choose the Settings icon > Incoming Feeds.

2. Choose a feed and expand Feed Settings.

3. Choose the Activity Log tab.
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Historic Feed Pulls

Historic pulls provide a method for you to ingest threat intelligence data from a particular
vendor prior to the date you enabled the incoming feed. The procedure for running historic

feeds varies based on the type of feed.
See the following topics for more information:

o Feeds that do not Support Historic Pulls

Performing Manual Feed Runs

iSight Historic Pull Command

« General Historic Pull Commands

Threat Intelligence Services Custom Feeds Historic Pull Commands

Feeds that do not Support Historic Pulls
The following feeds do not support historic pulls:

o All OSINT feeds
« The following Commercial Feed:

o DeepSight
Performing Manual Feed Runs

For some feeds, you can perform a manual feed run for a selected date range. This allows

you to generate a historic feed pull from the user interface.
You can perform a manual feed run for the following feeds:
« CrowdStrike

Procedure:
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1. From the main menu, choose the Settings icon > Incoming Feeds.
. Select a feed and expand Feed Settings.

. Click +Manual Run.

2
3
4. Select a Start Date, Start Time, and Time Zone for your run.
5. Selectan End Date, End Time, and Time Zone for your run.
6

. Click Queue Run.

iSight Historic Pull Command

To run an iSight historic pull, run the following command from the command line, substituting

your desired start and end date:

sudo isight connector -s MM-DD-YYYY -e MM-DD-YYYY

General Historic Pull Commands

If not called out specifically in Historic Feed Pulls, use the following commands at the com-

mand line to run historic pulls for most other connectors, including most TAXII feeds.

1. Run the following command to determine the feed name ($SFEEDNAME):

tgconnector -h

Take note of the desired feed name.
2. Run the following command to run the historic pull, substituting your desired start

and end date:

sudo -u threatqg tgconnector -f SFEEDNAME -s MM-

DD-YYYY -e MM-DD-YYYY
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Threat Intelligence Services Custom Feeds Historic Pull Commands

Custom feeds provided by Threat Intelligence Services provide a mechanism for you to gen-
erate a historic pull during the initial feed run. After the initial feed run, feeds typically perform
an hourly pull, but can be adjusted within cron.

Refer to the documentation for your custom feed or integration for more information.
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Dashboard

The following describes how to use the dashboard to view various threat intelligence met-

rics.

Dashboard Overview

Dashboard Overview

The Dashboard displays metrics and visualizations to provide at-a-glance views of your

threat intelligence data, including:

« Overview of intelligence by score

Watchlist activity

Incoming intelligence

Open assigned tasks

The dashboard serves as your landing page when you log in to ThreatQ.

Overview of Intelligence By Score

This dashboard graph provides a summary of indicator scoring in the system. It lists total

indicators by score in the following order:

Very High

« High

Medium

o Low
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o Very Low

« Not Scored

You may click on the percentage/number of indicators to launch an advanced search based

on that criteria.

@ Overview of Intelligence by Score

VERY HIGH 0% (0)

0% (1)

MEDIUM 0% (0)

0% (0)

VERY LOW 100% (192,379)

NOT SCORED 0% (0)

Incoming Intelligence

This dashboard graph provides a view of threat intelligence from all incoming feeds. The sys-

tem categorizes threat intelligence by:

« Feed Name
« Total number of indicators reported by a source
« Indicators reported by a source with a status of active

« All indicators reported by a source per day (includes existing indicators)
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@ Incoming Intelligence

Feed Name Total © Active ® o
All Feeds 188,571 16,027
DeepSight Advanced IP Reputation Attack XM... 70,443 13,645
DeepSight Advanced IP Reputation CnC XML ... 3,861 2,481

iSight Partners 40 40

SecureWorks Abuse.ch Feodo IP Tracker 0 0

Emerging Threats IQRisk Rep List FQDNs

DigitalShadows

DeepSight Advanced IP Reputation Fraud XM...

DeepSight Advanced IP Reputation Bot XML F...

CrowdStrike

Watchlist Activity

This dashboard section provides a view of the intelligence data that you selected to watch.

You may click on any accompanying link to view the details page of the item being watched.
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Dashboard

P Watchlist Activity

Adversaries (1/1)

(M  156.201.135.172

Activity

Manual Score added

Generated Score added
googleads2. publicvm.com linked

Source added

Class added

Watchlist

Files (1/1)

Source

CrowdStrike

CrowdStrike

CrowdStrike

CrowdStrike

CrowdStrike

i Since Wednesday

Indicators (6/6)

When

04/12/2018 06:05pm
04/12/2013 06:05pm
04/12/2018 06:05pm
04/12/2018 06:05pm

0471272078 06:04pm

The Watchlist allows you to track threat intelligence data and user activity of interest from a

view on the dashboard.
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Dashboard

THREATQ 3 Indicators  Events  Adversaries  Files

o Qv

VERY HIGH

w of Intelligence

HIGH
MEDIUM
LWy

VERY LOW

@ Incoming Intelligence

Feed Name Total @

All Faads 670,375

AlisnVault OTX

Signatures
by Score
0% (0}
0% (0
0% (0]
0% (09
100% [670,375)

0% (0)

Active @ -  Daily @
121,897

2747

Configuring the Watchlist

& Watchlist Activity

Events (11

@i 176.111.18.16

Activity

Source added

18-0D00EZ12 Indicalor Re

Exec Summary sdoed
Manual Score adoed

Generated Score added

inactoce (4]

Adversaries (0

Source

Sam Jackson

Sight Partners

Sight Partners

Sight Partners

Signt FPartners

Signatures (11)

When

04/18:2018 01:38pm
04162018 02:57am
04162018 02:568m
04162018 02:568m

04162018 02:568m

To create a watchlist that displays on the dashboard, complete the following steps:

1. From the ThreatQ user interface, navigate to the Details page of the indicator,

event, adversary, file, or signature you want to track.

2. Click Add to Watchlist to track that item.
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Dashboard

THREATQ ) o meesiiin

73.49.109.200 & B
INDICATOR: |P ADDRESS.

Created: 0S/07/2019  First Seen: 08M&/Z018 0357pm  Expires: add cae =
() Autributes (2)
(@) context
@ Artributes (7] | [m} ATTRIBUTETYPE @ ATTRIBUTE VALLEE =
B sou
& Tags 0} O Destination Port

O Mabware Type

(_9 Relationships

{3} camments (0]

B sources (1)

}_'\" Operations

3. Return to the dashboard to view your watchlist.

Viewing Tasks on the Dashboard

SOURCES

abuse.on Feodo Tracker Eomet
&2 IP Binckiis

abuseon Feodo Tracker Bomet
2 IP Binckii

STATUS:  Aevew =

© A

DATE CREATED =

058712015 03:11pm

Q572018 03410

This dashboard widget provides a view of all open tasks in the platform. You can view your

open tasks or view all open tasks. Tasks on the dashboard are categorized by:

Task ID

« Task Name

User the Task is Assigned To

Due Date

« Status.
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Search

The following describes how to search for indicators and other objects using ThreatQ's

search features.

« Search Overview

o Wildcards and Symbols in Searches

Search Overview

Search allows you to find objects you are looking for quickly, without having to browse

through a large number of objects. There are three search features in ThreatQ:

« Basic Search, which offers a quick method to search if you know exactly what you

are looking for.

« Advanced Search, which gives you more options for limiting your search.

The advanced search also serves as the primary interface for the
Threat Library.

« Indicator Search, which served as the legacy advanced search prior to ThreatQ ver-

sion 4.0.

Using these varieties of search, you can create as broad or as granular a view of your data

as desired.
For more information, see:

» Basic Search

« Advanced Search
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« Indicator Search

Basic Search

Basic Search allows you to search for all objects in the system: indicators, events, adversar-
ies, files, signatures, and so on. The search capability looks at high level aspects of each

object, including:

« Indicators (network or host)

« Attachment titles, hashes, keywords
« Attributes

« Adversary name

« Eventtitle
If searching for google.com, the following indicators will also be returned:

www.google.com (FQDN)

analytic.google.com (FQDN)

www.google.com/analytic (URL)

analytic@google.com (email address)

Related Topics:

o Performing a Basic Search

o Wildcards and Symbols in Searches

Performing a Basic Search

Procedure:
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1. Choose the Search icon.

The Search dialog box appears.

Search

— Search

Q

Advanced Search Indicator Search

During a search, you may use a percent sign (%) to match characters in a string. For example,
specifying net% matches network, netware, netscape, and so on: See mare examples

2. Enter the search criteria.
The Search field provides type ahead suggestions, if any, based on what you have

typed.
3. Select the desired result.

« If you do not retrieve any search results, we recommend trying the

Advanced Search option.

« Ifthere is only one result, the object details page appears.

Wildcards and Symbols in Searches

During a search, you may use a percent sign (%) to match characters in a string. The percent
wildcard specifies that any characters can appear in multiple positions represented by the

wildcard. For example, specifying net% matches network, netware, netscape, and so on.

Here are a number of examples showing search terms with percent wildcards:
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Search

Search

Description
Query
% panda Finds any adversaries and indicators with <name> panda
%ear Finds any character string that ends with "ear," such as bear

%panda%  Finds any character string that has panda in any position
panda% Finds any character string that begins with panda

Finds any character string that has pan in the first three positions and
pan%a _
ends with an "a"
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Reports

The following describes how to generate reports in ThreatQ.

o Reports Overview

« Report Options

o Generating Reports

Reports Overview

You can exporta PDF Summary of an object from an object's details page.

( A

A The generated PDF may contain active links to internal and external loc-
ations. Related objects in the PDF link to an internal ThreatQ instance that
may require authentication. Please be aware of potential impacts before
distribution of the generated report.

Google Chrome's pop-up blocker prevents object PDF summary
reports from downloading. We recommend changing your browser set-
tings to allow pop-ups from your ThreatQ instance.

)

Report Options

You can navigate to Settings > Report Options to customize the PDF reports that are gen-
erated. Report options apply to all reports generated platform-wide. You can make the fol-

lowing customizations:

o Previewing Report Customization

« Customizing the Report Header
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o Customizing Report Text Colors

« Adding a Custom Disclaimer to a Report

Previewing Report Customization
You can preview report customization to view a representation of a report's output.
Procedure:

1. Select the Settings icon > Report Options.

2. Under Customized PDF Reports, click Preview.
The sample report downloads to your computer.
Customizing the Report Header
Complete the following steps to add a custom header to your PDF.

Procedure:

—

. Select the Settings icon > Report Options.
2. Under Header Banner, complete one of the following steps:

« Drag and drop the image you want to use as the header.

« Click Browse and navigate to the image you want to use as the header.

w

. Optionally, click Restore header banner to defaults.

4. Click Save.

Customizing Report Text Colors
Complete the following steps to customize the colors in your PDF.

Procedure:
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1. Select the Settings icon > Report Options.

2. Under Colors, use the drop down menus to select:

» Header Text
« Heading Text
» Body Text

3. Click Save.

Adding a Custom Disclaimer to a Report

You can add a custom disclaimer to include with your report to communicate any liabilities

or limitations to the end users of the report.
Procedure:
1. Select the Settings icon > Report Options.

2. Under Disclaimer,enter your disclaimer text and then use the formatting tools to cus-

tomize your message.

3. Click Save.

Generating Reports

Complete the following steps to export a PDF Summary of an object from an object's details

page.
Procedure:

1. Access the object's detail's page for which you want to generate a report summary.

2. Select Actions > Generate PDF.

The PDF summary downloads and opens in a new browser tab.
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G Google Chrome Users: Google Chrome's pop-up blocker prevents
object PDF summary reports from downloading. We recommend
changing your browser settings to allow pop-ups from your ThreatQ
instance. See Turning Off the Pop-up Blocker in Chrome for more
information.

A The generated PDF may contain active links to internal and external
locations. Related objects in the PDF link to an internal ThreatQ
instance that may require authentication. Please be aware of poten-
tial impacts before distribution of the generated report.

| J

Turning Off the Pop-up Blocker in Chrome

G\ This topic applies to ThreatQ version 4.7

By default, Google Chrome blocks pop-ups from automatically showing up on your screen.

When a pop-up is blocked, the address bar will display a pop-up blocked alert. This pop-up

blocker will prevent your PDF from being downloaded. Complete the following steps to

allow pop-ups from ThreatQ.

Procedure:

1.

2.

Go to ThreatQ where pop-ups are blocked.

In the address bar, click the Pop-up blocked alert icon.

. Click the link for the pop-up you want to see.

To always see pop-ups for the site, select Always allow pop-ups from [your ThreatQ

instance].

Click Done.
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Tasks

The following describes how to manage tasks in ThreatQ.

o Tasks Overview

» Assigning a Task

« Managing Tasks

Tasks Overview
ThreatQ allows you to create and assign tasks to yourself or other users in the platform.

Once tasks are included in your deployment, you can add contextual information and cor-
relate them with Indicators, Events, Adversaries, Signatures, and Files. You can also add

comments, change the task priority, change the task status, and delete the task.

Assigning a Task
Complete the following steps to assign a task in ThreatQ.
1. From the main menu, choose Create > Task.
The Add Task dialog box opens.

Enter a task Name.
Enter the assignee's email address in the Assigned To field.

Optionally, use the date picker to select a Due Date.

o &~ B

Select one of the following statuses:
« ToDo

« In Progress
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o Review
o Done
6. Select one of the following task priorities:
o Low
o Medium
« High
7. Optionally, enter any Associated Objects.
8. Enter a Description for the task.

9. Click Save.

Managing Tasks
After a task is created, you can manage it on the task's Details page.

The following table describes the actions you can take to manage your tasks on a Task

Details page.
To You can...

Choose
the Priority
drop-down
Change task priority d select
and selec
a new pri-

ority.
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You can...

Choose

the Status

drop-down
Change task status

and select

a new

status.

Choose

the Add

Context
Add Attributes, Comments, Relationships, and Sources

drop-down

and select

an item.

Choose

View and Add Comments Comments

Choose

View the Audit Log Audit L
udit Log.
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Operations

The following explains how to configure and manage operations.

o Operations Overview

« Managing Operations

Operations Overview

Operations enhance your threat intelligence data by allowing you to add attributes, as well
as related indicators, from third party security services, both commercial and open source.
You accomplish this by creating objects to connect to a desired service, receive threat intel-

ligence, and display that threat intelligence in ThreatQ.

To develop custom operations, you should possess a basic functional knowledge of Python

version 3 development. In ThreatQ version 3.0 and later, you can create operations for:

« Indicators
« Events
« Adversaries

Files

« Signatures

ThreatQ operations are written in Python v3.5.2. We recommend allocating a non-production
ThreatQ appliance for Operations development. You may use this development appliance to
troubleshoot your operations before deploying them to production. You may also setup a

local Python environment, write your script, and then copy it onto your ThreatQ appliance.
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Managing Operations
Manage threat intelligence operations on the Operations Management page.

The following table describes the actions you can take to manage Operations.
To Do this..

_ Toggle the switch next to the operation
Turn an operation on or off

name.
Install an operation See Installing Operations.
Uninstall an operation See Deleting Operations.

Installing Operations

Typically, you will receive an operation installation package from a ThreatQuotient rep-

resentative or download it from a designated repository.
To install an operation:

1. From the navigation menu, choose the Settings icon > Operations Management.
2. Click Install Operation.
3. Choose one of the following:

« Drag and drop your operation package onto the Add Operation dialog box.

« Browse to your operation package, select it, and then click Open.

If successful, the operation appears in your list of operations where you can enable or
disable it.

Deleting Operations

To delete an operation:
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1. From the navigation menu, choose the Settings icon > Operations Management.
For the operation you want to delete, expand Operation Settings.

Click Delete Operation.

W N

Click Uninstall.
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Exports

The following explains how to configure and manage exports of threat intelligence data from

ThreatQ. Please read Exports Overview before proceeding.

« Exports Overview

« Managing Exports

« Specific Indicator Export Configuration Instructions

Exports Overview

Exporting is one of the most important ThreatQ features, as it allows you to output non-whitel-

isted indicators to an external threat detection system.

ThreatQ provides a number of standard system exports that have previously been identified
as useful. You have the option to use those and create your own. ThreatQ Exports are built

on the Smarty PHP Template Engine; see https:/www.smarty.net/.

A You should NOT attempt to export all of your threat intelligence data with a
single export. Attempting to do so will cause system degradation and the
export will not complete.

Managing Exports

Manage Exports on the Exports page, accessible by navigating to the Settings icon >

Exports.

The following describes the actions you can take to manage Exports.
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o Viewing the Exports List

« Enabling/Disabling an Export

o Viewing an Export

o Duplicating an Export

o Adding an Export

o Accessing/Editing an Export’s Connection Settings

o Accessing/Editing an Export's Output Format

o Deleting an Export

Viewing the Exports List
The Exports page provides a list of all standard and user-defined exports in the platform.
To view the exports list:

1. Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.

Exports r  here for exports documenavon. [T

ACTIONS
AseSight Ernail Address

ArcSight Email Attachments

ArcSight FQDN

ArcSight MD5

660606000

Enabling/Disabling an Export

To enable/disable an export:
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. Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.

Locate the export you wish to enable/disable.

Toggle the switch in the On/Off column to enable/disable the export.

A confirmation of your action appears in an alert bar at the top of the page.

Viewing an Export

To view an export:

1.

Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.
Click the desired URL.

A new tab opens in your browser, and you are taken to the data returned from that

export.

The load time may be lengthy depending on the amount of data being retumed.

Duplicating an Export

Duplicating an export allows you to have a version that you can edit.

To duplicate an export:

1.

Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.

Locate the Export you wish to duplicate.
Click duplicate in the Actions column.

The duplicate appears at the bottom of the Exports table. A confirmation of the
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duplication appears in an alert bar at the top of the page.

By default, the copy you just created is toggled Off.

Adding an Export

To add an export

1.

Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.
Click + Add Export.

The Connection Settings dialog box opens.

Enter the Export name.
Verify or edit the token.

Click Next Step.

The Output Format dialog box opens.

For detailed information on formatting the Output Format dialog box,
see Accessing/Editing an Export's Output Format.

Select which type of information you would like to export from the first dropdown

menu.
Select the Output type from the second dropdown menu.

Un-select any of the checkboxes under the Filter by TLP section to exclude data
by its source TLP classification. All classifications will be selected (included in the

export) by default.
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The Filter by TLP option will only appear if administrators have
enabled TLP viewing. See the Traffic Light Protocol (TLP) topic for
more information.

9. (Optional) Enter special parameters.

10. Customize the Output Format Template by putting your cursor where you want
the variable to go and selecting the variable you’d like to use from the Insert Vari-

able select box.
11. Verify the information entered.

12. Click Save Settings.

The export you just created appears at the bottom of the Exports table, and a con-

firmation alert appears in an alert bar at the top of the page.

By default, the new export is toggled Off.

Accessing/Editing an Export’s Connection Settings

Connection settings are available for each of the exports. The Connection Settings dialog
box contains the name of the export as well as the token you'll need to use when connecting

a device to ThreatQ.

While you cannot edit or delete any of the exports originally supplied by ThreatQ, you can

edit exports you have added to ThreatQ or copies of the original exports.
To edit an export's connection settings:
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.

2. Locate the export you wish to edit.
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3. Click connection settings in the Connection column.

The Connection Settings dialog box opens.

Connection Settings

VOWmMOmMRCESFARTHYTUEKM|PBwhYICpKt

Save Settings

4. Make the desired edits.

5. Click Save Settings.

The settings are saved, and a confirmation alert appears in an alert bar at the top of the

page.
Accessing/Editing an Export's Output Format

While you cannot edit or delete any of the exports originally supplied by ThreatQ, you can

edit exports you have added to ThreatQ or copies of the original exports.
To edit an export's output format:
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.

2. Locate the export you wish to edit.

3. Click output format in the Output Format column.
The Output Format dialog box opens.
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OUTPUT FORMAT

Which type of information would you like to export?

Indicators

Output type:

text/plain

Special Parameters (optional):
Provide URL Parameters to further refine information being exported: See examples.

indicator.deleted=N&indicator.type=MD5&indicator.class=networké&status=Active
A
Output Format Template: Insert Variable:

Indicator Id

{foreach $data as S$indicator}
{$indicator.value},{foreach $indicator.Sources item=source name=Sources}

Save Seftings el

4. Select which type of information you would like to export from the first dropdown

menu.

Which type of information would you like to export?

v Indicators
Recipients
IndicatorSources

An admin has the ability to choose between the following options:

« Indicators - Outputs only indicators
« Recipients - Outputs only recipients

« IndicatorSources - Outputs indicators with the source as supporting inform-

ation
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5. Select the Output Type from the second dropdown menu.

This sets the content type of the export response to a specific value (e.g. text/csv, tex-
t/plain, text/xml). Output Type does not have an impact on how the data is formatted
but it does affect the content type within the header of the exported document. For
example, if you select Output Type = text/csv, when viewing the source of the export,

the header will contain a Content Type = text/csv attribute.

Please see http://www.w3.org/Protocols/rfc1341/4 Content-Type.html for more

information.

o b b i

text/xml
v text/plain
text/csv
text/csv; charset=utf-8
text/json
Custom

6. (Optional) Enter special parameters. There are two ways to do this:

o Adding Special Parameters within ThreatQ. One advantage of using this

option is that the URL for the export remains non-specific and therefore
you can change what is being exported without having to manage each

external device individually.

o Customizing the Output Format Template. Choosing this option means

you lose the ability to have one place to manage what is being exported.

Adding Special Parameters within ThreatQ

This is where an admin can provide additional parameters to further specify which data will

be output via this export. Here are some examples.

To export all indicators with an active status Indicator.Status=Active

To export all CIDR Block indicators that Indicator.Status=Active&Indicator. Type=cidr

have an active status block
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To export all indicators with an active status

To export all CIDR Block indicators and

IP Addresses that have an active status

Indicator.Status=Active
Indicator.Status=Active&Indicator. Type=cidr

block&Indicator. Type=ip address

A wide range of filtering parameters are available:

Parameters for Indicators
indicator.id
indicator.type
indicator.status
indicator.value
indicator.class
indicator.hash
indicator.updated_at
indicator.last_detected_at
indicator.deleted
indicator.deleted_at
indicator.Attributes
indicator.Adversary
indicator.Sources

indicator.sources_count

Parameters for Recipients

recipient.id
recipient.value
recipient.count
recipient.to_count
recipient.cc_count
recipient.updated_at
recipient.deleted
recipient.deleted_at
recipient.spearphish_count
recipient. Adversaries
recipient.Attributes

recipient.Sources

Parameters for Indicator Sources

indicator.id

indicator.type
indicator.status
indicator.value
indicator.class
indicator.hash
indicator.updated_at
indicator.last_detected_at
indicator.deleted
indicator.deleted_at

indicator.source

Adding Parameters to the end of the URL

You can append the same parameters listed above to the end of any export URL to achieve
the same results. By pursuing this option, you will lose the option of having one place to man-

age what is being exported via that export.

Using Logical Operators in Export Filters

You can configure exports to output objects matching filter conditions that use logical AND

and OR operators. Exports allow the following filters:

ThreatQ User Guide, Version 4.20 322



THREAT() AN Exports

1. Searching using greater than, less than, or equal to

« Examples in special parameters string section:

indicator.score>=5

indicator.score<=5

« Examples in request URI:

&indicator.score=>=5

&indicator.score=<=8

2. Adding multiple criteria for a single field using an OR comparison

« Example in special parameters string section:

indicator.score=5&indicator.score=8

« Example in request URI:

&indicator.score[]=5&indicator.score[]=8

3. Adding multiple criteria for a single field using an AND comparison
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« Example in special parameters string section:

indicator.score>=5&indicator.score<=8

« Example in request URI:

&indicator.score[]=>=5&indicator.score
[]=<=8
Customizing the Output Format Template
You can customize the output format template for an custom or duplicated export.
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.

2. Locate the export for which you want to customize the output format template.
3. Click output format.

4. In the Output Format dialog box, customize the output format template by putting
your cursor where you want the variable to go and selecting the variable you'd like

to use from the Insert Variable select box.

This template provides you with the ability to format exactly how your data is printed

out within an export.

Important: When formatting your output template, you must wrap all of your declar-

ations within a loop. Please refer to the following as an example:

{foreach $data as $indicator}

Your variables go here
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{/foreach}

The Output Format Template is populated based on your selection.
5. Verify the information entered.
6. Click Save Settings.
Export Output Format Templates

The following topics contain template files that you can use to customize an export's output

format.

"l

The Output Format Template field for an export is found under its Output
Format modal. You can access this by clicking on the Output Format link
for an export from the main exports page.

Export Adversaries Output Format Template

Export Events Output Format Template

Export Indicators Output Format Template

Export Signatures Output Format Template

Export Adversaries Output Format Template

Use the template below to format exactly how your data is printed out within an export.

"1

Important: When formatting your output template, you must wrap all of your
declarations within a loop.

Template
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{foreach S$data as S$adversary}

ID: {$adversary.id}

Name: {$Sadversary.name}

Description: {S$Sadversary.description}
Created At: {Sadversary.created}
Updated At: {Sadversary.updated at}
Touched At: {Sadversary.touched at}
Deleted At: {Sadversary.deleted at}

Deleted: {$adversary.deleted}

Your variables go here

{/foreach}

The following items are variables that can added to the template.

Sources

{foreach S$Sadversary.Sources item=source name-
e=Sources}{Ssource.value} {if !empty(Ssource.tlp) }
({Ssource.tlp}) {/if}

{/foreach}

Attributes

{foreach Sadversary.Attributes item=attribute name-
e=Attributes}

Name: {Sattribute.name}

Value: {Sattribute.value}

{/foreach}
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Adversaries

Attachments

Indicators
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Value: {S$indicator.value}

{/foreach}

Investigations

{foreach $adversary.Investigations item-

m=investigation name=Investigations}

Name: {$investigation.name}

Value: {Sinvestigation.value}

{/foreach}

Signatures

{foreach Sadversary.Signatures item=signature name-

e=Signatures}
Name: {$signature.name}

Value: {Ssignature.value}

{/foreach}

Tasks

{foreach Sadversary.Tasks item=task name=Tasks}

Name: {S$Stask.name}

Value: {Stask.value}

{/foreach}

Export Events Output Format Template

Use the template below to format exactly how your data is printed out within an export.
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Important: When formatting your output template, you must wrap all of your
declarations within a loop.

Template

{foreach $data as S$Sevent}

{Sevent.title} ID: {Sevent.id}
Title: {Sevent.title}

Type: {Sevent.type}

Happened: {Sevent.happened at}
Description: {Sevent.description}
Created At: {Sevent.created}
Updated At: {Sevent.updated at}
Touched At: {Sevent.touched at}
Deleted At: {Sevent.deleted at}

Deleted: {Sevent.deleted}

Your variables go here

{/foreach}

The following items are variables that can added to the template.

Sources
{foreach S$event.Sources item=source name=Sources}
{$Ssource.value} {if !empty(S$Ssource.tlp)}{/if}

{/foreach}

Attributes
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Events
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Indicators

Investigations

Signatures
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Export Indicators Output Format Template

Use the template below to format exactly how your data is printed out within an export.

Important: When formatting your output template, you must wrap all of your
declarations within a loop.

Template

{foreach S$data as $indicator}

{$indicator.value}

ID: {$indicator.id}

Value: {Sindicator.value}

Type: {S$indicator.type}

Status: {$indicator.status}

Class: {$indicator.class}

Description: {$indicator.description}
Score: {Sindicator.score}

Hash: {$indicator.hash}

Source Count: {S$indicator.sources count}
Whitelisted: {S$Sindicator.whitelisted}
Last Detected At: {$indicator.last detected at}
Created At: {Sindicator.created}

Updated At: {Sindicator.updated at}
Touched At: {Sindicator.touched at}
Since Deleted: {S$indicator.sincedeleted}
Deleted At: {Sindicator.deleted at}

Deleted: {$indicator.deleted}

Your variables go here
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The following items are variables that can added to the template.

Attributes

Adversaries

Attachments
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Signatures

Tasks

{foreach $indicator.Signatures item=signature name-
e=Signatures}

Name: {$signature.name}

Value: {S$signature.value}

{/foreach}

foreach $indicator.Tasks item=task name=Tasks}
Name: {Stask.name}
Value: {Stask.value}

{/foreach}

Export Signatures Output Format Template

Use the template below to format exactly how your data is printed out within an export.

Important: When formatting your output template, you must wrap all of your
declarations within a loop.

Template

{foreach $data as $signature}

{Ssignature.name}

ID: {$signature.id}

Name: {$signature.name}
Value: {Ssignature.value}

Type: {S$signature.type}
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Status: {S$signature.status}

Description: {S$signature.description}
Hash: {$signature.hash}

Detected At: {$signature.last_detected_at}
Touched At: {S$signature.touched at}
Created At: {S$signature.created}

Updated At: {Ssignature.updated at}
Deleted At: {S$signature.deleted at}

Deleted: {$signature.deleted}

Your variables go here

{/foreach}

The following items are variables that can added to the template.

Sources

{foreach S$signature.Sources item=source name-
e=Sources}{Ssource.value} {if !empty(Ssource.tlp) }
({Ssource.tlp}) {/if}

{/foreach}

Attributes

{foreach $signature.Attributes item=attribute name-
e=Attributes}

Name: {Sattribute.name}

Value: {Sattribute.value}

{/foreach}
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Adversaries

Attachments

Indicators
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Deleting an Export

While you cannot delete any of the exports included with your ThreatQ installation, you can

delete any exports you have added or copies of the default exports.
To delete an export:
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.

2. Locate the export(s) you wish to delete.
3. Select one or more exports.

4. Click the delete icon at the top right of the Exports table.

Specific Indicator Export Configuration Instructions

The following topics provide instructions on how to export specific indicators for use with an

external threat detection system.

o Configuring Bro Exports

o Configuring Fidelis Exports

« Configuring Lancope Exports

o Configuring Netwithess Exports

« Configuring OpenlOC Signature Exports

o Configuring Palo Alto Exports

o Configuring Reservoir Labs Exports

o Configuring Splunk Exports

o Configuring Tenable Exports
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Configuring Bro Exports

This topic explains how to export Bro indicators for use with an external threat detection sys-

tem. See Exports Overview for more details about configuring exports. Follow the instruc-

tions below to export your data.

To export to Bro:

1.

Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.
Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
« For Output type, choose text/plain.

« Under Special Parameters, enter indic-

ator.status=Active&indicator.deleted=N

« Under Output Format Template, enter:
#fields{$tab}indicator{$tab}indicator_type{$tab}meta.source{$tab}meta.url
{foreach $data as $indicator}

{$indicator_type=""}

{$source_found=0}
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{if $indicator.type eq "CIDR Block"}{$indicator_type="Intel:: SUBNET"}/if}
{if $indicator.type eq "IP Address"}{$indicator_type="Intel:: ADDR"}{/if}

{if $indicator.type eq "URL"}{$indicator_type="Intel::URL"}{/if}

{if $indicator.type eq "Email Address"}{$indicator_type="Intel::EMAIL"}{/if}
{if $indicator.type eq "FQDN"}{$indicator_type="Intel::DOMAIN"}{/if}

{if $indicator.type eq "MD5"}{$indicator_type="Intel::FILE_HASH"}{/if}

{if $indicator.type eq "SHA-1"}{$indicator_type="Intel::FILE_HASH"}{/if}
{if Sindicator.type eq "SHA-256"H{$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator.type eq "SHA-256"}{$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator.type eq "SHA-384"H{$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator.type eq "SHA-512"}{$indicator_type="Intel::FILE_HASH"}{/if}
{if Sindicator.type eq "Filename"}{$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator_type ne "}

{$indicator.value}{$tab}{$indicator_type}{$tab}{foreach $indicator.Sources
item=source name=Sources}{if $smarty.foreach.Sources.first == true}

{$source.value}{$source_found=1}{/if}{/foreach}{if $source_found == 0}-{/if}
{$tab}https://{$http_host}/indicators/{$indicator.id}/details

{/if}

{/foreach}

6. Click Save Settings.
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7. Under On/Off, toggle the switch to enable the export.

Configuring Fidelis Exports

This topic explains how to export Fidelis indicators for use with an external threat detection

system. See Exports Overview for more details about configuring exports. Follow the instruc-

tions below to export your data for:

» Fidelis FQDN

« Fidelis FQDN Text

« Fidelis IP Address

» Fidelis IP Address Text
« Fildeis MD5

« Fidelis MD5 Text
 Fidelis URL

« Fidelis URL Text

To export to Fidelis FQDN:
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.

The Output Format dialog box appears.
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5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators
« For Output type, choose text/xml.

« Under Special Parameters, enter indic-
ator.status-
s=Active&indicator.deleted=N&indicator.type=FQDN&indicator.class=host

o Under Output Format Template, enter:
<MyMDb5feed/>

<description>FQDN feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>
<entries>

<limit>{$row_count}</limit>
<page>{$row_count}</page>
<start>{$row_count}</start>

<end>{$row_count}</end>
<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>
<entry>

{foreach $data as $indicator}
<hostname>{$indicator.value|escape:"url"}</hostname>

<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
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6.
7.

{/foreach}
</entry>
</entries>

Click Save Settings.

Under On/Off, toggle the switch to enable the export.

To export to Fidelis FQDN Text:

1.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.

The Output Format dialog box appears.

. Provide the following information:

« For Which type of information would you like to export? Choose: Indicators.
« For Output type, choose text/plain

« Under Special Parameters, enter indic-
ator.status-

s=Active&indicator.deleted=N&indicator.type=FQDN&indicator.class=host

o Under Output Format Template, enter:
{foreach $data as $indicator}

{$indicator.value}
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{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis IP Address:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
o For Output type, choose text/xml.

« Under Special Parameters, enter indic-
ator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-
dicator.class=network.

« Under Output Format Template, enter:
<MyMD5feed/>

<description>|P feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>

<entries>

ThreatQ User Guide, Version 4.20 345



THREAT() AN Exports

<limit>{$row_count}</limit>
<page>{$row_count}</page>
<start>{$row_count}</start>
<end>{$row_count}</end>
<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>
<entry>

{foreach $data as $indicator}
<ip>{$indicator.value|escape:"url"}</ip>
<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
{/foreach}

</entry>

</entries>

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis IP Address Text:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.

The Connection Settings dialog box appears.

ThreatQ User Guide, Version 4.20 346



THREAT() AN Exports

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
« ForOutput type, choose text/plain.

« Under Special Parameters, enter indic-
ator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-

dicator.class=network.

o Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value}

{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis MD5:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.
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4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
o For Output type, choose text/xml.

« Under Special Parameters, enter indic-
ator.status-
s=Active&indicator.deleted=N&indicator.type=MD5&indicator.class=host.

« Under Output Format Template, enter:
<MyMD5feed/>

<description>MDD5 feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>
<entries>

<limit>{$row_count}</limit>

<page>{$row_count}</page>

<start>{$row_count}</start>

<end>{$row_count}</end>

<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>

<entry>

{foreach $data as $indicator}
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<md5>{S$indicator.value|escape:"url"}}</md5>
<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
{/foreach}

</entry>

</entries>

Click Save Settings.

Under On/Off, toggle the switch to enable the export.

To export to Fidelis MD5 Text:

1.

From the navigation menu, choose the gear icon > Exports.

The Exports page appears.

. Click Add New EXxport.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
o For Output type, choose: text/plain.

« Under Special Parameters, enter indic-
ator.status-

s=Active&indicator.deleted=N&indicator.type=MD5&indicator.class=host
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6.
7.

« Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value}

{/foreach}

Click Save Settings.

Under On/Off, toggle the switch to enable the export.

To export to Fidelis URL:

1.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
« For Output type, choose text/plain.

« Under Special Parameters, enter: indic-

ator.status=Active&indicator.deleted=N

o Under Output Format Template, enter:

<MyMD5feed/>
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<description>URL feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>
<entries>

<limit>{$row_count}</limit>

<page>{$row_count}</page>

<start>{$row_count}</start>

<end>{$row_count}</end>

<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>

<entry>

{foreach $data as $indicator}
<url>{$indicator.value|escape:"url"}}</url>
<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
{/foreach}

</entry>

</entries>

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

To export to Fidelis URL Text:
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1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
« For Output type: choose text/plain.

« Under Special Parameters, enter indic-
ator.status-
s=Active&indicator.deleted=N&indicator.type=URL&indicator.class=host

o Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value}

{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Lancope Exports

This topic explains how to export Lancope indicators for use with an external threat detection

system. See Exports Overview for more details about configuring exports. Follow the
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instructions below configure an export for your data.
To export to Lancope:
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/csv; charset=utf-8

« Under Special Parameters, enter:
indicator.status=Active&indicator.deleted=N&indicator.type=IP
Addressg&indicator.type=CIDR Block&indicator.class=network

o Under Output Format Template, enter:

RECORD_NUMBER,GROUP_NAME,GROUP_ID,NETWORK _
DEFINITION,PARENT_NAMESPACE

0,ThreatQ,-1,,/

{foreach $data as $indicator}
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0,"{foreach $indicator.Sources item=source name=Sources}{$source.value}

{if $smarty.foreach.Sources.last != true},{/if}{/foreach}",-1,
{$indicator.value|regex_replace:"/[\r\t\n]/":""|replace:"\"":""},"/ThreatQ/"
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Netwitness Exports

This topic explains how to export Netwitness indicators for use with an external threat detec-

tion system. See Exports Overview for more details about configuring exports. Follow the

instructions below to export your data for:

« Netwitness FQDN

o Netwitness IP
To export to Netwitness FQDN:
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.

The Output Format dialog box appears.
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5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/csv; charset=utf-8.

« Under Special Parameters, enter:

indic-

ator.status-

=Ac-
ctive&indicator.deleted=N&indicator.type=FQDNG&indicator.class=network

o Under Output Format Template, enter:
{foreach $data as $indicator}
"{$indicator.value}","{foreach $indicator.Sources as $source}{$source.value},
{foreachelse}{/foreach}","https://{$http_host}/indicators/{$indicator.id}/details"
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Netwitness IP:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.
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4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/csv; charset=utf-8.

« Under Special Parameters, enter:

indicator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-

dicator.class=network
« Under Output Format Template, enter:
{foreach $data as $indicator}

"{$indicator.value}","{foreach $indicator.Sources as $source}{$source.value},
{foreachelse}{/foreach}","https://{$http_host}/indicators/{$indicator.id}/details"

{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring OpenlOC Signature Exports

This topic explains how to export OpenlOC signatures for use with an external threat detec-

tion system. See Exports Overview for more details about configuring exports. Follow the

instructions below to export your data.

To export to OpenlOC CSV:
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1. Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.
2. Click Add New Export.

The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose Signatures.
« For Output type, choose text/csv.

« Under Special Parameters, enter:
signature.status=Active&signature.deleted=N&signature.type=OpenlOC
o Under Output Format Template, enter:
{foreach $data as $signature}
"{$signature.name|replace:™:\"}","{$signature.value|replace:"":"\"}"
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Palo Alto Exports

This topic explains how to export Palo Alto indicators for use with an external threat detec-

tion system. See Exports Overview for more details about configuring exports. Follow the
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instructions below to export your data.

To export to Palo Alto FQDN:

1.

Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.

. Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/plain.

« Under Special Parameters, enter:

indic-

ator.status-

=Ac-
ctive&indicator.deleted=N&indicator.type=FQDNG&indicator.class=network

o Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value}

* {$indicator.value}

{/foreach}
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6.
7.

Click Save Settings.

Under On/Off, toggle the switch to enable the export.

Configuring Reservoir Labs Exports

This topic explains how to export Reservoir Labs indicators for use with an external threat

detection system. See Exports Overview for more details about configuring exports. Follow

the instructions below to export your data.

To export to Reservoir Labs:

1.

Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.
Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
o For Output type, choose text/plain.

« Under Special Parameters, enter:
indicator.status=Active&indicator.deleted=N
o Under Output Format Template, enter:

#fields{$tab}indicator{$tab}indicator_type{$tab}meta.source{$tab}meta.url
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{foreach $data as $indicator}

{if $indicator.type eq "CIDR Block"}{continue}{/if}

{if $indicator.type eq "SHA-1"}{continue}{/if}

{if Sindicator.type eq "SHA-256"Hcontinue}{/if}

{if $indicator.type eq "SHA-384"Hcontinue}{/if}

{if $indicator.type eq "SHA-512"Hcontinue}{/if}

{$indicator_type=""}

{$source_found=0}

{if $indicator.type eq "IP Address"}{$indicator_type="Intel::ADDR"}/if}

{if $indicator.type eq "URL"}{$indicator_type="Intel::URL"}{/if}

{if $indicator.type eq "Email Address"}{$indicator_type="Intel::EMAIL"}{/if}
{if $indicator.type eq "FQDN"H{$indicator_type="Intel::DOMAIN"}H/if}

{if $indicator.type eq "MD5"}{$indicator_type="Intel::FILE_HASH"}{/if}

{if $indicator.type eq "Filename"}{$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator_type ne "}

{$indicator.value}{$tab}{$indicator_type}{$tab}{foreach $indicator.Sources

item=source name=Sources}if $smarty.foreach.Sources.first == true}
{$source.value}{$source_found=1}{/if}{/foreach}{if $source_found == 0}-{/if}

{$tab}https://{$http_host}/indicators/{$indicator.id}/details

{/if}
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{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Splunk Exports

This topic explains how to export indicators for use with an external threat detection system.

See Exports Overview for more details about configuring exports. Follow the instructions

below to export your data.
To export to Splunk:
1. Select the Settings icon >Exports.
The Exports page appears with a table listing all exports in alphabetical order.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

Provide the following information:

« For Which type of information would you like to export? Choose Indicators.

For Output type, choose text/plain.

Under Special Parameters, enter:

indicator.sincedeleted=Y
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« Under Output Format Template, enter:

#indicator{$tab}indicator_type{$tab}last modified{$tab}reference_url{$tab}-
source{$tab}campaign{$tab}status

{foreach $data as $indicator}
{$indicator.value}{$tab}{$indicator.type}{$indicator.updated_at}

{$tab}https://{$http_host}/indicators/{$indicator.id}/details{$tab}{foreach $in-
dicator.Sources item=source name=Sources}{$source.value}{if $smarty.-
foreach.Sources.last == false}, {/if}{/foreach}{$tab}{foreach
$indicator.Adversaries item=adversary name=Adversaries}{$ad-
versary.value}{if $smarty.foreach.Adversaries.last == false}, {/if}{/foreach}
{$tab}{S$indicator.status}

{/foreach}

5. Click Save Settings.

6. Under On/Off, toggle the switch to enable the export.

Configuring Tenable Exports

This topic explains how to export Tenable indicators for use with an external threat detection

system. See Exports Overview for more details about configuring exports. Follow the instruc-

tions below to export your data for:

« Tenable FQDN
« Tenable IP Address
« Tenable MD5 Address

To export to Tenable FQDN:
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1. Select the Settings icon >Exports.

The Exports page appears with a table listing all exports in alphabetical order.
2. Click Add New Export.

The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/plain.

« Under Special Parameters, enter:

indic-

ator.status-

=Ac-
ctive&indicator.deleted=N&indicator.type=FQDN&indicator.class=network

« Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value},{foreach $indicator.Sources item=source name=Sources}
{$source.value}{if $smarty.foreach.Sources.last == false}/{/if}{/foreach}
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

To export to Tenable |P Address:

ThreatQ User Guide, Version 4.20 363



THREAT() AN Exports

—

. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.

The Output Format dialog box appears.

© N o O bk~ W D

Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/plain.

« Under Special Parameters, enter:

indicator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-

dicator.class=network

o Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value},{foreach $indicator.Sources item=source name=Sources}
{$source.value}{if $smarty.foreach.Sources.last == false}/{/if}{/foreach}
{/foreach}

9. Click Save Settings.

10. Under On/Off, toggle the switch to enable the export.
To export to Tenable MD5 Address:
1. From the navigation menu, choose the gear icon > Exports.

The Exports page appears.
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2. Click Add New Export.
The Connection Settings dialog box appears.

Enter an Export Name.
Click Next Step.

The Output Format dialog box appears.

2 T

Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/plain.
« Under Special Parameters, enter:
indic-
ator.status-
s=Active&indicator.deleted=N&indicator.type=MD5&indicator.class=network

o Under Output Format Template, enter:
. {foreach $data as $indicator}

« {$indicator.value},{foreach $indicator.Sources item=source name-

e=Sources}
« {$source.value}{if $smarty.foreach.Sources.last == false}/{/if}{/foreach}
« {/foreach}
7. Click Save Settings.

8. Under On/Off, toggle the switch to enable the export.
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Common Enrichment and Audit Log Ques-
tions

The ThreatQ Audit Log tracks every change made to every objectin the system. If there is a
change to an object, that change is displayed in the audit log. The audit log is only updated if

the data itself changes, not just the updated_at value.
The following questions below address further details about the audit logging process.

In the case where an activity is triggered (with nothing updated), where will the activity be
logged?

The activity will not show in the audit log, as there were no changes to report. While ThreatQ
does not track duplicate objects that enter the application, there is a touched_at date field on
primary objects (Adversaries, Files, Events, Indicators, and Signatures) that indicates when

a relation of the object has been changed.

Is there another raw audit log within the system where events are logged?

No, there are no other raw audit logs where events are logged.

Is there an option in the User Interface to enable all activities to be shown in the Audit
Log?

There is no option in the User Interface to limit or expand the audit log. All entries are pulled
for an object when the Audit Log panel is opened. The audit log displays changes to the indi-
vidual fields of an object; object comments, sources, attributes, and tags; as well as to object
links, object link comments, and object link attributes. Additionally, any changes to the score

of an Indicator are included.
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Air Gapped Data Sync

The following explains how to configure and complete an Air Gapped Data Sync from a

source ThreatQ instance to a target air-gapped ThreatQ instance.

Air Gapped Data Sync Overview

Understanding threatq:sync-export

Understanding threatq:sync-import

Executing Air Gapped Data Sync

Air Gapped Data Sync Overview

Air Gapped Data Sync allows you to transfer data from a source ThreatQ installation to a tar-
get air-gapped ThreatQ installation. ThreatQ defines an air-gapped system as one that is not
connected to a public network. This means that external feed ingestion will not occur on the

air-gapped installation.

You should consult with ThreatQ Support or a Threat Intelligence Engin-
eer prior to performing an Air Gapped Data Sync.

Air Gapped Data Sync consists of two synchronization commands:

« threatq:sync-export: the read command that copies data from the source ThreatQ

installation

« threatq:sync-import: the write command that copies data to the target ThreatQ

installation

A This section includes deployment details and configurations that should
not be deviated from or changed without first consulting with

ThreatQ User Guide, Version 4.20 367



THREA TG H Air Gapped Data Sync Overview

A ThreatQuotient. Any deviation of the ThreatQuotient recommended set-
tings could resultin system and platform instability, may render the system
non-operational, and are not supported.

Air Gapped Data Sync System Requirements
To use Air Gapped Data Sync, ThreatQ installations must meet the following requirements:

« ThreatQ v4.15 or later must be installed.

« All ThreatQ installations must run the same software version.

« All ThreatQ installations must be set to the correct time, time zone, and date, and using

a clock source available to all. UTC is recommended.
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Understanding threatq:sync-export

The purpose of this command is to pull all objects, object context, tags, and object links from
the source ThreatQ installation and then store them in CSV data dump files. You can specify
which objects are pulled, based on a date or via configuration. All data pulled into the CSV
data dump files can then be transferred to a target air-gapped ThreatQ installation for val-
idation and import. Each run of this command also generates a sync report with output logs

for the run.

threatq:sync-export Parameters

The following table outlines the parameters for the command. All parameters for the threatq:
sync-export command are optional. If you do not set any parameters, the system runs a

default configuration as explained in threatq:sync-export Configuration.

Parameter Explanation

Target directory where the output file should be placed.
This value is required.

--target
Default: tmp

example: -target=/my/directory

The start date for data selection. This value is required.
--start-date
ex: -start-date="2018-01-01 00:00:00"

The end date for data selection. This value is required.
--end-date Applies only to objects themselves, not object context or

object links.
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example: —-end-date="2018-01-02 00:00:00"

Determines whether objects that have been soft-deleted

are included in the result set. Options are Y(es) or N(0).
--include-deleted

Default: N

example: —include-deleted=Y

Determines whether Investigations and Tasks are included
in the result set. This value is required. Options are Y(es) or

: . o N(o).
--include-investigations

Default: N

example: —include-investigations=N

| If present, tells the command to only include meta data (no
--meta-only
object data) in the result set. No value necessary.

Sets the PHP memory limitin Megabytes or Gigabytes.
This value is required.

--memory-limit
Default: 2G

example: -memory-limit=4G

ThreatQ User Guide, Version 4.20 370



THREAT() /o~

Understanding threatq:sync-export

--object-limit

--ignore-file-types

Sets the limit on the number of objects selected at a time.
Recommended use is to set the limit to a number smaller

than the default (50,000) on boxes with very large data sets.

Default: 50,000

example: —-object-limit=10000

Defines a comma-delimited list of ThreatQ File Types for
which physical files stored on the source ThreatQ install-
ation should not be transferred to the target air-gapped
ThreatQ installation. Database records are still included in

the export tarball.
example: —ignore-file-types="Malware Analysis Report"

example: —ignore-file-types="Malware Analysis Report,Mal-

ware Sample"

threatq sync-export Examples

This command should be run from inside the /var/www/api directory. The following

examples provide use cases for air gapped data sync.

No Time Limit, Default Configuration

sudo ./artisan threatg:sync-export
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This example will pull all objects in the system (with the exception of Investigations, Tasks,

and soft-deleted Objects). The output will appear in Amp.

Meta Data Only

sudo ./artisan threatqg:sync-export --meta-only

This example will pull only meta data objects from the system (Attributes, Sources, Object

Statuses and Types, and so on).

Time Limit
sudo ./artisan threatq:sync-export —--start-date
="2018-10-01 00:00:00" --end-date="2018-11-01
00:00:00"

This example will pull objects whose updated at or touched at occurs between the

start and end date.

Exclude Malware Files

sudo ./artisan threatqg:sync-export --ignore-file-

types="Malware Sample"

This example will pull all objects, but will exclude the physical files attached to any File
objects with the type Malware Sample. The File objects themselves (as well as their context

and relationships) will still be included in the export tarball.

Any File Type can be used with this option, and multiple File Types can be included as a

comma-delimited list.
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sudo ./artisan threatqg:sync-export --ignore-file-

types="STIX, PDF,Malware Sample"

Cron Configuration

sudo ./artisan threatqg:sync-export
--target=/my/directory --include-deleted=Y

-—-include-investigations=N

This example will do a search for a previous synchronization record with the same hash
(comprised of the three options provided). If any hash matches are found, the run will use the

started at date of the most recent previous record as the start date for the current run.

If you do not require soft-deleted Objects, Investigations, or Tasks to be transferred to the tar-
get ThreatQ installation, then only the --target option is necessary (as the defaults for

the other two options are both (N)o).

threatq sync-export Initial Cron Setup for First Time Use

Basic Instructions

Determine what the cron configuration options should be:
« targetdirectory
« whether investigations/tasks should be included

« whether deleted objects should be included

The cron configuration options must be the same for every run, but they only need to be spe-

cified if different from the defaults.

Run the command with the cron configuration options:
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php artisan threatqg:sync-export
--target=/my/directory --include-investigations=Y

-—-include-deleted=N

Instructions for Larger Data Sets (Starting from the Beginning of Time)

For larger data sets, itis undesirable to do a full run from the beginning of time (performance

will suffer).

A\ ThreatQuotient recommends that you use the ——end-date option to spe-
cify an upper limit on the date range pulled. Multiple runs will be neces-
sary to process all data up to the current date.

Determine what the cron configuration options should be:

« targetdirectory
« whether investigations/tasks should be included

« whether deleted objects should be included

The cron configuration options will need to be the same for every run, but they only need to

be specified if different from the defaults.
For each of the runs, provide the configuration options along with the --end-date option:
php artisan threatqg:sync-export

--target=/my/directory --include-investigations=Y

-—end-date="2017-01-01 00:00:00"

Once the current date has been reached, the -—end-date option will no longer be neces-

sary.
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Instructions for Larger Data Sets (Starting from a Specified Date)

For larger data sets, itis undesirable to do a full run from the beginning of time (performance

will suffer).

£\ ThreatQuotient recommends that you use the ——end-date option to spe-
cify an upper limit on the date range pulled. Multiple runs will be neces-
sary to process all data up to the current date.

If only a subset of data needs to be processed up to the current date, then you should use

the --initial-start-date option.
Determine what the cron configuration options should be:

« target directory
« whether investigations/tasks should be included

« whether deleted objects should be included

The cron configuration options will need to be the same for every run, but they only need to

be specified if different from the defaults.

For the first run, provide the configuration options along withthe -—initial-start-
date option.

php artisan threatqg:sync-export
-—-initial-start-date="2017-01-01 00:00:00" --tar-
get=/my/directory

-—-include-investiagtions=Y --end-date="2017-02-01
00:00:00"

For each of the runs, provide the configuration options along with the —-—end-date option:
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php artisan threatqg:sync-export
--target=/my/directory --include-investigations=Y

-—end-date="2017-01-01 00:00:00"

Once the current date has been reached, the --end-date option will no longer be neces-

sary.

threatq sync-export Run Scenarios

Success

When a run of this command completes successfully, a tarball of data will appear in the tar-
get directory you specified (or tmp by default). A report file describing the run will be avail-
able in the data tarball, under the /sync directory. There will also be a record in the database

synchronizations table for the run.

Errors

If a run of this command fails before completion, the tarball will not be created. There will be
a data directory in the target directory (where the data is stored before itis compressed) that
contains all the data that was processed before the failure. The report file will appear in this
directory under /sync. Error messages will not appear in the report file - though they will

appear in the laravel log and in the console.

Regardless of whether the run was part of a cron configuration, it can simply be restarted.

The cron configuration will look for the last completed run to find the next start date.
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threatq:sync-export Dates

Start Date

A start date is applied to objects according to the column available - touched at or

updated at.
touched at Objects
Adversaries, Attachments, Events, Indicators, Signatures, Custom Objects
updated at Objects

Investigations, Tasks, Object Links, Tagged Objects

End Date

An end date is applied only if you provide one at run time. It is applied everywhere a start

date is used.

threatq:sync-export Configuration

The configuration used for each run of this command consists of the --target, --
include deleted,and --include investigations command line options andis
stored in the config json column of the Synchronization record. The hash column of

each Synchronization record is a md5 hash of the config json column.

Default
The default configuration is used if the command is run with no options provided:

« target directory = /tmp
« include_deleted = false

« include_investigations = false
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In this configuration, the initial run start date will defaultto 1970-01-01 00:00:00.

Cron

If the command is run with the --target,--include deleted,and --include
investigations parameters, the hash of these values will be compared against the
hash column of previous runs. Using these three options on every run allows for the com-

mand to be incorporated into a scheduled task.

If any hash matches are found, the start date for the run will be setto the started at date

in the Synchronization record of the previous run with the same hash.

If no hash matches are found, the start date will be setto 1970-01-01 00:00:00.

Start Date Provided

If a start date is included in the command run using the --start-date option, any other
options also provided will be honored. However, ifthe --target, --include deleted
and --include investigations options are also included, a Cron check against the
hash of these three options will not occur. The start date provided will be included in con-
fig json asthe manual_start_date so thatthe run does not collide with any Cron-related

runs.

If a "beginning of time" run is necessary, use the option as --start-date="1970-01-

01 00:00:00".

threatq:sync-export Output and Sync Report
The following sections detail the data you may find in the export output and sync report.
threatq:sync-export Meta Data

Meta data is transferred with every run of this command by default. You can specify that only

meta data (no object data) should be pulled in a run by using the -—-meta-on1ly option.
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Meta data includes information about Sources, Attributes, Tags, as well as Object Statuses

and Types (both seeded and user-provided).

While meta data like Connectors and Operations are included in this list, they are not
installed on the target ThreatQ installation as part of the air gapped data sync process. They
are only placed in the requisite tables for use as Sources of Objects that are transferred. The
same is true of any Users that are copied - these will not be enabled Users on the target

installation; they will be transferred as disabled.

Meta Data Objects:

« Attributes

« Clients

« Connectors

« Connector Categories
« Connector Definitions
« Content Types

o Groups

« Investigation Priorities
o <Object Type> Statuses
o <Object Type> Types
« Other Sources

o Operations

» Sources

o Tags

o TLP

o« Users
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threatq:sync-export Objects

This command covers any objects installed on the system by default, and any custom
objects that have been installed by the user. The only objects that can be excluded are
Investigations and Tasks (using the —-include-investigations command line

option).

g N\

A Custom Objects that are installed on a source ThreatQ installation that
have NOT been installed on a target ThreatQ installation will NOT be
installed by the air gapped data sync process. If an object is included in
the export data, but is not found on the target, it will be ignored.

. J

Default Objects:

« Adversaries

« Attachments (Files)
« Events

« Indicators

« Signatures

o Campaigns

« Courses of Action
« Exploit Targets

« Incidents

e« TTPs

Storage:

The data for each object is copied as a dump file in CSV format using "SELECT *INTO
OUTFILE..." MariaDB syntax. The full query for the data is built up using the options you

provided (start date, end date, etc).
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Dump files contain a maximum object limit of 50,000 (set in the Synchronization base class).
Dump files are created (with a counter appended to the file name) until the entire object res-

ult has been covered.

To ensure that any Objects present in Object Links, Tagged Obijects, or Investigation
Timeline Objects are also included in the base Object data, CSV dump files for each Object
type are also created from queries against each of these tables. This is necessary because
of the differing date columns used in each query (an object may appear in an Object Link in
the specified date range according to the Object Link's updated at date, even though the
Objects themselves saw no change to their touched at date in that date range). When
the data from all of these object files is transferred to the target ThreatQ installation, any

duplicates across dump files will be consolidated.
Sample Object File List (all of these files will contain Adversary records):
« adversaries/adversaries_0.csv
« adversaries/adversaries_investigation_timelines_0.csv
» adversaries/adversaries_object _links_dest_0.csv
» adversaries/adversaries_object_links_src_0.csv

» adversaries/adversaries_tags_0.csv

threatq:sync-export Object Context

The date range for queries on Object Context tables uses the updated at date column,

with the exception of Adversary Descriptions, which uses the created at date column.

Adversary Descriptions are handled as part of the Object Context gathering process. The
adversary descriptions table is queried using the created_at date column, and the
entirety of the adversary description values tableis pulled, as itdoesn'thave a

date column.
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Not all Objects have all Object Contexts (Attributes, Attribute Sources, Comments, and

Sources). Tables are only polled if they exist.
Tables Covered for each Object Type:

<object type>_attributes

<object type>_attribute_sources

<object type>_comments

<object type>_sources

Sample Object Context File List (Indicator Object Type):
« indicators/indicator_attribute_sources_0.csv

indicators/indicator_attributes_0.csv

indicators/indicator_comments_0.csv

« indicators/indicator_sources_0.csv

threatq:sync-export Other Data
Attachment Files

Physical files for all attachments included in the date range are copied into the attach-
ments/files directory of the data tarball.

Object Links
The date range for queries on Object Links uses the updated at date column.

Tables Covered (Object Links and Object Link Context):

« object_links
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« Object_link_attributes

object_link_attribute_sources

object_link_comments

« Object_link_sources

Sample Object Link File List:

object_links/object_links_0.csv

« object_links/object_link_attributes_0.csv

« object_links/object_link_attribute_sources_0.csv
« object_links/object_link_comments_0.csv

« object_links/object_link_sources_0.csv
Tags
The date range for queries on Tagged Objects uses the updated at date column.
Tables Covered (Tags themselves are covered in the Meta Data):
tagged_objects
Sample Tagged Objects File List:
tagged_objects/tagged_objects_0.csv
Spearphish
The date range for queries on Spearphish uses the updated at date column.
Tables Covered:
spearphish

Sample Spearphish File List (Spearphish files are stored with Event data):
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events/spearphish_0.csv

Investigations

The date range for queries on additional Investigation context tables uses the updated at

column.

Tables Covered:

investigation_nodes

investigation_node_properties

« investigation_timelines

investigation_timeline_objects

investigation_viewpoints

Sample Investigation additional context File List:

investigations/investigation_node_properties_0.csv
« investigations/investigation_nodes_0.csv

« investigations/investigation_timeline_objects_0.csv
« investigations/investigation_timelines_0.csv

« investigations/investigation_viewpoints_0.csv

threatq:sync-export File Output

threatq:sync-export Data Tarball

Once all data has been processed, a tarball is created containing all output files. This tarball
will be dropped in the directory specified in the --target option, orthe /tmp directory by
default.

Tarball Naming Convention: tgSync <run date>.tar.gz
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Example: tqSync-19-01-16-1547649934-0849.tar.gz

threatq:sync-export Sync Report

The output for each run is stored in a Sync Report output file, which is located in the sync dir-

ectory of the data tarball. The file is always named sync-export.ixt.

threatq:sync-export Command Line Output

Command line output displays command progress, object totals, and files written.

threatq:sync-export Synchronizations

Table
synchronizations

id - The auto-incremented id for the Synchronization record

« type - The Synchronization direction (options are "export" or "import")

« started at - The date and time the command run was started

o« finished at -The date and time the command run completed

o config json -A JSON representation of the command run configuration

o report json -A JSON representation of the command run parameters (com-

mand line options, object counts, files created, etc)
e pid - The process id of the command run
« hash - Unique identifier for a command run (md5 hash of the config_json column)
o created at - The date and time the Synchronization record was created

o updated at - The date and time the Synchronization record was updated
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Record Handling

Hash

The Synchronization record hash column is automatically calculated as an md5 of the con-

fig json column on record creation.
Initial Creation

A Synchronization record is created at the beginning of a command run, right after all com-
mand line options have been processed. Initial creation only covers the type, started
at,pid,and config json columns. Forthis command (threatqg:sync-export), the
type will be "export". The command line option portion of the report json is added as
well, but this column will not be complete until the record is finalized. The finished at

column remains NULL.
Finalization

A Synchronization record is finalized when the command run has completed. At this time,
the finished at column is filled with the completion datetime, and the report json

column is updated to include information about the run (object counts, files created, etc).
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Understanding threatq:sync-import

The purpose of this command is to process the tarball of object data created by the threatq:-
sync-export command. Temporary sync tables are created on the target to house this object
data, and integrity checks are run against existing data to verify IDs and check for duplicate
objects. Duplicate objects from the source ThreatQ installation are updated, and new objects
are inserted. The temporary sync tables are dropped when data processing is complete.

Each run of this command also generates a sync report without output logs for the run.

threatq:sync-import Parameters

The following table outlines the parameters for the command. With the exception of —-

file, whichis required, all parameters for the threatq: sync-import command are optional.

Parameter Explanation

File path to the tarball created by the threatqg: sync-
export command. This command is required to run the

—file threatqg:sync-import command.

example: —file=tmp/tqSync-19-01-16-1547660837-
8345.tar.gz
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Determines whether the oldest created at date between
the source and target ThreatQ installations should be main-
tained, oranew created at is seton the target system.
The default if this option is not provided by the user is for the
--keep-created-at oldestcreated at date to be maintained. This value is

required. Options are Y(es) or N(0).

Default: Y

example: --keep-created-at=N

Integer value used as the limit for the number of objects
updated or inserted at a time. This value is required. When

using this option, the size of the data sets on both source and

. o target ThreatQ installations should be taken into account. Set-
--object-limit _ o _ _
ting the limit too high may hinder performance.

Default: 1000

example: —-objectlimit=50000

Sets the PHP memory limitin Megabytes or Gigabytes. This
value is required.

--memory-limit
Default: 2G

example: -memory-limit=4G

threatq:sync-import Examples

This command should be run frominside the /var/www/api directory.
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Basic Run

sudo ./artisan threatqg:sync-import

-—file=/tmp/tgSync-19-01-16-1547660837-8345.tar.gz

This example will process all the data in the tarball provided in the —-f1i 1e option, using an
object limit of 1000 for all inserts and updates. The created at date of all transferred
objects will be updated on the target ThreatQ installation if it is older than the current cre-
ated at date (if the objectis already present on the source ThreatQ installation). Newly

inserted objects will keep the created at date of the source ThreatQ installation.

Set New created_at Dates on the Write System

sudo ./artisan threatq:sync-import
-—-file=/tmp/tgSync-19-01-16-1547660837-8345.tar.gz

—-—keep-created-at=N

This example will process all the data in the tarball provided in the --fi 1e option using an
object limit of 1000 for all inserts and updates. The created at date of all transferred will
be left alone in the case of object updates, and to the current time in the case of new object

inserts.

Increase the Object Limit

sudo ./artisan threatqg:sync-import
-—-file=/tmp/tgSync-19-01-16-1547660837-8345.tar.gz
--object-1imit=50000

This example will process all the data in the tarball provided in the —-fi 1e option using an

object limit of 50000 for all inserts and updates. The --keep-created-at option has
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been left out, so it will use the default setting of Y(es) and created at dates will be main-

tained from the read system.

threatq:sync-import Initial Setup

Youmust runthe threatqg: fill-sync-hash-column command, before running the
threatqg:sync-import command on an air gapped ThreatQ installation. This command
prepares the database of an air gapped installation to run the threatq:sync-import command.
Upon upgrade to ThreatQ version 4.17 and later, several tables will include a sync_hash
column, which stores an MD5 hash of the unique fields for records in each table. This com-
mand fills in the data in this column, before attempting an Air Gapped Data Sync import.
Data added after upgrade will automatically have their sync_hash columns populated on

insert and update, so itis only necessary to run this command once.

'd N\

G The threatq:sync-import command checks for any NULL values in the
sync_hash column in the events, indicators, and object_links tables
before importing any data, and will fail if any NULL values are found. If the
threatq:fill-sync-hash-column command is not run and sync_hash
columns are found on the indicators, events, or object_links tables, the
import will fail and ask you to run the command to fill that column before
continuing.

Running the threatq:fill-sync-hash-column Command

1. SSH to your target ThreatQ installation.
Change directories to /var/www/api.

Runphp artisan down to place ThreatQ into maintenance mode.

N

Run the following command:

sudo ./artisan threatqg:fill-sync-hash-column

5. Runphp artisan up to bring ThreatQ out of maintenance mode.
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threatqg:sync-import Run Scenarios

Success

When a run of this command completes successfully, a report will appear in the directory the
command was run in (/var/www/api). There will also be a record in the database syn-
chronizations table for the run. Both of these will contain data describing performance met-

rics and object counts.

Excluded Files

Ifthe -—ignore-file-types option was used during creation of the export tarball, then
the physical files associated with File objects that have the File Types specified in that
option will not be available during the import of those objects. If the import command detects
that a file is missing from the export tarball, it will create a placeholder file under the same file
path as was set on the read box (this is defined in the path field of the File). This placeholder
file will be a simple text file with the phrase "File excluded from export.". Please be aware
that because the original physical file associated to the File object has been replaced, it will

no longer be possible to open the physical file on the Details page for that File object.

Errors

If a run of this command fails before completion, error messages will not appear in the report
file - though they will appear in the laravel log and in the console. There is not currently a
means of restarting the command from where it left off. The command will need to be restar-
ted and will run through all the data again. Any data from the tarball that was written during
the previous failed run will simply be updated (rather than inserted again), meaning the end

result will be the same - all data will be transferred from the tarball to the target system.
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threatq:sync-import Data Processing

Data found in CSV dump files for a table from the tarball provided inthe --file option
is inserted into a corresponding sync table. A sync table is just a copy of a base table, with
column structure maintained but indexes excluded. Indexes are added to unique columns
on sync tables (which will later be used in table joins and where clauses) once data inser-

tion from dump files is complete, since indexes slow the insertion process down.
The naming convention for a sync table is sync_import_<base table name>_<process id>.
Example:

Base table: adversaries

Sync table: sync_import_adversaries_12345

All sync tables are removed from the target ThreatQ installation's database once data pro-

cessing is complete.

threatq:sync-import Basic Table

A basic table has no foreign keys pointing to other tables in the database. It has a single
identifier (id) column for each record. Once all the data stored in the tarball for a basic table
has been transferred to a sync table, the sync table has an existing id column added
with a default value of NULL for each record. This column is used to determine whether the
record already exists on the target ThreatQ installation. The id for the record on the target sys-
tem may be different from that of the record from the source ThreatQ installation, so this

existing id column ensures that data integrity is maintained between the two.
Sample Basic Table:

attachment types-(id, name, is_parsable, parser_class, created_at, updated_at,
deleted_at)
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Sample Sync Table created from Basic Table:

sync_import attachment types 12345 -(existing_id, id, name, is_parsable,

parser_class, created_at, updated_at, deleted_at)

threatq:sync-import Tables with Pivots

A pivot table has one or more foreign keys pointing to other tables in the database. Once all
the data stored in the tarball for a table with pivots has been transferred to a sync table, the
sync table has an existing <pivot> id column added for each foreign key column, as

wellasan existing id column for the record itself (all setto a default value of NULL).

threatq:sync-import File Output
threatq sync-import File Output and Sync Report

Once all data has been processed, a Sync Report will be generated in the /var/www/api
directory (where the command is run). This file will be named after the tarball used in the run,

with the extension "-sync-import.txt"
Example:

Tarball used: tqSync-19-01-16-1547660837-8345.tar.gz

Sync Report name: tqSync-19-01-16-1547660837-8345-sync-import.txt
threatq:sync-import Command Line Output

Command line output displays command progress and object totals. It will be similar to the

outputin the Sync Report.
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threatq:sync-import Synchronizations

Table
synchronizations

id - The auto-incremented id for the Synchronization record

« type - The Synchronization direction (options are "export" or "import")

e started at - The date and time the command run was started

o« finished at -The date and time the command run completed

o config json -A JSON representation of the command run configuration

o report json -A JSON representation of the command run parameters (com-

mand line options, object counts, tables created, etc)
e pid - The process id of the command run
« hash - Unique identifier for a command run (md5 hash of the config_json column)
o created at - The date and time the Synchronization record was created

updated at - The date and time the Synchronization record was updated

Record Handling

Hash

The Synchronization record hash column is automatically calculated as an md5 of the con-

fig json column on record creation.
Initial Creation

A Synchronization record is created at the beginning of a command run, right after all com-
mand line options have been processed. Initial creation only covers the type, started at,

pid,and config json columns. Forthis command (threatq: sync-import), the type
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will be "import". The command line option portion of the report json is added as well,
but this column will not be complete until the record is finalized. The £inished at column

remains NULL.
Finalization

A Synchronization record is finalized when the command run has completed. At this time,
the finished at column is filled with the completion date and time, and the report
json column is updated to include information about the run (object counts, tables created,

etc).
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Executing Air Gapped Data Sync

Using artisan commands at the command line of the ThreatQ installation, you execute air

gapped data sync in two steps:

1. You run the threatq:sync-export command on the source ThreatQ installation; see
Understanding threatq:sync-export.

2. You run the threatq:sync-import command on the target ThreatQ installation, see

Understanding threatq:sync-import.

Running the threatq:sync-export Command
To run the threatq:sync-export command, complete the following steps:
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command appended by the necessary parameters, as described in

threatq:sync-export Parameters:

sudo ./artisan threatqg:sync-export

4. Review the Output and Sync report; see threatq:sync-export Output and Sync
Report.

Running the threatq:sync-import Command

To run the threatq:sync-import command, complete the following steps:
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1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command appended by the necessary parameters, as described in

Running the threatg:sync-import Command:

sudo ./artisan threatg:sync-import

4. Review the Output and Sync report; see threatq sync-import File Output and Sync
Report.
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Backup and Restore

The following describes how to back up and restore a ThreatQ instance.

o ThreatQ Backup

« ThreatQ Restore

ThreatQ Backup

Before performing a backup of a ThreatQ instance, note the following:

« The backup process stops and starts all ThreatQ services automatically in order to
prevent modifications to the file system and database. Requests made during this

time are queued and resumed once the backup process completes.

« The time it takes to back up ThreatQ depends primarily on the size of the data-
base. For this reason, we recommend performing a backup when system avail-

ability is not critical, such as during a scheduled maintenance window.

» The resulting backup file can be large. We recommend that you write it to a moun-
ted drive or file location rather than the local file system. For instructions on how to
mount a network-available drive, contact ThreatQ Support. If the backup file must
be stored locally, you should move it off the local file system at the earliest oppor-
tunity.

» By default, the system creates a backup of the threat intelligence data index
required for improved search performance and includes it in the backup file. This
operation may take hours. You can omit this portion of the backup by running the
backup command with the --exclude-solr option. However, this means that your

threat intelligence data must be re-indexed during or after the restore process.
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Backing Up a ThreatQ Instance

By default, the system creates a backup of the threat intelligence data index required for

improved search performance and includes it in the backup file. This operation may take

hours. You can omit this portion of the backup by running the backup command with the --

exclude-solr option. However, this means that your threat intelligence data must be re-

indexed during or after the restore process.

Before you begin, refer to ThreatQ Backup.

To perform a ThreatQ backup:

1.
2.

4.
5.

SSH to the ThreatQ command line and elevate your user privilege to root or sudo.
Change the directory to /var/www/api.
Choose one of the following options:

« To create a backup thatincludes a Threat Library re-index, run the following

command: sudo php artisan threatqg:backup

» To create a backup that excludes a Threat Library re-index, run the following

command: sudo php artisan threatqg:backup --exclude-solr
When prompted, provide the root mysql password you configured during first boot.

Provide the path to the file location where you want to create the backup.

The script generates a backup file in the specified file location. The name of the file will be

threatq_backup_x.x.x_yyyy-mm-dd.tgz, where x.x.x is the TQ version and yyyy-mm-dd is

the date when the backup was performed.

ThreatQ Restore

To restore from a ThreatQ backup, note the following:
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« The target machine must be an existing ThreatQ instance running the same ver-

sion of the instance captured in the backup.
« The restore process completely overwrites the current installation.

« The backup file needs to be accessible by the target ThreatQ instance, either loc-

ally or on a mounted drive.

« The backup file will be unzipped in the same directory where it resides. Ensure
that the available disk has sufficient space to hold both the backup archive and the
extracted directory. The extracted directory can be removed after the restore is com-

plete.

« Depending on the size of the instance being restored, the process can take a

while.

« The machine running the target ThreatQ instance automatically restarts once the

restore process is complete.

How to Restore from a ThreatQ Backup

Before you begin, refer to ThreatQ Restore.

To restore from a ThreatQ backup, perform the following procedure on the target ThreatQ

instance.

1. Complete the first boot process on the new host by navigating to its IP address in a
web browser and entering your credentials. If this step is not completed, the remain-

ing steps are not successful.
2. SSH to the command line and elevate your user privileges to root or sudo.

3. Verify that you have the necessary utilities in place by running: yum install poli-
cycoreutils-python-2.2.5-20.el7.x86_64.

4. Change directory to /var/www/api.
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5. Issue the following commands:
« php artisan threatq:restore </path/to/backup_file>
« php artisan threatq:update-events
6. When prompted, provide the root mysql password you configured during first boot.

7. Ifthe backup file does not include the intelligence data index required for improved
search performance, the system prompts you to either allow an automatic re-index

or manually perform it later.
This operation may take hours.

8. After the restore completes, you should reboot the target ThreatQ system to ensure

that the system processes start up correctly.
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Command Line Interface (CLI)

You can use the CLI to perform tasks and initiate specific platform processes.
Important Notes
« You should SSH into your ThreatQ installation as root or have sudo permission.

« Some CLI commands require you to be in a specific directory to execute. Review the

help center topic for each command before running.

« Most CLI commands require that the ThreatQ application be placed into maintenance
mode before proceeding. Placing the application in maintenance mode allows you to
perform operations which would be delayed or otherwise impeded by regular API oper-

ation. Review the Maintenance Mode topic before executing CLI commands.

Related Topics

« Maintenance Mode

o ThreatQ Purge Command

« Command Reference Table

Maintenance Mode

Command Line Interface (CLI) commands and other processes, such as backup and
restore, require that you place the ThreatQ application into maintenance mode. Placing the
application in maintenance mode allows you to perform operations which would be delayed

or otherwise impeded by regular API operation.

Some CLI commands will automatically place the ThreatQ application into
maintenance mode when executed. The help center topics for these com-
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ands will indicate if the command will automatically place the ThreatQ
pplication into maintenance mode.

Placing the ThreatQ Application into Maintenance Mode

1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:
cd /var/www/api
3. Run the following command:

sudo php artisan down

The platform will now be in maintenance mode.

[root@techpubstg apil# php artisan down

[root@techpubsty apil# [

Taking the ThreatQ Application out of Maintenance Mode

The following steps assume you are already in the CLI. If not, complete
steps 1-2 from above before proceeding.

1. While under the /var/www/api directory, run the following command:

sudo php artisan up

The platform will now be out of maintenance mode.

[root@techpubstg apil# php artisan up
Application iz now live.
[root@techpubstg apil# I
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ThreatQ Purge Command

A Read this topic carefully before running the ThreatQ Purge Command.
After running this command, your threat intelligence data cannot be
recovered.

The ThreatQ Purge command will permanently delete all object-related threat intelligence
data from your ThreatQ installation, including audit logs. It will maintain any configuration-

related settings, such as expiration, scoring, and so on.

Running the ThreatQ Purge Command
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatqg:purge-threat-intel-

ligence

5. You will be presented the following prompt:

You are about to erase all of your data, are

you sure?
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6. Enter Yes or No.

7. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Command Reference Table

The table below contains a list of Command Line Interface (CLI) commands available for the

ThreatQ application.

Command Topic

System ThreatQ Purge « ThreatQ Purge Command
Feeds
Add/Upgrace CDF « Install/lUpgrade CDF Command

Source Consolidation Source Consolidation Command

Source Merge Source Merge Command

Historic Pull General Historic Pull Commands

iSight Historic Pull iSight Historic Pull Command

User Management

Reset User Password « Resetting User Passwords from the Command
Line
TLP
Update TLP Designations « Update TLP Schema using TLP Default - Com-
mand
Convert TLP o Convert TLP Command
AirGap Data Sync
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Command Topic

Airgap Import « Running the threatq:sync-import Command

Airgap Export « Running the threatq:sync-export Command
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